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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notice

© Copyright 1993-2011 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft®, Windows®, Windows® XP, and Windows Vista® are U.S. registered trademarks of Microsoft 
Corporation.
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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract. To register for an HP Passport user ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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1 Introduction
The HP Client Automation Administrator Installation and User Guide describes the 
installation of HP Client Automation (HPCA) Administrator and the HPCA Administrator 
tools for the Windows, Linux, and Macintosh operating systems.

The HPCA Administrator tools are:

• HP Client Automation Administrator Agent Explorer (Windows, Linux)

• HP Client Automation Administrator AMP Editor (Windows)

• HP Client Automation Administrator CSDB Editor (Windows)

• HP Client Automation Administrator Packager (Windows)

• HP Client Automation Administrator Publisher (Windows, Linux, and Macintosh)

• HP Client Automation Administrator Screen Painter (Windows)

Audience

The administrators can use this book to learn how to install the HPCA Administrator and 
how to use the HPCA Administrator tools to administer the HP Client Automation product.

Abbreviations and Variables

This guide uses the abbreviations and variables defined in the following tables.

The details of the HPCA Administrator AMP Editor are not discussed in this book. 
For information on HPCA Administrator AMP Editor, see the HP Client 
Automation Application Management Profiles User Guide.

Table 1 Abbreviations Used in this Guide

Abbreviation Definition

HPCA HP Client Automation

Core and Satellite HPCA Enterprise environment consisting of one Core 
server and one or more Satellite servers. All features 
are installed as part of the Core or Satellite server 
installation.

CSDB Configuration Server Database

Portal HPCA Portal
9



About the HPCA Administrator

The HPCA Administrator contains a set of tools that you use to manipulate the contents of 
the HPCA Configuration Server Database (CSDB).

• HPCA Administrator Agent Explorer
enables you to create and edit HP Client Automation objects.

• HPCA Administrator AMP Editor
enables you to rapidly deploy and manage software products such as Microsoft Office 
2007, Symantec Antivirus, and Citrix Presentation Agent that are typically required on 
desktop clients. For information on HPCA Administrator AMP Editor, see the HP Client 
Automation Application Management Profiles User Guide.

• HPCA Administrator CSDB Editor
enables you to inspect and manipulate the contents of the HPCA CSDB.

• HPCA Administrator Packager
enables you to use a packaging method called Installation Monitor Mode when you are not 
familiar with all the components that should be part of a package. This method performs 
a scan before and after you install the software. The difference between the two scans 
becomes the contents of the package.

• HPCA Administrator Publisher
enables you to use Component Select Mode to create a package and to then add that 
package to the HPCA CSDB. When you use this method, you select each component that 
you want to add to the package.

• HPCA Administrator Screen Painter
enables you to design and create dialog boxes.

Table 2 Variables Used in this Guide

Variable Description Default Values

InstallDir Location where 
the HPCA server 
is installed

For a 32-bit OS: C:\Program 
Files\Hewlett-Packard\HPCA

For a 64-bit OS: C:\Program 
Files(x86)\Hewlett-Packard\HPC
A

SystemDrive Drive label for 
the drive where 
the HPCA server 
is installed

C:
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2 Installing HP Client Automation Administrator: 
Windows
HP Client Automation (HPCA) Administrator installation program uses Microsoft Windows 
Installer. The program consists of one MSI package with HPCA Administrator tools. HPCA 
Administrator consists of:

• HPCA Administrator Agent Explorer

• HPCA Administrator Packager

• HPCA Administrator Publisher

• HPCA Administrator Screen Painter

• HPCA Administrator CSDB Editor

• HPCA Administrator AMP Editor

System Requirements

• A Clean computer. A clean computer is a computer with only the target subscriber's 
operating system installed.

• Windows Server 2003, Windows Server 2008, Windows XP, Windows Vista, or Windows 7 
(x86 or x64 where applicable).

• TCP/IP connection to the HP Client Automation Configuration Server (HPCA 
Configuration Server).

• Minimum screen resolution of 800 x 600.

• Administrative rights to the computer.

Platform Support

For detailed information about supported platforms, see HPCA 8.10 Release Notes that 
accompany this release.

About the Installation Files

This section describes the files that you use for installation.

setup.exe

The setup.exe is located in the HPCA installation media folder, 
\Setup-Core\Media\admin\default\win32.

It accepts any command line parameters and passes them to Windows Installer. 
11



You can also create a Windows Installer Administrative Installation Point (AIP) for network 
installations.

The AIP starts the Windows Installer and passes command line parameters to it. To create 
the Windows Installer Administrative Installation Point (AIP) in a specified target directory, 
type:

SETUP.EXE /a TARGETDIR=drive:\targetdirectory /qb

The target directory contains HPCAE-ADMIN.MSI, the installation folders, and setup.exe.

HPCAE-ADMIN.MSI

HPCAE-ADMIN.MSI is the MSI database file, that contains the default configuration 
information for the installation. This file is stored on the HPCA installation media folder, 
\Setup-Core\Media\admin\default\win32.

Installing HPCA Administrator for Windows

You can install HPCA Administrator for Windows using the Installation Wizard or Command 
Line.

Installing HPCA Administrator using Wizard

1 Run setup.exe file from the HPCA installation media folder, 
\Setup-Core\Media\admin\default\win32. HPCA Administrator Installation 
Wizard opens.

2 Click Next. The License Agreement window opens.

3 Read and accept the license agreement, then click Next.

If HPCA Agent is not installed on the computer, the Destination Folder window opens.

If you want to select a different destination for HPCA Administrator, click Browse, and 
then navigate to the appropriate destination folder, then click OK to continue.

4 Click Next. The Configuration Server window opens.

5 In the IP Address text box, type the IP address of the Configuration Server.

6 In the Port text box, type the port number (default is 3464).

7 Click Next. The License window opens.

8 Enter a valid license file (for Starter, Standard, or Enterprise edition), or navigate to and 
select it.

9 Click Next. The Select Features window opens.

A Windows Installer Administrative Installation Point (AIP) is also known as an 
Administrative Control Point (ACP).

If HPCA Agent is already installed on the computer, the Destination Folder 
window will not open. HPCA Administrator is installed in the same location as the 
HPCA Agent.
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— If you enter a Starter or Standard license file in step 8, you will have two tools from 
which to choose: HPCA Admin Agent Explorer, and HPCA Admin Publisher.

— If you enter an Enterprise license file in step 8, you will have 6 tools from which to 
choose: HPCA Admin Agent Explorer, HPCA Admin Packager, HPCA Admin 
Publisher, HPCA Admin Screen Painter, HPCA Admin CSDB Editor, and HPCA AMP 
Editor.

10 Click  to select the features that you want to install.

Each time you click , a shortcut menu for that feature opens.

If you enter an Enterprise license file in step 8, the next window opens.

If you want to set the same options for all of the features, you can click  next 
to HP Client Automation Admin and select the appropriate option to apply the 
setting to all features
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11 From the shortcut menu, select an installation option. The following table contains 
descriptions of these options. 

12 Click Next. The Ready to Install the Application window opens.

13 Click Install to begin the installation. When the installation is done, HPCA Administrator 
has been successfully installed window opens.

14 Click Finish to exit the installation.

Installing HPCA Administrator using Command Line

From the directory containing HPCA Administrator installation files type a command line 
with the following syntax:

SETUP.EXE FeatureStateArgument=Feature1,Feature2

where FeatureStateArgument is one of the arguments in the following table and Feature1 and 
Feature2 are arguments in Table 5 on page 15.

Table 3 Feature settings for the Administrator

Option Description

Will be installed on local hard drive Installs the top-level feature on the local hard drive, 
but not any sub-features.

Entire feature will be installed on 
local hard drive

Installs the entire feature, including sub-features.
Note: In this installation program, selecting this 
option or the "Will be installed on local hard drive" 
option for any of the features results in the same 
installation because these features do not contain 
sub-features.

Entire feature will be unavailable The feature will not be installed. If previously 
installed, this feature will be removed.

You can click Disk Cost to see an overview of the disk space needed for the 
installation.

Table 4 HPCA Administrator feature state arguments

Specify the following 
arguments To set the feature state

ADDLOCAL Type a comma-delimited list of features that 
you want to set to "Will be installed on local 
hard drive."
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Examples

If you want to install only HPCA Administrator Packager on a computer, type the following 
command line:

SETUP.EXE ADDLOCAL=NVDINSTALLPACKAGER

If you want to install HPCA Administrator CSDB Editor and HPCA Administrator Agent 
Explorer on a computer, type the following command line:

SETUP.EXE ADDLOCAL= NVDINSTALLSYSTEMEXPLORER,NVDINSTALLCLIENTEXPLORER

ADDSOURCE Type a comma-delimited list of features that 
you want to set to "Will be installed to run from 
network."

ADVERTISE Type a comma-delimited list of features that 
you want to set to "Feature will be installed 
when required."

REMOVE Type a comma-delimited list of features that 
you want to set to "Entire feature will be 
unavailable."
This only removes the features not the entire 
product. Therefore, if you use the REMOVE 
property and type each of the feature names, 
the core product will still be stored on your 
computer.
If you want to remove the entire product, type 
REMOVE=ALL.

Table 5 HPCA Administrator features arguments

Administrator 
Feature Feature Argument

Agent Explorer NVDINSTALLCLIENTEXPLORER

Packager NVDINSTALLPACKAGER

Publisher NVDINSTALLPUBLISHER

Screen Painter NVDINSTALLSCREENPAINTER

CSDB Editor NVDINSTALLSYSTEMEXPLORER

AMP Editor NVDINSTALLAMPEDITOR

If you run the installation from a command line, be sure to pass the IP address for the 
Configuration Server to the installation. For example:

SETUP.EXE NVDOBJZMASTER_ZIPADDR=10.10.10.1

Table 4 HPCA Administrator feature state arguments

Specify the following 
arguments To set the feature state
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Additional Command Line Arguments

The following table describes some additional arguments that you can pass to the installation 
program on the command line.

Changing HPCA Administrator Installation

The Windows Installer installation program enables you to modify, repair, and remove HPCA 
Administrator.

Using the Installation Wizard to Change the Installation

This section describes how to use the Installation Wizard to modify, repair, and remove 
(uninstall) HPCA Administrator.

To use the Installation Wizard to change the Administrator installation

1 From the folder on the installation media that contains HPCA Administrator installation 
files, double-click setup.exe. The Application Maintenance window opens.

2 Select the Modify, Repair, or Remove option.

3 Click Next.

Table 6 Command Line Arguments

Argument Description

/qn Performs a silent installation.

/qb Displays the progress bar only during the installation.

/l*v 
drive:\instal
l.log

Creates a detailed Windows Installer log.
Note: Using this option may impact the performance of 
the installation.

/a TARGETDIR= 
drive:

\targetdirect
ory

Creates a Windows Installer AIP in the specified target 
directory.

The target directory contains HPCAE-ADMIN.MSI, the 
installation folders, and setup.exe.

After you create the AIP, you can run setup.exe and 
pass the appropriate command line parameters. This 
starts the Windows Installer and passes the specified 
parameters to it.

INSTALLDIR= Specify the installation directory to be used. Use quotes 
for paths that contain spaces.

LICENSEFILE= Specify the full path of the license file to be used. Use 
quotes for paths that contain spaces. In case this 
property is not specified, the installer looks for 
license.nvd in the setup folder, by default.

To remove specific tools of HPCA Administrator, use the Modify option on the Application 
Maintenance window.
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— If you select Modify, the Select Features window opens. Select the features that you 
want to modify, then click Install. For information on feature settings, see Installing 
HPCA Administrator using Wizard on page 12.

— If you select Repair, the Ready to Repair the Application window opens. Click Install.

— If you select Remove, click Remove.

4 Click Finish.

Using a Command Line to Change the Installation

This section describes how to use a command line to modify, repair, and remove (uninstall) 
HPCA Administrator using a command line.

To use a command line to modify HPCA Administrator

From \Setup-Core\Media\admin\default\win32, HPCA Administrator installation 
media folder, type the following command line:

SETUP.EXE FeatureStateArgument=Feature1,Feature2

where FeatureStateArgument is one of the arguments in Table 4 on page 14 and Feature1 and 
Feature2 are arguments in Table 5 on page 15.

Examples

If you want to silently remove HPCA Administrator CSDB Editor and HPCA Administrator 
Agent Explorer, type:

SETUP.EXE REMOVE=NVDINSTALLSYSTEMEXPLORER, NVDINSTALLCLIENTEXPLORER /
qn

To install HPCA Administrator Packager to the local hard drive, and to make HPCA 
Administrator CSDB Editor and HPCA Administrator Agent Explorer unavailable, type the 
following command line:

SETUP.EXE ADDLOCAL=NVDINSTALLPACKAGER 
REMOVE=NVDINSTALLSYSTEMEXPLORER,NVDINSTALLCLIENTEXPLORER
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18 Chapter 2



3 HP Client Automation Administrator Tools for 
Windows
The HPCA Administrator Tools for Windows are:

• HPCA Administrator Agent Explorer

• HPCA Administrator Packager

• HPCA Administrator Publisher

• HPCA Administrator Screen Painter

• HPCA Administrator CSDB Editor

• HPCA Administrator AMP Editor 

HPCA Administrator Agent Explorer

This section describes how to create and edit HPCA objects using HPCA Administrator Agent 
Explorer.

HPCA Administrator Agent Explorer is installed automatically with the HPCA 
Administrator. You can use the HPCA Administrator Agent Explorer as a diagnostic utility to 
view local objects on the desktop and, if desired, to edit existing objects or create new ones.

If you have multiple HPCA agents that rely on a single file server in your environment, you 
can use the HPCA Administrator Agent Explorer to edit objects stored on that file server.

The HPCA Administrator Agent Explorer can also be used to edit objects on other HPCA 
agent desktops. For diagnostic purposes, you can view and edit managed objects configured for 
other HPCA agents to which you are connected on a local area network (LAN).

Accessing HPCA Administrator Agent Explorer

The following instructions explain how to access the HPCA Administrator Agent Explorer.

To access HPCA Administrator Agent Explorer

Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Agent Explorer

You must have administrative privileges to use HPCA Administrator Tools.

HPCA screen objects can be viewed with the HPCA Administrator Agent Explorer, 
however, the actual screens are not displayed. HPCA screens must be created and 
edited using the HPCA Administrator Screen Painter. Be careful not to corrupt the 
variables of screen objects while viewing them with the HPCA Administrator 
Agent Explorer.
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or

at the command line type NVDOBJED.EXE.

The HPCA Administrator Agent Explorer opens with the object list displayed in the right 
pane, see Figure 1 on page 20. The object list contains the names of HPCA objects that you 
can view and edit.

Figure 1 HPCA Administrator Agent Explorer Window

Menus in the HPCA Administrator Agent Explorer Window

Use the menus in the HPCA Administrator Agent Explorer window to manage objects, and to 
manage the appearance of the HPCA Administrator Agent Explorer window.

HPCA uses objects that begin with "Z". When naming a new object that you create, HP 
recommends that you do not click a name beginning with the letter "Z."
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File Menu

Use the File menu to open, copy, delete, rename, and create new objects.

Edit Menu

Use the Edit menu to navigate objects.

Table 7 HPCA Administrator Agent Explorer File menu

Menu option Function

New Click New, type a new object name, and click OK.

Open Select an object from the object list and click Open. 
The Object View window opens.

Copy Select an object from the object list, click Copy, and 
type the name of a new object to which you want to 
copy the object characteristics, then click OK.

Rename Select an object from the object list, click Rename, 
and type the new name over the old name in the list. 

Change Directory Click Change Directory, navigate to the directory you 
want, then press Enter.

Defined Directories Click Defined Directories. From the shortcut menu 
select Admin, Lib, or System.

Exit Click Exit to close the HPCA Administrator Agent 
Explorer.

Table 8 HPCA Administrator Agent Explorer Edit menu

Menu Option Function

Select All Place the cursor in the right pane, then click Select All.

Byte Convert Select an object from the object list. Click Byte Convert to 
convert to Little Endian or Big Endian.

Find in Objects Click Find in Objects, enter your search criterion, click 
Find. From the list of objects returned, click the object 
you want to view to open the Object View window.
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View Menu

Use the View menu to customize the way the HPCA Administrator Agent Explorer window 
looks.

Window Menu

Use the Window menu to close all objects.

Table 9 HPCA Administrator Agent Explorer View menu

Menu option Function

Toolbar To view the toolbar at the top of the window click 
Toolbar.

Status Bar To view the status bar at the bottom of the window 
click Status.

Full Row Select To select the full row of object information (including 
the its number of instances, size, and when it was last 
modified) in the object list when it is selected, click Full 
Row Select.

Show Grid Lines To view the grid lines in the object list, click Show Grid 
Lines.

Refresh To refresh the window, click Refresh.

Object Options Click Object Options, then select one or more of the 
following:

• Live Editor
Edits contents of disk instead of memory.

• Use Recycle Bin
Sends deleted objects to the Recycle Bin.

• Esc Closes Object
Enables you to press Esc to close an object.

View Styles Click View Styles, then select whether you want to view 
the objects as icons or in a list.

User Defined 
Directory

Click User Defined Directory, and type the name of a 
path to load.

Font Click Font, and then select the font you want to use for 
display in all windows.

Table 10 HPCA Administrator Agent Explorer Window menu

Menu option Function

Close All To close all open objects, click Close All.
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Help Menu

Use the Help menu to view information about the HPCA Administrator Agent Explorer and 
to register it as the default editor for .edm files.

Object View Window

The Object View window displays the contents of an HPCA object for you to view or edit, and 
contains four drop-down menus: Object, Variable, Instance, and Options.

Object Menu

Use the Object menu to manage, navigate, and print objects.

Variable Menu

Use the Variable menu to add, delete, and rename variables, and manage and navigate 
through the heaps in an object based on their variable's values.

Table 11 HPCA Administrator Agent Explorer Help menu

Menu option Function

Register as Default Viewer Sets the HPCA Administrator Agent Explorer 
as the default editor for .edm files.

About Agent Explorer Displays version and copyright information.

Table 12 Object menu options

Menu option Function

Information Displays the Object Information screen.

Sort Sorts the heaps of a multi-heap object by the values of 
variables.

Sort Order Select an ascending or descending sort order.

Print Prints the contents of the Object View window.

Export Exports the object to a .CSV file and puts it in the same 
location as the object file.

Save Saves the changes you made.

Close Closes the Object View window.

Table 13 Variable menu options

Menu option Function

Add Adds a variable with a user-specified name to an 
object.

Delete Deletes a variable from an object.

Edit Changes the value of a variable.
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Instance Menu

Use the Instance menu to add, delete, and copy instances in an object, and to navigate 
through the instances in an object.

An instance is also called a heap. To view each instance in an object, click >> or << at the 
bottom of the Object View window.

Modify All Changes the value of this variable for all heaps in an 
object.

Filter Displays all the variables that contain a 
user-specified character string.

Rename Renames a variable in an object.

Calculate Row Value For a selected variable, sums all the decimal only 
entries for all heaps in the object.

Find For a user-selected variable, finds the heaps whose 
values contain a user-specified character string. 
Available only for multi-heap objects.

Find Next After you use the Find command to enter a 
character string to find, this command finds the 
next occurrence of this character string.

Find Prev After you use the Find command to enter a 
character string to find, this command finds the 
previous occurrence of this character string.

Replace Find and replace a user-specified character string in 
a variable's value.

Table 13 Variable menu options

Menu option Function

Table 14 Instance menu options

Menu option Function

Add Adds an instance with blank values. Go to Variable → Edit 
to enter the values.

Delete Deletes the instance you select. Click >> or << to navigate 
to the instance that you want to delete.

Duplicate heap Makes a copy of the instance you select, including its 
values. Click >> or << to navigate to the instance you want 
to duplicate.

Copy heap to Copies the instance that you select to the object that you 
type in the Copy Instance to dialog box.
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Options Menu

Use the Options menu to manage the Object View window.

Using HPCA Administrator Agent Explorer to View HPCA Agent Objects

The HPCA Administrator Agent Explorer is installed as a component of the HPCA 
Administrator. Use it to view objects in the IDMLIB directory. You can view any object if you 
have access to the HPCA agent computer’s IDMLIB directory. Otherwise, you might need to 
manually retrieve the object file and store it on your HPCA administrator computer.

To view an object using HPCA Administrator Agent Explorer

1 Navigate to Start → Programs → HP Client Automation Administrator → HP 
Client Automation Administrator Agent Explorer. The HPCA Administrator Agent 
Explorer opens.

2 If necessary, from the File menu, select Change Directory to navigate to the HPCA 
agent computer’s IDMLIB directory or to the directory in which the object is stored.

Go to Jumps to the instance whose number you type in the New 
Instance # dialog box.

Home Jumps to the first instance in an object.

End Jumps to the last instance in an object.

Table 14 Instance menu options

Menu option Function

Table 15 Options menu options

Menu option Function

Resolve Values Displays variable substitution for a named object 
and attribute using the ampersand convention 
&(variable).

• &(DATE) will display the DATE variable 
contents in that heap of the object.

• &(ZERROR.ZERRDATA) will display the 
ZERRDATA variable contents from the 
ZERROR object in the current directory.

Show Length Displays the number of characters allowed for an 
instance's value.

Split View Displays the variable's values for two consecutive 
instances at the same time.

Save Window Position Saves any changes to the format of the window 
that you made in the Options menu.

Object Format Select Little Endian for PC and Big Endian for 
UNIX and Mac.
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3 Double-click the object’s name in the list view. The HPCA Administrator Agent Explorer 
displays the selected object.

4 Click Save/Exit to close the dialog box.

Redirecting the HPCA Administrator CSDB Editor to another Database

You can use the HPCA Administrator Agent Explorer to redirect the HPCA Administrator 
CSDB Editor to another database.

To redirect the HPCA Administrator CSDB Editor to another database

1 Open the HPCA Administrator Agent Explorer.

Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Agent Explorer

or

at the command line type NVDOBJED.EXE.

2 Select the ZMASTER object and right-click to open the Object View Window.

3 Change the value of ZIPADDR to the name or IP address of the computer where the other 
Configuration Server is running.

The HPCA Administrator CSDB Editor will now be directed to the database that resides 
on the computer.

HPCA Administrator Packager

Use the HPCA Administrator Packager to create packages using Installation Monitor Mode.

In Installation Monitor Mode, the HPCA Administrator Packager determines what to 
package by scanning the computer before and after you install the software. It differences the 
before and after scans to determine what changes were made to the computer after the 
installation. These differences become the package that you will publish to the CSDB.

HP recommends this mode for packaging when you do not know all of the components that 
make up an application.

Packaging is the process of identifying the components of the software that you want to 
manage, and organizing them into packages. Packages contain the files, shortcuts, links, 
and/or registry entries that make up the software.

Set Package Properties

Before you begin to package data, you might want to use the Global Default Properties dialog 
box to set default properties for the files that will be included in the package. Changes made 
to the default properties apply to new HPCA Administrator Packager sessions.

HP recommends that you use the HPCA Administrator Packager only on a clean 
computer.

The HPCA Administrator Packager must not be used on a device that has HPCA 
Administrator installed along with the HPCA Core. The Core services may affect 
the HPCA Administrator Packager processing.
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If necessary, you can modify the properties later for any file or folder from the Instance 
Properties dialog box in Installation Monitor Mode.

You can also use the HPCA Administrator CSDB Editor to modify the default properties in 
the base instance. Alternatively, after you promote the package to the CSDB, you can modify 
the properties for an individual instance in the FILE, REGISTRY, or DESKTOP Classes.

Global Default Properties and Instance Properties have three tabs: Agent Management, 
Data Options, and Agent Behaviors. 

To access the Global Defaults Properties dialog box

1 Click Start → Programs → HP Client Automation Administrator → Client Automation 
Administrator Packager.

2 In the Packager Security Information dialog box, type your user ID and password in 
the appropriate text boxes.

3 Click OK.

4 From the Edit menu, select Change Global Defaults. The HPCA Administrator Packager – 
Global Default Properties dialog box has three tabs: Agent Management, Data Options, 
and Agent behaviors.

Agent Management Tab

Use the Agent Management tab to set verification and delivery options for the selected file 
or folder in the package. After publishing this package to the CSDB, you can still modify these 
settings using the HPCA Administrator CSDB Editor.

• Use Verification Options to specify the verification actions that the HPCA agent will 
take for this file or folder.

The default user ID and password are:

User ID: ADMIN

Password: secret
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• Use Delivery Options to specify delivery options, such as the order in which files are 
deployed.

Verification Options

• Use the default specified on the Manager (default)

Select this option so that verification options for this file or folder are inherited from the 
base instance of the FILE Class in the CSDB.

Use the HPCA Administrator CSDB Editor to look at the ZRSCVRFY attribute of the base 
instance of the FILE Class to determine what the default verification options are.

• Verify statistics equal to

Select this option so that the agent checks the selected statistics (Date, Time, File Size) for 
the file on the agent computer. The file is deployed from the CSDB (or Proxy Server) if its 
statistics are different from the file on the agent computer. You can also use the CSDB 
Editor to set this option: ZRSCVRFY=D, ZRSCVRFY=S, ZRSCVRFY=T, or ZRSCVRFY=Y.

• Content (CRC Check)

Select the CRC option so that the HPCA agent checks the statistics of the file on the agent 
computer. When the file is verified, the first the Date, Time, and File Size are checked. To 
save time during the verification, the CRC will be checked only if the file passes the Date, 
Time, and File Size verification. Then, the Configuration Server (or Proxy Server) will 
deploy a file if its statistics are different from those on the agent computer. By selecting 
this option, the Packager will calculate the CRC and put the value in the ZRSCCRC 
attribute.
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• Update only if newer

Select this option so that this file is deployed from the CSDB (or Proxy Server) if it has a 
later date/time stamp than the one on the agent computer. You can also use the HPCA 
Administrator CSDB Editor to set this option: ZRSCVRFY=U.

• Check for existence only

Select this option so that this file is deployed only if it is not on the agent computer. No 
action is taken if it already exists on the agent computer, even if its statistics differ from 
those in the CSDB. You can also use the HPCA Administrator CSDB Editor to set this 
option: ZRSCVRFY=E.

• Check internal version

Select this option to compare the version of the file being deployed against the version 
that may already exist on the agent computer. This ensures that the correct file will be 
updated if more than one version exists. You can also use the HPCA Administrator CSDB 
Editor to set this option: ZRSCVRFY=V. This feature applies to the following file types: 
.DLL, .EXE, .OCX, .SYS, .VBX.

• No verification

Select this option so that the file is deployed the first time the application is deployed. No 
subsequent action is taken. You can also use the HPCA Administrator CSDB Editor to set 
this option: ZRSCVRFY=N.

Delivery Options

• Use default priority

Select this check box to use the default priority of 50. Priority determines the order of 
deployment, from highest priority to lowest priority. You can also use HPCA 
Administrator CSDB Editor to set this option: ZRSCPRI=50.

• Override Priority (01-99)

Type a number from 1 to 99 to override the default priority of 50. 1 is the highest priority 
and 99 is the lowest. You can also use HPCA Administrator CSDB Editor to set this 
option: ZRSCPRI=1.

The following options apply only if there is not enough space on the agent computer to install 
the entire application.

• Mandatory

Select this option to indicate that this file is critical to the application.

— If there is not enough space on the agent computer for the entire application, HPCA 
will only deploy mandatory files.

— If there is not enough space for the mandatory files, then the application is not 
deployed at all.

You can also use the HPCA Administrator CSDB Editor to set this option: ZRSCMO=M.

• Optional (default) 

Select this option to indicate that a file is not critical to the application.

— If there is not enough space on the agent computer for the entire application, HPCA 
will not deploy optional files.

You can also use the HPCA Administrator CSDB Editor to set this option: ZRSCMO=O.
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The following options apply only to operating systems supporting multiple users with a 
required sign on, such as Windows Server 2003.

• User

Select User if you want to indicate that the file should be deployed only to the subscriber 
logged on when the application is initially deployed. You can also use the HPCA 
Administrator CSDB Editor to set this option: ZCONTEXT=U.

• Machine

Select Machine to indicate that the file should be deployed to all users of the computer. You 
can also use the HPCA Administrator CSDB Editor to set this option: ZCONTEXT=M.

• User Specified

This option is reserved for future use.

Data Options Tab

Use the Data Options tab to specify data compression and other details about the files or 
folders that you want to distribute.

• Compression setting

If necessary, select the compression setting for storing this file in the CSDB. Compression 
minimizes the time required to transmit data and the amount of disk space required to 
store it.

— Select Deflate for the most efficient compression, which produces smaller compressed 
images. 
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— Select None if the file is already compressed. If you are packaging an application that 
contains a compressed file, do not have HPCA Administrator Packager also compress 
it, as the file may actually grow in size if it is compressed again.

• Promote instances without data

Select this check box to indicate that this file should not be transferred to the CSDB as 
part of the package. Only the instance representing it is included in the package. The data 
remain in compressed format in the IDMDATA location on your computer. The default 
IDMDATA location is <InstallDir>\Agent\Lib\Data\.

Promote Resource As

• Normal

Select this option to indicate that this file should be deployed as part of an application.

• Maintenance

This feature is no longer supported.

• Force lock method

Select this check box to force the use of the locked file method for deploying this file. If 
the file is in use on the agent computer when HPCA attempts to deploy a new copy of it, 
the locked file method is normally used to deploy it. If necessary, it is decompressed and 
stored locally in a folder. The agent connect process forces a restart when it ends and the 
file is deployed to its correct location during startup.

• Enforce System File Protection (Windows Server 2003 only)

Select this check box to specify that you want to enforce Windows System File Protection 
(SFP). HPCA first attempts to verify the resource using the current verify options, as 
specified in the ZRSCVRFY attribute located in the FILE Class.

— If the verification is successful, the resource is in the desired state and no further 
verification is necessary.

— If the verification fails, HPCA checks to see if System File Protection protects the file. 
If the file is protected, it will not be deployed.

Finally, HPCA checks this attribute to see whether you want to enforce SFP.

— If you select this check box, the ZRSCVRFY attribute is set to P and deployment of 
this resource and the service are marked as failed due to SFP processing. 

— If you do not enforce SFP, the file is marked as having passed verification. 

A ZERROR instance is created to describe the actions taken against the SFP file.

In the WinZip example, we accepted the default data options.
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Agent Behaviors Tab

Use the Agent Behaviors tab to specify methods (programs) that HPCA executes on the 
agent computer.

The command lines that you type in this dialog box are stored in attributes in the FILE Class 
instances in the SOFTWARE Domain.

Agent Method Command Lines

• Resource Initialization Method (Attribute in database: ZINIT)

Type the method to run when the file is stored on the agent computer.

• Method to Install Resource (Attribute in database: ZCREATE)

Type the method to run after the file has been stored on the agent computer. This is used 
if some processing is required to enable it to be used on the agent computer.

To enable deployment of applications that require user interaction on Windows 
Vista operating system, use the "runasuser" method modifier. During publishing, 
add the modifier "runasuser" to the Method to Install Resource text box.

For example: runasuser setup.exe

The method modifier "runasuser" cannot be used along with modifier "hide" as 
these modifiers are mutually exclusive.
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• Method to De-install Resource (Attribute in database: ZDELETE)

Normally, files are removed if the subscription to the software is cancelled. If a file, such 
as a shared DLL file, is not supposed to be deleted from the agent computer, even if the 
subscription to the software is cancelled, type _NONE_ (with the underscores) as the value 
for the Method to De-install Resource.

• Instance Update Method (Attribute in database: ZUPDATE)

Type the method to run when the instance is modified on the computer, after the file has 
been deployed.

• File Update/Add Method (Attribute in database: ZFILEUPD)

Type the method to run when the file is new or has been updated. This method executes 
just before it is deployed to the agent computer.

• File Arbitration Method (Attribute in database: ARBITRAT)

Type the method to run if a file is about to be replaced. This method compares the version 
information of the file or folder on the agent computer and the one that is going to replace 
it, and then determines which to keep.

Component Select Mode

The HPCA Administrator Packager no longer supports Component Select mode. However, you 
can enable Component Select mode in the HPCA Administrator Packager to package links or 
registry keys. To enable component selection mode in the Packager, add a variable to 
ZMASTER called PKGCOMP and set the value to 'Y'. Component Select mode will then be 
enabled for the HPCA Administrator Packager.

Installation Monitor Mode

There are five phases to create a package in Installation Monitor Mode:

1 Define the application's hardware, software, and operating system requirements.

2 Analyze (scan) the hardware and software on the computer.

3 Install the software that you want to package.

4 Analyze (scan) the hardware and software on the computer again. The difference 
between the pre- and post-scans represents the software you installed.

5 Publish the package to the CSDB.

Recommendations

The scans performed in Installation Monitor Mode are highly effective. Therefore, we will 
select some of the subtleties that you might want to consider. If you are already familiar with 
systems management software, some of this material may be redundant.

Before you package an application in Installation Monitor Mode:

• Set up a clean computer.

You must add the ARBITRAT method to the CSDB to use this field. For more 
information, see the Technical Note About the File Arbitration Method on the HP 
Software web site.
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A clean computer has the same operating system as your target audience and has the 
HPCA Administrator installed. Do not make any other changes to the computer.

• Use the same operating system and language version as the target computers for all 
packaging activities.

• Package on a computer with a static IP address.
If your packaging computer uses Dynamic Host Configuration Protocol (DHCP) to obtain 
a dynamic IP address, each time the computer is restarted you will receive a different IP 
address. If you are using Installation Monitor Mode, and the software you are packaging 
causes the computer to restart, the IP address in the registry will change. Therefore, HP 
recommends packaging on a computer with a static IP address.

• If you are packaging Visual Basic applications, create an HPCA package that includes the 
Visual Basic 6 support files.

When HPCA Administrator CSDB Editor is installed with the HPCA Administrator, it is 
a Visual Basic 6 application. Therefore, the following Visual Basic 6 support files are 
installed: 

If you use Installation Monitor Mode to package a Visual Basic 5 application on a 
computer that has HPCA Administrator CSDB Editor installed, the support files listed 
above will not be included in the package. These files exist on the computer, even before 
the pre-installation scan is done. Therefore, the post-installation scan will not recognize 
these files as being added when the software is installed.

To distribute the necessary support files with your Visual Basic applications, use the 
Component Select Mode in HPCA Administrator Publisher to create a package that 
includes only the Visual Basic 6 support files. Then, include this package in any 
application package for Visual Basic 6.

Alternatively, package Visual Basic 6 applications on a computer that does not have the 
HPCA Administrator CSDB Editor installed. To install the HPCA Administrator without 
the HPCA Administrator CSDB Editor, put the CD-ROM in the drive and type the 
following on the command line:

CDDrive:\HPCAE-Admin.msi –ne

There are distinct differences between the national language implementations of 
operating systems. These differences may include different registry key names 
and directory locations, which can create a significant operational gap between the 
expected behavior of the packaged application and the actual operation of the 
application.

For example, if you are installing the French version of Office 2000 for Windows on 
computers using the French language version of Windows Server 2003, package 
the application on a computer with the French language version of the target 
operating system.

ASYCFILT.DLL COMCAT.DLL

COMCTL32.OCX COMDLG32.OCX

MSVBVM60.DLL OLEAUT32.DLL

OLEPRO32.DLL STDOLE2.TLB
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Using Installation Monitor Mode to Create a Package

This section explains how to use Installation Monitor Mode to create a package, and also 
provides detailed information about each of the screens you will encounter.

Task 1: Log on to Packager

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Packager.

2 In the Packager Security Information dialog box, type your User ID and Password in 
the appropriate text boxes.

3 Click OK.

Task 2: Complete the Open Packaging Session Window

Use the Open Packaging Session window to select the packaging mode and enter information 
to identify the packaging session.

At the end of a packaging session, you will have a package—a unit of distributable software 
or data—that you will connect to a service. You will set up policies to distribute the software 
or data to the targeted subscribers.

1 In the Session Type area, Installation Monitor Mode is the only option available. Component 
Select Mode is now only available in the HPCA Administrator Publisher. For more 
information on HPCA Administrator Publisher, see HPCA Administrator Publisher on 
page 45.

2 In the What to Open area, select New Session to begin a new packaging session. You 
must complete the Session ID and Description fields

or

Select Existing Session to resume a previous session.

3 In the Session ID field, type a unique 1 to 6 character name for the session. If you do not 
complete this packaging session, you will need to remember this ID to return to it later.

4 In the Description field, type a description for the session.

5 Click Next. The Package Properties window opens.

The default user ID and password are:

User ID: ADMIN

Password: secret

Review the Global Defaults before you begin any Packaging Session. For more information on 
Global defaults, see Set Package Properties on page 26.

In previous versions of HPCA Administrator Packager, the Import Mode was available for 
applications installed or maintained using Windows Installer. For information on packaging 
these applications, see HP Client Automation Extensions for Windows Installer User Guide. 
This is a separately licensed product.
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Task 3: Enter Package Properties

Use the Package Properties window to name the package and include additional descriptive 
information.

1 In the Package Name field type a name for the package. This is the name for the 
PACKAGE Class instance in the CSDB, and should conform to your naming conventions. 
The name cannot contain any spaces.

2 In the Domain field select the domain in which you want to store the instance. This is 
normally the SOFTWARE Domain unless you customized the CSDB with proprietary 
domains.

3 In the Description field type a description of the package.

4 In the Release field, type the release number of the software.

5 Click Next to go to the System Configuration window.

Task 4: Set the Required System Configuration

Use the System Configuration window to limit the distribution of the package to computers 
that meet specific requirements. Distribution is based on the operating system, installed 
RAM, and processor.

1 Select Target Operating System to activate the Operating System list box. Then, select 
one or more operating systems required for this package.

— To select multiple, consecutive operating systems, press and hold down the Shift key 
on your keyboard and click the items.

— To select multiple, non-consecutive operating systems, press and hold down the Ctrl 
key on your keyboard and click the items.

If you do not select an option, the package will be available to users running all operating 
systems.

2 Select Minimum Megabytes of Memory Required to activate the Megabytes options. Then, 
select the minimum RAM required for this package.

If you do not select an option, the package will be available to users with any amount of 
available memory.

You might want to establish a naming convention to ensure that identifiers are 
unique. HPCA Administrator Packager uses this identifier to construct data 
objects and file names.

If you enter a name of an existing package you will receive an error message. Go 
back and enter a different name for this new package, or go back and open the 
existing package.

The current session information is stored in 
<InstallDir>\Agent\LIB\ZPAKSESS.EDM on your computer. Use the HPCA 
Administrator Agent Explorer to view this object. For more information on HPCA 
Administrator Agent Explorer, see HPCA Administrator Agent Explorer on 
page 19.

If you decide to close this packaging session and do not plan to complete it, you can 
delete this object. You can also use the HPCA Administrator CSDB Editor to 
delete the PACKAGE Instance from the CSDB. Locate the object in the 
SOFTWARE Domain, Packages Class.
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3 Select Minimum Processor Required to activate the Processor options. Then, select the 
minimum processor that is required for this package.

If you do not select an option the package will be available to users with any processor.

If none of the above three options is selected, the package will be available to all eligible 
subscribers.

4 Click Next to go to the Availability window.

64-Bit Applications

Use HPCA Administrator Packager on a 64-bit computer to package 64-bit applications, and 
on a 32-bit computer to package 32-bit applications, regardless of the target computer’s bit 
architecture. This avoids accessing both 32-bit and 64-bit registry and file systems during one 
packaging session.

32-bit applications being deployed to the Program Files directory will not be redirected to 
the Program Files (x86) directory by the HPCA Application Manager on a 64-bit 
computer. This is a convention implemented through environment variables, and not a hard 
requirement. There will be no adverse effect to installing 32-bit applications in the Program 
Files directory, unless you are deploying a 64-bit version of the application to the same 
device and same Program Files directory. If this situation arises, there are two methods to 
resolve it:

• Use the HPCA Administrator CSDB Editor to copy the 32-bit package and change the 
Program Files PATH instances to reference Program Files (x86).

• Convert the application to an MSI install and enables MSI to determine the correct 
Program Files location.

The packaging and publishing tools on a 64-bit operating system automatically generate a 
ZSTOP expression. Two examples are:

• WORDPOS(EDMGETV(ZMASTER,ZOSTYPE),'WINX64_NT')=0

• WORDPOS(EDMGETV(ZMASTER,ZOSTYPE),'WINIA64_NT')=0

Task 5: Set Date and Time Constraints

Use the Availability window to specify the date and/or time when the package will be 
available for deployment. The date and time are based on the system clock of the computer 
running the Configuration Server.

If you do not specify date and time constraints, the package will be available as soon as it is 
promoted to the CSDB and configured for distribution.

1 Select Before to prevent distribution of the package before the specified date and time. Use 
the Month, Day, Year, Hour, and Min text boxes to specify the date and time.

2 Select After to prevent distribution of the package after the specified date and time. Use 
the Month, Day, Year, Hour, and Min text boxes to specify the date and time.

3 Click Next to go to the What to Scan — Set Packaging Options window.

Task 6: Identify What to Scan

Use the What to Scan: Set Packaging Options window to identify areas where the software 
might make changes to the target computer. You can select to scan the desktop, registry, file 
system, or to compare file content.
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Before you install the application, the HPCA Administrator Packager scans the selected areas 
and takes a snapshot that records their current state. After you install the application, the 
HPCA Administrator Packager takes another snapshot. HPCA compares these before and 
after snapshots, and the differences make up the package.

If you do not know how the installation of the application will affect the target computers, 
scan all areas to ensure that all changes made by the application are recorded.

The more information that you have about the software that you are packaging, the easier it 
is to package and deploy. One benefit of knowing the application is that you can save time 
during scanning. Below are some examples of this.

• If you know that the application does not make any registry changes, you can clear the 
Registry option so that HPCA Administrator Packager does not scan the registry.

• If you are packaging some favorites to Internet Explorer and you know that Internet 
Explorer stores favorites in individual .URL files, you can scan only the file system to pick 
up the changes.

• If you are packaging several bookmarks to Netscape Navigator and you know that 
Netscape Navigator stores bookmarks in a single .HTM file, you can include this file in the 
File Contents to be Scanned list, select the File Content Comparison check box, and the 
HPCA Administrator Packager picks up the changes to the bookmark file.

1 To identify which areas of the computer you want to scan, select one or more of the 
following check boxes:

— File System

— Desktop (Icons, Shortcuts, Groups)

— Registry

— File Content Comparison

2 If you select File Content Comparison, you must include the file name in the File Contents 
to be Scanned list box. To do this, type the full path and file name in the File Name text 
box, or click Browse to navigate to and select it. Then click Add.

3 Click Next. If, in step 1, you chose to scan the File System, the Set Drives to Scan window 
opens. If not, the Pre-Installation window opens, see Task 8 on page 39.

Task 7: Identify What to Scan in the File System

Use the What to Scan — Directories window to select the areas of the file system that you 
want to scan. All of the drives (local and network) connected to your computer are considered 
the file system. Many factors, including the computer's hardware and software, affect the 
amount of time it takes to scan the system.

1 Select all the folders or drives that will be affected by the installation.

2 Click Add to move your selections into the Directories to be Scanned list.

3 Click Next to go to the Pre-Installation Scan window.

HPCA does not support the packaging of files from the IDMSYS, IDMLIB, or IDMLOG 
directories.

This window opens only if you selected File System in the Set Packaging Options: What to 
Scan window.

HP recommends that you do not scan network drives. These can take longer due to 
the overhead transmission across the network. Also, the mapping of network 
drives may vary from one user to another.
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Task 8: Begin the Pre-Installation Scan

Use the Pre-Installation Scan window to begin the scan.

1 Click Begin Scan. A check mark appears next to each area as the scan is finished.

2 When the scan is done, a message box opens.

3 Click OK.

Task 9: Install the Software

After the pre-installation scan is complete, you must install the software.

1 In the Pre-Installation Scan window, click Next. A message opens.

2 Click OK. The HPCA Administrator Packager minimizes and HPCA Administrator 
Packager icon appears in the system tray.

3 Install the application using its native installation.

4 After the application is installed, double-click the HPCA Administrator Packager icon in 
the system tray. A message asks if the installation was successful.

5 Click Yes. The HPCA Administrator Packager logon window opens.

6 Type your User ID and Password, and then click OK. The Post Installation Scan window 
opens.

Task 10: Begin the Post-Installation Scan

Use the Post-Installation Scan window to do the final scan.

To begin the post-installation scan

1 Click Begin Scan. When the scan is done, a message box opens.

2 Click OK. A list of how many items were found that were different from the 
pre-installation scan appears.

3 Click Next to go to the Summary window.

Do not do anything other than install the application. If you do, you risk making 
changes to the file system, registry, desktop, and so on. HPCA will detect these 
(unrelated) changes during the post-installation scan and include them in the 
package.

If the application that you are installing requires that you restart your computer, 
the HPCA Administrator Packager icon in the system tray will be available when 
you log on again.

The comparison of the registry scans may take a long time, and there may be very little disk 
activity. Although it may seem as though no progress is being made during this step, be 
patient. The registry scan comparison will complete normally. Use a clean computer to 
minimize the time it takes to complete this comparison.

After differencing the before and after scans, the HPCA Administrator Packager 
creates three registry (.EDR) files in the REGISTRY class. These files are 
published to the Configuration Server.
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Task 11: Review the Modifications to the File System

Use the Summary window, to review the changes that were made when you installed the 
software on your computer.

1 Click Files tab to review the files that were added, deleted, or updated.

2 Click Desktop tab to review the program groups, links, and shortcuts that were added, 
deleted, or updated.

3 Click Registry tab to review changes detected in the registry.

Detailed information about the Files, Desktop, and Registry tabs follows, beginning with View 
File Properties and Locations below.

Task 12: View File Properties and Locations

Use the Files tab in the Summary window to see the files and folders that will be included in 
the package.

To view the selected items

1 Right-click the topmost Selected branch in the tree and select Expand All. Check marks 
indicate that the properties for the file have been specified and the HPCA Administrator 
Packager is ready to publish them.

2 Select an item in the tree view to see its properties in the list view. Some of the properties 
such as Verify, Priority, and Mandatory/Optional, are initially set according to the 
selections in the HPCA Administrator Packager – Global Default Properties dialog 
box. For information on the Global Default Properties, see Set Package Properties on 
page 26.

To filter the displayed items

If the package contains many items, you can use filtering to limit the type of items that you 
want to see in the window.

1 Click  to filter the items in the tree view.

2 In the Set Filter dialog box, type the item type as a string, such as .DLL. If the filter 
string is found anywhere in the item's name, it is considered a match.

3 Click OK. Only those items that meet the filter requirements are displayed.

To remove a filter

1 Click  to open the Set Filter dialog box.

2 Click Clear.

3 Click OK. All files are displayed.

4 Click Next to continue.

Task 13: Set File Properties and Locations

You can modify the properties of the files and folders displayed on the Files tab, or you can 
exclude them from the package.

To edit a file's properties

1 Right-click a file. A shortcut menu opens with the following three options.
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— Set properties

— Active

— Inactive

2 To exclude this file from the package, click Inactive.

3 To include this file in the package, click Active. This is the default setting.

4 To modify the properties of the file, select Set Properties. The Instance Properties dialog 
box opens.

5 Use the Instance Properties dialog box as described in Set Package Properties on 
page 26.

To edit a folder properties

1 Right-click a folder. A shortcut menu opens with the following three options.

— Set properties

— Active

— Inactive

2 To exclude this folder from the package, click Inactive. All the files in that folder will also 
be inactive.

3 To include this folder in the package, click Active. This is the default setting. All the files 
in that folder will also be active.

4 To modify the properties of the folder, select Set Properties. You must also indicate whether 
you want the changes to affect the Directory Only or Directory and Files.

5 Select Directory and Files. The Instance Properties dialog box opens.

Use this dialog box to modify the attributes of the files in the package. The properties of a 
file are stored in its instance in the CSDB. The default values of these properties are set in 
the Global Default Properties dialog box. For more information see Set Package Properties 
on page 26.

Task 14: Updated Files

In addition to the files that were added, you might notice Updated files.

Updated files are control files whose ASCII text has been modified, such as configuration files. 
You can set the properties for a standard ASCII text file as described in View File Properties 
and Locations on page 40.

If a control file, such as WIN.INI, has been updated, the file name of the desktop object is 
listed, followed by the name of the section in the .INI file that has been modified. You can 
see the changes to individual lines below the section name. Each line is listed separately so 
that you can edit them as necessary.

To edit a line in a control file

Right-click the line that you want to modify in the tree view and perform one of the following 
actions:

• Click Active to include the change to the text file in the package

• Click Inactive if you do not want to include the change to the text file in the package.

• Click Override Value if want to modify the change to the text file. The Override Text File 
Data dialog box opens.
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To use the Override Value feature

1 Click Override Value.

2 Type the New Value for the line in the text box.

3 Click OK.

To restore the text line

1 Right-click the line that you want to modify in the tree view.

2 Click Override Value.

3 Click Reset.

4 Click OK to save your changes and close the dialog box.

Task 15: Set Desktop Properties and Locations

Use the Desktop tab in the Set Properties and Locations window to see the selected program 
groups, links, and shortcuts in the package, and to modify their properties.

To view the selected program groups, links, and shortcuts

Right-click Selected Links, and select Expand All.

To set properties for program groups, links, and shortcuts

Right-click the link in the tree view. A menu opens with options listed below.

— Just In Time (HPCA Application Manager Only)

The HPCA Application Manager lets you designate applications as self-maintaining. 
This means that each time the user launches the application, a connection is made to 
the Configuration Server to verify the application and, if necessary, update or repair 
it.

Note that the use of Just In Time with Machine/User applications can only verify or 
repair either the Machine or User portion of the service. If the Just In Time icon is 
using context=M, then startdir should be set to SYSTEM, and the user portion of the 
service will not be verified/repaired. If the Just In Time icon is using context=U, 
then startdir should be $USER, and only the user portion of the service will be verified/
repaired.

– Active

Select Active to include this link or folder in the package.

– Inactive

Select Inactive to exclude this link or folder from the package.

– Properties

Select Properties to open the Verify/Type submenu.

When you select a folder or link, HPCA applies the changes to all links within that folder or 
within the link's branch in the tree view.
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Verify Menu Commands

• Full Verify

Select this command to deploy the link every time a user connects to the Configuration 
Server, even if it already exists on the agent computer. This repairs broken or modified 
links.

• No Verify

Select this command if you do not want to verify the link after initial deployment. No 
repairs are made to the link, even if the user modifies or removes it.

• Exists

Select this command to deploy the link only if it does not exist on the agent computer 
during initial deployment and on each subsequent connection. The link is deployed again 
only if it was deleted. This enables users to modify the link.

Type Menu Commands

The following options apply only to operating systems that support multiple users, such as 
Windows XP or Windows Server 2003.

• User

Select this command to deploy this link only to the subscriber logged on when the 
application is initially deployed.

• Machine

Select this command to deploy this link to all users of the computer.

Task 16: Set Registry Properties and Values

Use the Registry tab in the Set Properties and Locations window to see the changes that will 
be made to the registry when the application is deployed. You can also modify the values in 
registry keys and set deployment options.

To view the selected registry

Right-click Selected Registry Keys, and select Expand All.

To edit values in a registry key

1 Select the registry key in the tree view.

2 Double-click the registry key in the list view.

3 Edit the data in the New Value text box.

4 Click OK to save your changes and close the dialog box.

To restore the registry key to its original value

1 Double-click the registry key in the list view.

2 Click Reset.

3 Click OK to save your changes and close the dialog box.
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To set properties for registry keys

Right-click the link in the tree view. A shortcut menu opens.

• Active

Select this command to include registry changes in the package.

• Inactive

Select this command to prevent registry changes from being included in the package.

• Properties – Deploy / Verify

— Unconditional/Enforced

Select this command to deploy the registry key, even if it already exists on the agent 
computer. If the registry key is modified, the next time the user connects to the 
Configuration Server, this registry key is reset to the packaged value. Use this setting 
for registry keys that must not change in order for the application to function properly.

— Unconditional/Exist (default)

Select this command to deploy the registry key upon initial deployment or if it has 
been deleted. However, the value of the registry key is not reset.

— Exist/Exist

Select this command to deploy the registry key only if it does not exist on the agent 
computer. This enables you to modify the registry key and your changes will not be 
overwritten because the key will be deployed again only if it is deleted.

Task 17: Publish the Package

After you create a package, you publish it to the CSDB. The package is copied to the HPCA 
CSDB and several instances are created, as described below.

• An Application Packages (PACKAGE) instance that represents the promoted package.

• One File Resources (FILE) instance for each file in the package.

• One Desktop (DESKTOP) instance for each program group, link, and shortcut in the 
package.

• One Path (PATH) instance for each unique path to one or more components on the 
computer where the software is installed.

• One Registry Resources (REGISTRY) instance for each hive in the package.

When you right-click a registry key, HPCA applies the changes to all registry keys 
within the key's branch in the tree view.

Each instance described above is stored in one of the default classes in the 
SOFTWARE Domain, such as the PACKAGE or FILE Class. You can also add your 
own classes, such as a DLL class, to the CSDB. For information on how to add a 
class, see Adding a Class on page 106.
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After you have set all file properties and locations, click Next. The HPCA Administrator 
Packager creates the object to be published. This is the package that will be published to the 
CSDB.

To view the files to be promoted

Right-click Files to be Promoted, and select Expand All.

To publish the package

1 Right-click Files to be Promoted, and select Expand All to view the files that will be 
promoted.

2 Click Promote.

3 Click OK when you receive the prompt that the package has been promoted successfully.

4 Click Finish to close HPCA Administrator Packager.

5 Click Yes to confirm that you want to close the HPCA Administrator Packager.

Next, use the HPCA Administrator CSDB Editor to create a service. For more information, 
see Creating Services with the New Application Wizard on page 122.

HPCA Administrator Publisher

The HPCA Administrator Publisher is a tool you use to package data and publish it to the 
CSDB in a form that HPCA can easily manage.

Publishing is the process of importing a package and its imbedded information into the 
CSDB. A package must be published before its content can be distributed and deployed into 
your environment.

After you publish the package, the session's objects are deleted and you cannot resume the 
session. Therefore, you may want to save the session so that you can re-open it later. For 
example, you might find problems while testing the deployment of the package, and want to 
make corrections. Here's how to save the session:

Copy the LIB directory (and its subdirectories) from <InstallDir>\Agent\LIB to a backup 
location. The LIB directory contains the objects that were built by the HPCA Administrator 
Packager during your packaging session.

By saving the LIB directory, promoting the package, and then restoring the LIB directory, you 
can alter the settings in the HPCA Administrator Packager's windows, and publish the 
package again. Use the toolbar buttons to jump directly to the various windows in the HPCA 
Administrator Packager.

If you find a problem while testing the deployment of the promoted package, this enables you 
to fix it.

If you need to change or modify your selections, click Prev until you reach the appropriate 
window. When you are satisfied with the package, click Next until you arrive back at this 
window.

You can also use the buttons in the toolbar to return to a previous screen.

When you publish an application that is targeted for Windows Vista deployment, if you 
choose to install it under system account, then you must make sure that the application will 
deploy without any user interaction on the target Windows Vista computer.
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The HPCA Administrator Publisher supports four different types of publishing. The following 
table lists the types of publishing and where to find information about each one. This book 
describes only two types, Component Select Mode on page 48 and Windows Installer Files on 
page 61.

Batch Mode

The HPCA Administrator Publisher enables publication of files in batch mode. This lets you 
use a configuration file to publish multiple .msi files to the CSDB during one publishing 
session. For more information, see Publishing Multiple .msi Files (Batch Mode) on page 74.

Session 0 Isolation

In Windows XP, Windows Server 2003, and earlier versions of the Windows, all services run in 
the same session as the first user who logs on to the console. This session is called Session 0. 
In Windows Vista and above (including Windows 7), session 0 is now isolated from the user.  
As a result, any operation that requires user interaction should not be performed in session 0.   
To address this new restriction, a new method modifier has been provided called runasuser. 
This modifier will execute the method under the user’s session, and not the system’s session 0.  

In order to use this modifier, insert it before the method command line. Using ZCREATE as 
an example, if your ZCREATE method was:

setup.exe

It would now look like:

runasuser setup.exe

Please be aware that the method modifier runasuser cannot be used with the method modifier 
hide; these are mutually exclusive. In addition, since runasuser executes the method under 
the user’s context, the user must have sufficient privileges to perform the operation.

To change the method using the HPCA console:

1 Click the Service ID to open the Software Details window for a service.

2 Open the Properties tab.

3 Add the modifier runasuser to the beginning of the existing method command Line as 
shown above.

Table 16 Types of files published by HPCA Administrator Publisher

Publication Type Where to find information

Component Select Component Select Mode on page 48.

Hardware Configuration HP Client Automation OS Manager 
Hardware Configuration Guide

Operating System images HP Client Automation OS Manager System 
Administrator Guide

Windows Installer Files Windows Installer Files on page 61.
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Alternatively, this modifier can be included during publishing by adding it to the Method 
property or Method to Install Resource.

Hide Method Modifier

When the administrator deploys an application onto the user's computer, some console 
application windows flicker on the user's screen. To hide these pop-ups from appearing on the 
user's computer screen, the administrator can use the hide method modifier.

To use this modifier, insert it before the method command line. Using ZCREATE as an 
example, if your ZCREATE method was:

ZCREATE = cmd.exe nvdkit runthis.tcl

It will now look like:

ZCREATE = hide cmd.exe nvdkit runthis.tcl

The hide method modifier supports two command lines to launch 32 bit and 64 bit 
applications. The commands are /sys32 for 32 bit applications and /sys64 for 64 bit 
applications. The hide modifier uses the 32 bit version of cmd.exe, by default. As an 
administrator, if you want the 64 bit version of cmd.exe to open, you must run the following 
command:

hide /sys64

To change the method using the HPCA console:

1 Click the Service ID to open the Software Details window for a service.

2 Open the Properties tab.

3 Add the hide modifier to the beginning of the existing method command line, as shown 
above.

Alternatively, this modifier can be included during publishing by adding it to the Method 
property or Method to Install Resource.

Getting Started

To open HPCA Administrator Publisher

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Publisher.

2 Use the HPCA Administrator password to log on to the HPCA Administrator Publisher. 
By default, the user name is ADMIN and the password is secret.

Each of the publishing modes that are discussed in this guide – Component Select mode and 
Windows Installer files – consists of four basic tasks:

1 Selecting: Select the files that you want to package

2 Editing: Edit the file properties

3 Configuring: Enter package and service information

In CA Standard, existing applications cannot be modified, so one should modify the Install 
method during publishing as instructed above.

Please be aware that the method modifier hide cannot be used with the method modifier 
runasuser; these are mutually exclusive.
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4 Publishing: Publish the package to the CSDB.

Component Select Mode

In HPCA Administrator Publisher, you can select the individual components that make up the 
application, such as files, directories, registry entries, and links. HP recommends this mode 
for packaging simple data or applications where you can easily identify all the components in 
the package.

Publishing in Component Select Mode

As of the 5.1 release of the HPCA Administrator Publisher contained a new feature: 
Component Select Mode. Prior to this release this mode of publishing was available in the 
HPCA Administrator Packager. It is now unavailable in the HPCA Administrator Packager, 
and is available only in the HPCA Administrator Publisher.

To publish in Component Select Mode

1 Start the HPCA Administrator Publisher. 

Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Publisher. The Publishing Options widow opens.

2 In the Publishing Options window:

— If you are publishing for thin clients, select Thin Client Publishing.

— From the drop-down list, select Component Select.

3 Click OK. The Select window opens.
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Task 1: Select Files to Publish

Use the Select window to select the files, folders, registry keys, and links that you want to 
include in the package.

1 Navigate through the file system in the left pane. Select all the items that you want to 
include in the package.

2 Click Next.
HP Client Automation Administrator Tools for Windows 49



— If you selected one or more registry files, a Confirm content management dialog 
box opens. Select the registry files whose content you want to manage individually, 
and click OK.

— If you selected one or more link files, a Confirm content management dialog box 
opens. Select the link files whose content you want to manage individually, and click 
OK.

The Edit window opens.

Task 2: Edit Properties and Methods

Use the Edit window to edit properties and methods.

Editing File and Folder Properties

1 Select the Files tab.
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2 All files and folders that will be included in the package are listed in left pane.

3 Select any files or folders whose properties you want to edit.

4 Click the Properties tab to edit the file or folder's verification and delivery options.

Verify Options

— Use defaults on server (default)

Select this option to inherit verification options from the FILE, REGISTRY, or 
DESKTOP Class' base instance in the CSDB.

— File statistics

Select this option so that the HPCA agent checks the selected statistics (Date, Time, 
or File Size) for the files or folders on the computer. Select the Date, Time, or File Size 
options below the Verify options drop-down list. The files or directories are deployed 
from the CSDB if the statistics of the files or folders on the computer are different 
from the statistics for these files or folders in the database. You can also use HPCA 
Administrator CSDB Editor to set this option: ZRSCVRFY=D, ZRSCVRFY=S, 
ZRSCVRFY=T, or ZRSCVRFY=Y.

— Content check using CRC

Select this option so the HPCA Application Manager checks the statistics of the file on 
the agent computer. When the file is verified, first check the Date, Time, and File Size. 
To save time during the verify, the CRC will be checked only if the file passes the Date, 
Time, and File Size verification. Then, the Configuration Server (or Proxy Server) will 
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deploy a file if its statistics are different from those on the agent computer. By 
selecting this option, the HPCA Administrator Publisher will calculate the CRC and 
put the value in the ZRSCCRC attribute. ZRSCVRFY is set to Y.

— Update if newer

Select this option so that these files or folders are deployed if the files or folders in the 
CSDB have a later date/time stamp than those on the agent's computer. You can also 
use the HPCA Administrator CSDB Editor to set this option: ZRSCVRFY=U.

— Existence only

Select this option so that these files or folders are deployed if they are not on the 
subscriber's computer. No action is taken if the files or folders already exist on the 
agent's computer, even if the statistics differ from those in the CSDB. You can also use 
the HPCA Administrator CSDB Editor to set this option: ZRSCVRFY=E.

— None

Select this option so that the files are deployed the first time the application is 
deployed. No subsequent action is taken. You can also use the HPCA Administrator 
CSDB Editor to set this option: ZRSCVRFY=N.

Delivery Options

The following options apply only if there is not enough space on the user’s computer to 
install the entire application. Select if the application will be Mandatory or Optional.

— Mandatory

Select this option to indicate that these files or folders are critical to the application. If 
there is not enough space on the agent's computer for the entire application, HPCA 
will deploy only mandatory files. If there is not enough space for the mandatory files, 
then the application is not deployed at all. You can also use the HPCA Administrator 
CSDB Editor to set this option: ZRSCMO=M.

— Optional (default) 

Select this option to indicate that files or folders are not critical to the application. If 
there is not enough space on the user’s computer for the entire application, HPCA will 
not deploy optional files. You can also use the HPCA Administrator CSDB Editor to 
set this option: ZRSCMO=O.

— Use default priority

Select the Use default priority check box (default) to use the default priority of 50. 
Priority determines the order of deployment, from highest priority to lowest priority. 
You can also use the HPCA Administrator CSDB Editor to set this option: 
ZRSCPRI=50.

If you clear the check box, you can enter a number from 1 to 99 to override the default 
priority of 50. 1 is the highest priority and 99 is the lowest. You can also use the HPCA 
Administrator CSDB Editor to set this option: ZRSCPRI=1.

5 When you are finished editing file properties, click the Methods tab to edit the methods. 
The command lines that you type in the dialog boxes on the Methods tab are stored in 
attributes in the FILE Class instances in the SOFTWARE Domain.

— Resource Initialization Method (Variable in database: ZINIT)

Type the method to run when the files or folders are stored on the agent computer.

Content CRC checking is a time consuming process and should be used sparingly
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— Method to Install Resource (Variable in database: ZCREATE) 

Type the method to run after the file or folder is stored on the computer. Use this if 
some processing is required to enable the file to be used on the agent computer.

— Method to Uninstall Resource (Variable in database: ZDELETE) 

Normally, files are removed if the subscription to the software is cancelled. If a file, 
such as a shared object file, should not be deleted from the agent computer, even if the 
subscription to the software is cancelled, type _NONE_--with the underscores--as the 
value for Method to De-install Resource.

— Instance Update Method (Variable in database: ZUPDATE) 

Type the method to run when the instance is modified on the agent computer, after 
the file has been deployed.

— File Update/Add Method (Variable in database: ZFILEUPD) 

Type the method to run when the file is new or has been updated. The method 
executes just before the file is deployed to the agent computer.

— File Arbitration Method (Variable in database: ARBITRAT) 

Type the method to run if files or folders are about to be replaced. This method 
compares the version information of the files or folders that exist with the files or 
folders that are going to replace them, and then determines which to keep.

6 When you are finished editing file and method properties, click Next to go to the Configure 
window, see Enter Package and Service Information on page 56.

To enable deployment of applications that require user interaction on Windows 
Vista operating system, use the "runasuser" method modifier. During publishing, 
add the modifier "runasuser" to the Method to Install Resource text box.

For example:

runasuser setup.exe

Note: The method modifier "runasuser" cannot be used along with modifier "hide" 
as these modifiers are mutually exclusive.

You must add the ARBITRAT method to the CSDB to use this text box. See the 
technical note about the File Arbitration Method on the HP Software web site.
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Editing Registry File Properties

In this window you can edit the verify and delivery options for the registry keys you selected.

1 Select the Registry tab. All registry keys that will be included in the package are listed in 
left pane.

2 Select any registry keys whose properties you want to edit.

3 In the Verify Options and Delivery Options boxes you may select the following 
combination of verify and delivery options:

— Enforced/Unconditional

Select this command to deploy the registry key, even if it already exists on the agent 
computer. If the registry key is modified, the next time the user connects to the 
Configuration Server, this registry key is reset to the packaged value. Use this setting 
for registry keys that must not change in order for the application to function properly.

— Exist/Unconditional

Select this command to deploy the registry key upon initial deployment or if it has 
been deleted. However, the value of the registry key is not reset.
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— Exist/Exist

Select this command to deploy the registry key only if it does not exist on the agent 
computer. This enables you to modify the registry key and your changes will not be 
overwritten because the key will be deployed again only if it is deleted.

Editing Link Properties

1 Select the Link tab.

2 All links that will be included in the package are listed in left pane.

3 Select any links whose properties you want to edit.

4 In the Verify Options box, from the drop-down list, select Full, None, or Exist.

— Full

Select this command to deploy the link every time a user connects to the 
Configuration Server, even if it already exists on the agent computer. This repairs 
broken or modified links.

— None

Select this command if you do not want to verify the link after initial deployment. No 
repairs are made to the link, even if the user modifies or removes it.

You may not select a verify value of Enforced in combination with a delivery value 
of Exist. This is not a valid combination. If you make these selections, the values 
will revert to a verify value of Enforced, and a delivery value of Unconditional.
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— Exist

Select this command to deploy the link during initial deployment and on each 
subsequent connection only if it does not exist on the agent computer. The link is 
deployed again only if it was deleted. This enables users to modify the link.

5 In the Delivery Options box, from the drop down list, select User or Machine.

— User
Select User Component if you want to indicate that the file will be deployed only to the 
agent that is logged on when the application is initially deployed. You can also use the 
HPCA Administrator CSDB Editor to set this option.

— Machine
Select Machine Component to indicate that the file will be deployed to all users of the 
computer. You can also use the HPCA Administrator CSDB Editor to set this option.

6 When you are finished editing file and method properties, click Next to go to the Configure 
window, see Enter Package and Service Information.

Task 3: Enter Package and Service Information

Use the Configure windows to enter information about the package and the service. Here you 
name the package and include additional descriptive information and set package deployment 
limitations based on hardware and operating system settings. You also enter descriptive 
information about the service, and information about how it will be managed after it is 
deployed.
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1 In the Package Information area enter the following information:

a In the Name field, type a name for the package. This is the name for the PACKAGE 
Class instance in the CSDB and should conform to your naming conventions. Note 
that the name cannot contain any spaces.

b In the Display name field, enter a display name for the package. This is the friendly 
name used in the HPCA Administrator CSDB Editor.

c From the Domain drop-down list, select the domain in which to store the instance. 
This is normally the SOFTWARE Domain unless you customized the CSDB with 
proprietary domains. As shipped, the default domains are ADMIN, AUDIT, CLIENT, 
PATCH, POLICY, PRDMAINT, SOFTWARE, and SYSTEM.

d In the Description field, type a description for the package.

e In the Release field, type the release number of the software.

f From the Class drop-down list, select the class for which you want to create the 
instance. In some cases, the class selection is not honored and the instance is created 
for the default class for the selected domain.

2 In the Limit package to systems with area, enter the following information. If none of 
these options is selected, the package will be available to all eligible users.

a Operating system
Select the operating systems to which this package applies.

b Hardware
To limit distribution based on minimum RAM or processor speed, select the check box 
next to the appropriate configuration option and enter the minimum requirement in 
the text box provided.

You may want to establish a naming convention to ensure that identifiers are 
unique. HPCA Administrator Publisher uses this identifier to construct data 
objects and file names. For more information, see Appendix B, Naming 
Conventions.
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3 Click Next to go to the Service Information window

4 Select Create new if you want to create a new service, Use existing to use an existing 
service, or No service to skip creating a service at this time.

5 Enter a Name, Display name, Vendor, Web URL, Description, and Author.

6 In the Assignment type section, select whether the service is mandatory or optional. 
Mandatory is the default. This will distribute the service to all available users. Optional 
services are only available if you are using the HPCA Application Self-service Manager.

7 In the Management type section, indicate how the application will be managed after it 
is deployed.

If you want to create only a package, select No service. This is useful if, for 
example, you have a single service, but want to create multiple packages and later 
connect them to the existing service using the HPCA Administrator CSDB Editor.

If you are using an existing service, make sure you enter the service name 
correctly.
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Management type and Assignment type correspond to the ZSVCMO service attribute 
value. This field can contain two values, depending on what you select for each type. The 
table below displays the possible attribute values.

8 In the Report on the following events section, select the events you would like to 
record. If you would like to use the default application reporting events available in the 
Base Instance, select Use Base. 

9 Click Next to open the Publish window.

Task 4: Publish the Package

Use the Publish window to view the package and service information and then to publish it.

To publish the package

1 Click Publish. The package is published to the database.

2 Click Finish when the status bar at the bottom of the window displays the message, 
Process completed successfully.

3 Click Yes to confirm that you want to exit.

You can now view the published service in the HPCA Administrator CSDB Editor.

Table 17 ZSVCMO Variables

Assignment Type Management Type
ZSVCMO 
Value Explanation

Mandatory Automatic M Service is deployed to all users and 
managed by HPCA.

Mandatory Manual MO Service is deployed to all users and 
is not managed by HPCA after 
deployment.

Optional Automatic OM Service is deployed only to those 
users that accept it and is 
managed by HPCA.

Optional Manual O Service is deployed only to those 
users that accept it and is not 
managed by HPCA after 
deployment.

If you need to change or modify your selections, click Previous until you reach the 
appropriate window. When you are satisfied with the package, click Next until you 
arrive back at this window.

You can also use the buttons in the toolbar to return to a previous screen.
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Figure 2 Sample Application

HPCA Batch Publisher

The HPCA Batch Publisher is a command-line alternative to using Component Select Mode. It 
offers an automated, repeatable command-line process to create packages and store them in 
the CSDB. For more information, see the HP Client Automation Batch Publisher Installation 
and Configuration Guide.

The HPCA Batch Publisher can:

• Search for files on multiple drives/file systems.

• Search for and publish files from any mapped file/drive system.

• Be configured to limit the subdirectories that are searched.

• Include or exclude at the file level.

• Select files by type.

The HPCA Batch Publisher can also accommodate frequent patching of internal applications. 
Its capacity to revise content is reliable, and can be designed to perform continuously, at 
designated times, and at predetermined intervals. The HPCA Batch Publisher can be easily 
executed from within any script or code capable of calling a command prompt.

The HPCA Batch Publisher is an optional feature available from HP. Contact your 
sales representative for more details.
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Windows Installer Files

Windows Installer uses MSI files to distribute software packages to your operating system. 
The HPCA Administrator Publisher uses the files to create a package and service that are 
then published to the CSDB. After they are added to the CSDB, the software packages are 
ready for distribution to your environment.

VMware ThinApp Isolated Applications

The HPCA Administrator Publisher has been updated to recognize the existence of a VMware 
ThinApp Isolated Application packaged inside an MSI. If detected, Advanced Publishing 
Mode will be disabled and the associated service will be marked as containing a VMware 
ThinApp, see Advanced Publishing Mode on page 63. The administrator is asked if he wants 
to enable auto-updates of the ThinApp by using VMware’s AppSync facility. If selected, this 
option will also be indicated inside the associated service for future processing. This change is 
the first step in tighter integration with virtual applications, and can be leveraged in future 
improvements in this area.

To publish Windows Installer files

1 Access the HPCA Administrator Publisher.

2 From the Type of data to publish drop-down list, select Windows Installer.

3 Click OK. The Select window opens.
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Task 1: Select Files to Publish

Use the Select window to select all the files that you want to include in the package.

1 In the left pane, select the Windows Installer file that you want to publish. The right pane 
displays any information that is available for the .msi file you select.

2 In the Publish mode section, select either Basic or Advanced.

3 Click Next to go to the Edit window.

Task 2: Edit File Properties and Methods

This task differs depending on whether you:

• Selected a Microsoft patch file (.msp) in Task 1, Step 1. If so, see Upgrading an Existing 
Package using an .MSP File on page 63.

• Selected the Advanced publishing mode in Task 1, Step 2. If so, see Advanced Publishing 
Mode on page 63.

• Selected the Basic publishing mode in Task 1, Step 2. If so, see Basic Publishing Mode on 
page 69.

Make sure the Windows Installer file folder location does not contain a lot of files. 
HPCA Administrator Publisher reads all the files in the folder location to enable 
publishing of additional files along with the Windows Installer file. Depending on 
the number of files, the HPCA Administrator Publisher can take considerable 
amount of time to respond. To avoid this, place the Windows Installer file in a 
separate folder location along with the additional files you want to publish to the 
CSDB.
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Upgrading an Existing Package using an .MSP File

If you selected a Microsoft patch file (.msp) to publish, the Edit window will have only one 
option: Upgrade. The Upgrade Existing window shows all available packages in the CSDB 
that can be upgraded with the selected file.

1 From the Upgrade Existing window, select the corresponding package that you want to 
upgrade.

2 Select any of the options in the Use existing section at the bottom of the window to use 
the existing package's features, properties, or transforms.

You can also upgrade an existing package using another Windows Installer file. When 
publishing this type of file (.msi), the Advanced Publishing Mode presents you with the 
Upgrade option. For more information, see Advanced Publishing Mode on page 63.

Advanced Publishing Mode

The Advanced Publishing mode enables you to edit many of the publishing options used to 
create the package.

The HPCA Administrator Publisher will create a new package for the upgrade. After the new 
upgrade package is published to the CSDB, connect it to the existing package using the 
HPCA Administrator CSDB Editor. For more information on HPCA Administrator CSDB 
Editor, see HP Administrator CSDB Editor on page 91.
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To publish in Advanced Publishing Mode

1 If the Administrative Install Point (AIP) window is not open, click the Admin Install Point 
option on the left. The Administrative Install Point (AIP) window opens.

2 In the Administrative Install Point (AIP) window make the following selections to create 
an AIP:

Creating the Windows Installer AIP

Previously, the Windows Installer publishing process required the manual 
creation of an AIP outside of the publishing process. This is no longer required. 
Now, you can supply the .msi file in its original state without any modifications 
and the HPCA Administrator Publisher then automatically creates the AIP in the 
short file name format.

Table 18 Creating an AIP

Options Description

Publish with AIP Select this check box to publish using an AIP.

AIP location Type in or click Browse to designate the AIP 
location.

Execute user interface Select to execute either a full or basic user 
interface after package installation.
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3 Click Installation Simulator, then click Run User Interface. This will simulate an installation, 
but will not actually install the software.

4 Click Features. The Features window opens. Use this window to configure the available 
MSI features.

Delete AIP when 
publishing complete

Select to delete the AIP after the package is 
published to the CSDB.

Connect AIP package 
to service

Select to connect the AIP package to the 
associated service.

Use local AIP support 
for MSI redirector

Select to create a temporary local AIP to support 
Client Automation advanced data management 
and caching during the installation. Enable this 
feature for installations that do not inherently 
support HTTP-based MSI installs. After selected, 
select the Use long filenames check box to use long 
file names.

Optional arguments for 
AIP creation

Type any additional arguments to include during 
the AIP creation.

Table 18 Creating an AIP

Options Description

In order to connect the AIP package to the service, select the Connect AIP package 
to service check box. When this check box is selected, the AIP package will be 
connected to the service and will have its ZSTOP000 set to 1. This prevents the 
AIP package from being delivered to the desktop, but its connection to the service 
will guarantee its travel during Proxy Server operations.
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5 Right-click each feature and select if you want it to be hidden or disabled.

6 Click Properties.

7 In the Properties window, view and modify the msi file properties. Some Windows 
Installer files may require additional command line parameters to deploy correctly. For 
example, an application may require a custom property to pass a serial number during 
installation. Use the Properties window to include any additional parameters.

— Click Add to add a new property.

— Click Remove to delete an existing property.

— To modify a property Name or Value, click the item you want to change and enter the 
new value.

8 Click Transforms. Use this window to reorder the application of any transform files 
associated with the Windows Installer file.

Selecting features using the above interface overrides ADDLOCAL command 
specified in the command line. If you install a .msi file using ADDLOCAL 
command, make sure you disable all the MSI features before you start the 
installation. To disable the MSI features while publishing, use HPCA 
Administrator Publisher or HPCA Administrator CSDB Editor and set 
DISABLE=Y in MSIFEATS class.
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9 Click Machine / User. Use this window to define Machine/User parameters.

— Enable per user installation – Select this option to automatically generate a new 
user MSI package to be used to manage Machine/User component installations.

— Available resources per user – Select which resources should be made available 
per user.

10 Click Upgrade. This window displays existing MSI packages in the CSDB that are 
available for upgrade using the current Windows Installer patch (.MSP). Select to use 
existing features properties or transforms by selecting the appropriate options.
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11 Click Additional Files. Select any additional files that you want to include as part of the 
AIP.

12 Click Behaviors. This window contains options for using a local MSI file cache, enabling 
local repair, saving Internet cache, controlling MSI features, and determining salvage 
status.

— Use local cache for MSI files – Select this to determine the location and size of your 
cache. Enter the cache location in the Cache location text box and the upper limit of 
the percentage of disk space to be used in the Disk percent for cache text box.

When you select Use local cache for MSI files, during the application installation, the 
cache directory is created in the specified location. If the used disk space on the target 
machine becomes greater than the cache percentage limit, caching is automatically 
turned off.

— Use local repair – Select this to enable local repair. Choosing this option retains the 
MSI cache on the local agent computer, and enables repairs to be made locally, instead 
of going back to the CSDB for the missing or required data.

— Preserve internet cache – Select this to avoid having the Internet cache purged 
after an HTTP installation.
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— Salvage – Enables you to take advantage of existing files on the target computer. 
When a package is installed, if any portion of that package is discovered, the 
installation will use the existing files instead of going back to the CSDB for the 
redundant data. You have the option to enable the Salvage feature for HPCA managed 
and unmanaged applications, select the appropriate options--Managed applications or 
Unmanaged applications-- to determine which type of application should have this 
feature enabled. Both types of applications can be selected.

— User controls MSI features – Select this to enable the end user to control which 
MSI features are installed during the installation. Selecting this option displays the 
feature editor during the application installation.

13 Click Next to go to the Configure window.

Basic Publishing Mode

The basic publishing mode offers four options, which are available in the Publishing Options 
window.

To publish in Basic Publishing Mode

1 After you select the publishing mode in the Select window, click Next. The Edit window 
opens. This window contains four options, click any link to configure that aspect of the 
basic publishing mode.

— Management Options

Select which management option you would like to apply. The Management Option 
you select defines how the application will run after it is deployed.

– Use setup

– Use msiexec

– Command line

— Transforms

Reorder the application of any transform files associated with the Windows Installer 
file.

— Additional Files 

Apply any available additional files.
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— Upgrade

Displays existing MSI packages within the CSDB that are available for upgrade using 
the current Windows Installer package. Select this to use existing feature properties 
or transforms by selecting the appropriate options.

2 When you are finished editing the publishing options, click Next to go to the Configure 
window.

Task 3: Enter Package and Service Information

Use the Configure windows to enter information about the package and the service. For 
detailed description of these windows, see Enter Package and Service Information on page 56.

1 In the Package information section, enter the package information.

2 Use the Limit package to systems with section to limit the package to any specific 
operating system or hardware. Click any link to display the options.

3 Click Next. The Service Information window opens.

4 Enter service information in this window

5 Click Next to go to the Publish window.

Task 4: Publish the Package

1 Review the Summary section to verify the package and service information you provided 
during the previous steps. When you are satisfied, click Publish.

2 When the publishing process is finished, click Finish to exit the Publisher. Use the HPCA 
Administrator CSDB Editor to view your operating system package or service.

The service is now ready for distribution to your enterprise.

Command Line Publishing

The HPCA Administrator Publisher supports a non-graphical publishing mode that 
substitutes any values entered in the HPCA Administrator Publisher interface with values 
predefined in a configuration file. The configuration file enables you to predefine any package 
and service values and store them in a text file. Run the HPCA Administrator Publisher from 
the command line with the parameter –cfg designating which configuration file to use during 
the publishing session.

The following is a sample command line to run the HPCA Administrator Publisher with a 
configuration file called test.cfg:

The zcreate.cmd file enables the ZCREATE method to contain more than 100 
characters. This is applicable for the Windows Installer mode and the Component 
Select Mode in HPCA standard edition.

In the Basic Publishing Mode, a patch (.msp) file cannot be updated in an existing 
installer (.msi) file. The Advanced Publishing Mode supports the feature to 
update an existing .msi file.

Command line publishing is only supported for Windows Installer (.msi) files.
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nvdtk.exe pubport.tkd –cfg "c:\program files\test.cfg" –user <USER> –
password <PASSWORD>

The following table describes the parameters of the configuration file.

Make sure to use a fully qualified file name when designating the configuration 
file.

Table 19 Configuration file parameters

Parameter Description

package Defines the PACKAGE Class instance name.

pkgname Specifies the friendly name of the PACKAGE Class instance (NAME 
attribute).

pkgdesc Specifies a description of the PACKAGE Class instance (DESCRIPT 
attribute).

service Defines the name of the ZSERVICE Class instance that will be 
optionally created.

svcname Specifies the friendly name of the ZSERVICE instance (NAME 
attribute). The ZSVCNAME attribute is also set from this value.

svcdesc Specifies a description of the ZSERVICE Class instance (DESCRIPT 
attribute).

addtosvc Controls whether or not a service instance is created for this session.
1 = create service
0 = don't create

path Defines the CSDB path to the file and domain to which the package 
will be published, for example, PRIMARY.SOFTWARE.

attr CLASS {body} Additional instance attribute values to be added during the publishing 
process. Note that the HPCA Administrator Publisher only supports 
PACKAGE and ZSERVICE as values for CLASS. Any attribute of these 
classes can be passed, even those not supported by the interface. 
Examples:

attr ZSERVICE {

AUTHOR  {John J. User}

URL        {http://www.nowhere.com}

      OWNER        {Microsoft Corp}

                                  }

      attr PACKAGE {

      RELEASE       {1.0}

      }

Enclose values in braces.
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msi {body} This section specifies MSI interface settings. The settings you can use 
are:

• aiplocation
This specifies where the AIP is to be created (if needed).

• publishmode
Advanced or Basic.

• execui
How to execute the MSI interface during AIP creation. The 
values you can use are Full, Basic, or None.

• deleteaip
Whether or not to delete the AIP after publishing. The values 
you can use are y or n.

• aiparguments
Optional arguments for AIP creation.

• enableperuser
Whether to disable per user installation of this package (N) or 
any combination of the following: S=shortcuts, R=registry, 
E=private exe, D=private dll. Specifying "SD", for example, will 
turn on per user installation for shortcuts and private dlls.

• additionalfiles
Whether additional files should be included. The values you 
can use are y or n.

• connectaiptosvc
Whether the AIP should be included. The values you can use 
are y or n.

Following is an example of the msi section:
msi {

               aiplocation        {c:\testaip}

               publishmode     advanced

               execui          none

               deleteaip       n

               aiparguments    ""

               enableperuser   sre

}

Note: Values are case-sensitive.

Table 19 Configuration file parameters

Parameter Description
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Here is a sample configuration file.

pkgname         MYTESTPKG

package         CJMTEST

pkgdesc         {This is a test package}

path            PRIMARY.SOFTWARE

addtosvc        1

service         CJMTESTS

svcname         MYTESTSVC

svcdesc         {This is a test service}

customZcreate   0

appendTransform 1

appendMsiProp   1

attr PACKAGE {

        RELEASE 1.0

        BEHAVIOR

}

attr ZSERVICE {

        AUTHOR      me

        URL         {HTTP://WWW.NOWHERE.COM}

        OWNER       {Microsoft Corp.}

        PRICE       {5}

}

customZcreate Enables you to create a customized zcreate.cmd file. By default, 
HPCA Administrator Publisher creates a zcreate.cmd file if the 
ZCREATE method exceeds more than 100 characters.
1= creates a customized zcreate.cmd file.
0= HPCA Administrator Publisher creates the zcreate.cmd file.

appendTransform Enables you to append the transform (.mst)  files specified at the end 
of the ZCREATE method. By default, transform files are added to the 
ZCREATE method if they reside in the same location as the .msi files.
1= HPCA Administrator Publisher appends the transform files.
0= HPCA Administrator Publisher does not append the transform files.

appendMsiProp Enables you to append the MSI properties specified at the end of the 
ZCREATE method.
1= HPCA Administrator Publisher appends the MSI properties.
0= HPCA Administrator Publisher does not append the MSI 
properties.

Table 19 Configuration file parameters

Parameter Description
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msi {

        aiplocation     {g:\aip}

        publishmode     advanced

        deleteaip       n

        aiparguments    {}

        enableperuser   n

}

Defining Windows Installer Files to Publish on the Command Line

In addition to defining a configuration file, you can define any Windows Installer file to be 
published on the command line. Use the –file parameter to define which Windows Installer 
file to use in the publishing session.

nvdtk.exe pubport.tkd –cfg "c: \program  files\test.cfg"  -file 
"c:\program files\test.msi" –user <USER> –password <PASSWORD>

Publishing Multiple .msi Files (Batch Mode)

The HPCA Administrator Publisher enables you to publish multiple .msi files to the CSDB 
during one publishing session. This is achieved by calling the Publisher from the command 
line and designating a location using the –batchmsi parameter. The Publisher then scans 
this location and all subdirectories for .msi files as well as any configuration files or 
transform (.mst) files.

Directories are scanned until a conforming directory is found. Each directory should contain 
the components of an HPCA package that will be published to the CSDB, including at least 
one .msi file as well as, optionally one configuration file and any applicable transform files. 
After a conforming directory has been processed, scanning continues to look for additional 
conforming directories that exist under the starting directory.

The files contained in the designated location must follow a few simple rules:

• If more than one .msi file exists in a directory, an error will be recorded and the 
publishing session scan will continue.

• If more than one configuration file exists in a directory, an error will be recorded and the 
publishing session scan will continue.

• If desired, only one configuration file can be used for all .msi files found. When only one 
configuration file is discovered in the root directory location, the HPCA Administrator 
Publisher will apply that configuration to all .msi files it finds thereafter. To define a 
unique name to each package then, use symbolic substitution, as described in 
Customizing Configuration File Values with Symbolic Substitution on page 77.

• In order for the scan to be successful, at least one configuration file must be present at the 
root directory location or co-located with any MSI that is found.

Unlike publishing single .msi files using the command line, when publishing 
batches of .msi files with the HPCA Administrator Publisher, the command line 
parameter –cfg cannot be used to designate a configuration file. Instead, at least 
one configuration file must be included within the .msi file directory location.
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• The scan is run repeatedly until an MSI file is found. At that point, the MSI file is 
processed, and the scan does is not run any deeper in that directory tree. Scanning 
continues at the parent directory of the MSI file that is found.

• If the additionalfiles keyword was defined with a y value in the configuration file, any 
additional files at the level of the MSI file and below are included with the AIP (in 
advanced mode) or the package (in basic mode).

• In batch mode, any transform files co-located with the MSI file are included in the 
package.

The following is a sample command line to run the HPCA Administrator Publisher and 
designate a location to scan:

nvdtk.exe pubport.tkd –batchmsi "c:\msifileslocation" –user <USER> –
password <PASSWORD>

This example will cause the HPCA Administrator Publisher to scan the directory 
c:\msifileslocation and all its subdirectories looking for .msi files as well as any 
configuration files or transforms.

When the publishing session is finished, verify the session by referring to the pubport.log 
file located in your log directory.

Using Multiple Configuration Files

As discussed in Customizing Configuration File Values with Symbolic Substitution on 
page 77, only one configuration file is required for all the .msi files that you publish as long 
as you are using symbolic substitution to assign unique package names. However, if you 
would like to apply a separate configuration file to each .msi, then a separate configuration 
file must reside within the directory of the .msi to which it will be applied.

Any configuration file found within a directory will be applied to the .msi file found within 
that directory and any subsequent .msi files found in each subdirectory, unless another 
configuration file is found.

For instance, the Acrobat Reader 6.msi file, as displayed in Figure 3 on page 76, will use 
the configuration file global.cfg, located in the root location directory, \Adobe MSI Apps 
to Publish, since no configuration file is included in the \Acrobat Reader 6.0 directory.
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Figure 3 Root location directory that contains configuration file

Figure 4 Configuration files within the directory structure

Including Transform (.mst) Files

You can apply any number of transform files with your .msi files by including those 
transforms in the same directory with the .msi file to which they will be applied. Transform 
files are only applied to the .msi file with which they share a directory.

Figure 5 on page 77 displays two transform files, both of which will be included with the 
Photoshop 7.msi package upon publication.
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Figure 5 Transform files included in the directory structure

Customizing Configuration File Values with Symbolic Substitution

If you want to publish similar .msi files and would like to use only one configuration file, you 
can direct the HPCA Administrator Publisher to use symbolic substitution to assign unique 
values. For instance, to create unique package names set the pkgname variable within the 
configuration file to %MSIPROP.VARNAME% or another symbolic variable as found in your .msi 
file. When used, the HPCA Administrator Publisher will search the current individual .msi 
file it is publishing and substitute the pkgname value with the corresponding value found 
within the .msi file, based on the symbolic value you supplied.

The sample configuration file below that displays the use of symbolic substitution.

# 
-----------------------------------------------------------------------------
-----------

#      Publisher – Sample imbedded MSI Properties Configuration File                      

# 
-----------------------------------------------------------------------------
-----------

#----------------------------------------------------------------------------
-------------

#      Package related variables

#----------------------------------------------------------------------------
-------------

pkgname              {%MSIPROP.RADIA_PKG_DISPLAY_NAME%}

package              {%MSIPROP.RADIA_PKG_INSTANCE_NAME%}

pkgdesc              {%MSIPROP.RADIA_PKG_DESCRIPTION%}

path                 {PRIMARY.SOFTWARE}

You cannot use symbolic substitution for the path attribute.
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#----------------------------------------------------------------------------
-------------

#      Service related variables

#----------------------------------------------------------------------------
-------------

addtosvc             {%MSIPROP.RADIA_ADDTOSVC%}

service              {%MSIPROP.RADIA_SVC_INSTANCE_NAME%}

svcname              {%MSIPROP.RADIA_SVC_DISPLAY_NAME%}

svcdesc              {%MSIPROP.RADIA_SVC_DESCRIPTION%}

attr PACKAGE {

     RELEASE         {%MSIPROP.RADIA_PKG_RELEASE%}

}

attr ZSERVICE {

     AUTHOR          {%MSIPROP.RADIA_SVC_AUTHOR%}

     URL             {%MSIPROP.RADIA_SVC_URL%}

     OWNER           {%MSIPROP.RADIA_SVC_OWNER%}

     PRICE           {%MSIPROP.RADIA_SVC_PRICE%}

     ZSVCMO          {%MSIPROP.RADIA_SVC_ZSVCMO%}

     ZCREATE         {%MSIPROP.RADIA_SVC_ZCREATE%}

}

msi {

     aiplocation     {%MSIPROP.RADIA_AIPLOCATION%}

     publishmode     {%MSIPROP.RADIA_PUBLISHMODE%}

     execui          {%MSIPROP.RADIA_EXECUI%}

     deleteaip       {%MSIPROP.RADIA_DELETEAIP%}

     aiparguments    {%MSIPROP.RADIA_AIPARGS%}

     enableperuser   {%MSIPROP.RADIA_ENABLEPERUSER%}

     additionalfiles {%MSIPROP.RADIA_ADDITIONALFILES%}

}

Notice in the example above that every value for each package and service that is created will 
be generated from the associated .msi file property table.

There are two primary MSI substitution value sources.

• %MSISUMM_summary_variable_name%
extracted from the summary information associated with the MSI file.

• %MSIPROP_property_name%
extracted from the property table associated with the MSI file.
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Embedded MSI Properties and Extensions for Windows Installer User-Defined Properties

When you use the Extensions for Windows Installer to create an .msi package, you can 
automatically add a set of MSI properties and their default values. To do this use the HPCA 
Administrator Packager for Windows Installer → Windows Installer Options dialog box that is 
shown at the end of a Unified Packager session. Select the Information tab to define 
User-defined properties. You can manually add these properties to any package whether 
created by Wise, InstallShield, or another vendor.

Publishing Hardware Configuration Elements

Use the HPCA Administrator Publisher to publish hardware configuration elements for 
distribution to devices in your environment. For detailed information, see HP Client 
Automation OS Manager Hardware Configuration Guide. This guide contains detailed steps 
for publishing hardware configuration elements.

HPCA Administrator Screen Painter

This section contains a description of the HPCA Administrator Screen Painter, a tool that you 
can use to design and create dialog boxes. It provides an interface, with drag-and-drop 
capabilities, for creating and positioning typical controls such as check boxes, list boxes, and 
buttons.
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To open the Screen Painter

Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Screen Painter. The Screen Painter window opens.

File Menu

The following table describes the navigation features in the File menu.

Table 20 Screen Painter File Menu

Feature Function

New Creates a new dialog box.

Open Opens the Select a Panel Object File for Editing dialog 
box. From the list, select a panel object to edit.

Close Closes the current editing session.

Save Saves the current panel object with the same name.

Save As Saves the current panel object with a new name.

Revert Reverts to a previously saved version of the panel object.
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Edit Menu

The Edit menu contains the standard Windows editing functions.

Font Menu

The Font menu enables you to change the font of the text displayed for one or more selected 
dialog box elements.

Controls

The following instructions explain how to add and set controls in a dialog box, and how to add 
or change the title of a dialog box. Use either the Controls toolbar or the Controls menu.

Page Setup Select a portion of the current dialog box to make this option 
available. It is the standard Windows Print Setup dialog box.

Print Enables you to print a copy of the dialog box.
Note: HPCA Administrator Screen Painter’s Print function 
prints the current dialog box pixel-by-pixel, with one printer 
dot per pixel. If you have a high-resolution printer set at 600 
DPI, the resulting printout will be illegibly small. To fix this, 
use the Properties button of the Page Setup dialog box to 
reduce the printer resolution to approximate screen 
resolution. This will produce a printout roughly the same size 
as that which appears on the screen.

Exit Closes the Screen Painter.

Table 20 Screen Painter File Menu

Feature Function
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Controls Toolbox

The Controls toolbox provides buttons to facilitate the process of adding controls to a dialog 
box. The following is a table of the buttons and a brief description of the function of each 
control associated with it.

Table 21 Controls Toolbox

Book Button Name Function

Static Text For displaying labels, descriptions, and object 
variable values.

Edit For entering text and displaying object variable 
values.

Check Box For Yes/No or On/Off types of controls.

Push Button For performing an action such as EXIT or 
displaying another dialog box.

Radio Button For a multiple choice option where only one item 
can be selected.

List Box For a list of choices where only one item can be 
selected.

List Button For a drop-down list of choices where only one 
item can be selected.

Group Box For grouping and organizing controls.

Image For displaying a bitmap image.

Test For executing the dialog box in real-time mode.

Select For selecting and modifying dialog boxes, controls, 
and properties.
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Properties Box

Use the Properties box to assign properties to each element in the screen object. You will not 
need to assign all these properties to every control in your screen object. Some controls need 
only a few properties. Use the Properties box at the bottom of the HPCA Administrator 
Screen Painter window to add properties.

Figure 6 Screen Painter Properties box

The following table describes these properties.

Table 22 Properties box elements

Property Description

Name The label displayed on the control. Also used for indicating a 
target name.

Object The object from which the control reads and writes data.

Variable The variable from which the control reads and writes data.

Target The dialog box, file, or control that is affected by what is 
specified in the Action field.

Value Enabled only for Check Box, Radio Button, and List Box. See 
these sections for an explanation of specifications for this 
field.

Group ID A user-specified identifier that enables you to group together 
several controls.

Action Specifies what the control will do when selected.

Alignment Justification for the text entered in the Static field of the 
Static Text control. Push Button text defaults to 'center'.

Tab Order Specifies the order in which the control is reached when the 
user presses Tab. The default is the order in which the 
controls were added to the dialog box.

Active Determines whether the control will be initially selectable or 
dimmed. (default: Active.)

Visible Determines whether the control will be initially displayed or 
hidden. (default: Visible.)

Responds 
to <Enter>

Enables the user to select the selected Push Button by 
pressing Enter. This feature works only with Push Buttons, 
and only one per dialog box.
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Controls Menu

This section describes the controls that are available on the Controls menu.

Deleting a Control

Select one or more controls and press Delete to delete a control.

Static Text

Use this control to label other controls, or add descriptions or instructions to the dialog box.

To insert static text

1 Select the Static Text tool from the toolbar or Static Text from the Controls menu.

2 Click-and-drag a rectangle in the dialog box. Re-size this control later, if needed.

3 Click on the static text control just created.

4 In the Properties box, specify values for the active fields.

For the Static text control, the Name field becomes the Static field. This field enables 
you to enter static text to label a control (or controls) in this dialog box. Leave this blank if 
text is coming from a variable in an object.

Edit

Use this tool to add a text box. A text box is a control that enables the entry and display of 
variable data.

To insert a text box

1 Select the Edit tool from the toolbar, or Edit from the Controls menu.

2 In the dialog box, click-and-drag a rectangle. Re-size this control later, if needed.

3 Click on the text box just created.

4 In the Properties box, specify values for the active fields.

For the Edit control, the Name field becomes the Edit field. The Edit field is the name of 
the control for referencing in groups.

Push Button

A push button enables the user to initiate an action.

To insert a push button

1 Select the Push Button tool from the toolbar or Push Button from the Controls menu.

Revert Restores the property values for the control to when the 
control was last updated.

Cancel Closes the editing session without saving changes.

Help Invokes on-line help (not available yet).

Table 22 Properties box elements

Property Description
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2 In the dialog box, click-and-drag a rectangle. Re-size this control later, if needed.

3 Click the push button just created.

4 In the Properties box, specify values for the active fields.

For the Push Button control, the Name field becomes the Push field. The Push filed is 
text label displayed on the button.

The following table describes the actions that you can assign to a Push button.

Table 23 Actions for Push Buttons

Action Description

EXIT Saves the contents of the dialog box, and closes it.

CANCEL Closes the dialog box without saving changes.

SHOW Toggles the control whose name is specified in the Target field 
to be visible or invisible. If the Target field contains a Group 
ID for a group of controls in the dialog box, then that group of 
controls is made invisible or visible.

ENABLE Toggles the control whose name is specified in the Target field 
to be enabled (for example, capable of becoming the focus of 
input) or disabled (for example, dimmed, and incapable of 
becoming the focus of input). If the Target field contains a 
Group ID for a group of controls in the dialog box, then that 
group of controls is enabled or disabled.

PANEL Exits the current dialog box and displays the dialog box 
specified in the Target field. If the Target field is blank, then 
the Object and Variable fields specify a variable that contains 
the name of the dialog box to be displayed.
You can use a push button in conjunction with a list box to 
enable the user to select which dialog box to display next from 
a list. The user selects an item from the list box, and presses 
the associated push button to launch his choice. To accomplish 
this, the push button’s Target field must contain the name of a 
list box, and the push button’s Object and Variable fields 
identify some variable in the multi-heap object that is the data 
source for the list box. In each heap of the list box’s data source 
object, this variable contains the name of the panel object 
corresponding to the dialog box to display next, for the user 
choice associated with data displayed in the list box from that 
heap.
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Check Box

A Check box enables the user to indicate a binary choice such as yes or no.

To insert a check box

1 Select the Check Box tool from toolbar or Check Box from the Controls menu.

2 In the dialog box, click-and-drag a rectangle. You can resize this control later.

3 Click the check box just created.

4 In the Properties box, specify values for the active fields.

For the Check Box control, the Name field becomes the Check field. The Check field is 
label for the check box and the name of this control when referenced as a target by other 
controls.

LAUNCH Launches the application specified in the Target field. If the 
Target field is blank, then the Object and Variable fields 
specify the variable that contains the path and file name of the 
file to be launched.
You can use a push button in conjunction with a list box to 
enable the user to select which program to launch from a list. 
The user selects an item from the list box, and presses the 
associated push button to launch his choice. To accomplish 
this, the push button’s Target field must contain the name of a 
list box, and the push button’s Object and Variable fields 
identify some variable in the multi-heap object that is the data 
source for the list box. In each heap of the list box’s data source 
object, this variable contains the path and file name of the 
program to launch for the user choice associated with data 
displayed in the list box from that heap.

PREVHP Pages to the previous heap in a multi-heap object (if not on the 
first heap) and reloads all the controls that use that object. 
The object to be paged is specified in the Object field. The 
variable specified in the Value field is displayed.

NEXTHP Pages to the next heap of a multi-heap object (if not on the last 
heap) and reloads all the controls that use that object. The 
object to be paged to is specified in the Object field. The 
variable specified in the Value field is displayed.

LNCHEX Launch and Exit. Does the same thing as the LAUNCH action, 
and also exits the dialog box.

STDFILE Presents the standard Windows Open File dialog box and 
places the user’s selection (with full path information) into the 
variable specified by the Object and Variable fields.

STDFOLD Presents the standard Windows Select Folder dialog box, and 
places the user’s selection (with full path information) into the 
variable specified by the Object and Variable fields.

Table 23 Actions for Push Buttons

Action Description
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Radio Button

A Radio button enables the user to click one item from a set. Insert radio buttons 
individually, but group them in order to establish a set.

To insert a radio button

1 Select the Radio Button tool from the toolbar or Radio Button from the Controls menu.

2 In the dialog box, click-and-drag a rectangle. Re-size this control later, if needed.

3 Click the radio button just created.

4 In the Properties box, specify values for the active fields.

For the Radio Button control, the Name field becomes the Radio field. The Radio field 
is label for the radio button. The name of this control when referenced as a target by other 
controls.

Group Box

A Group box enables you to visually group a set of controls within a defined area of the 
dialog box.

To insert a group box

1 Select the Group Box tool from toolbar or Group Box from the Controls menu.

2 In the dialog box, click-and-drag a rectangle. Re-size this control later, if needed.

3 Click on the group box just created.

4 In the Properties box, specify values for the active fields.

For the Group Box control, the Name field becomes the Group field. The Group field is 
the text label for the group box.

List Box

A List Box is a scrollable box from which the user may select only one item at a time.

To insert a list box

1 Select the List Box tool from toolbar or List Box from the Controls menu.

2 In the dialog box, click-and-drag a rectangle. Re-size this control later, if needed.

3 Click the list box just created.

4 In the Properties box, specify values for the active fields.

For the List Box control, the Name field becomes the List Box field. The List Box field 
is the name of the control for specifying it as a target, and the name of this control when 
referenced as a target by other controls.

When created, a radio button defaults to a preset size. If the text entered exceeds 
the limits of the text box, expand it horizontally. The gray area will retain its size, 
but the full text will be displayed to the user.

First create and align the controls, then place a group box around them. This will 
save time if you decide to reposition, add, or delete controls that will be grouped.
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List Button

A List Button is a drop-down list control that enables the user to select one of the choices 
presented.

To insert a list button

1 Select the List Button tool from toolbar or List Button from the Controls menu.

2 In the dialog box, click-and-drag a rectangle. Re-size this control later, if needed.

3 Click the list button just created.

4 In the Properties box, specify values for the active fields.

For the List Button control, the Name field becomes the List field. The List field is the 
name of the control for specifying it as a target. Also, the name of this control when 
referenced as a target by other controls.

Image

To insert a bitmap image

1 Select the Bitmap Image tool from toolbar, or Image from the Controls menu.

2 Click-and-drag a rectangle proportionate to the image it will display. Re-size this control 
later, if needed.

3 Click the frame just created.

4 In the Properties box, specify values for the active fields.

For the Image control, the Name field becomes the Image field. The Image field is the 
full path of the bitmap image to be displayed, including the .bmp extension.

Select

The mouse-cursor functions as a select (arrow) tool. Click a control in the dialog box with the 
cursor in this mode, and HPCA Administrator Screen Painter selects it with handles.

To resize a control

Grab one of the control's handles and drag it to the desired size.

To reposition a control

Click-and-drag the item to the desired location.

Set Title

Name a dialog box to make it easier for the user to remember its function.

To give the dialog box a title

1 From the Controls menu, click Set Title, or double-click the blue title bar of the dialog box.

2 Type the title in the dialog box, and press Enter.

In order for your List Button to have drop-down capability, you must expand the 
control vertically in the design space.

The image is scaled to fill the entire frame.
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Alignment Menu

Arrange the controls you have inserted for a more legible appearance. The following table 
explains the nine options available for aligning controls.

The following instructions explain how to align controls. Users will find the dialog boxes 
easier to use if the controls are arranged in an orderly fashion. These features are available 
only from the Alignment menu.

To align controls

The first five options of the Alignment menu enable you to reposition controls for a standard 
appearance.

1 Drag-and-drop a reference control to the desired position.

2 Select at least three controls that you want to align with the reference control by holding 
down Shift and clicking each one.

— To align controls vertically, from the Alignment menu, click Align Lefts or Align Rights.

— To align controls horizontally, from the Alignment menu, click Align Tops or Align 
Bottoms.

Table 24 Alignment Functions

Feature Function

Align Tops Aligns the selected controls to the top edge of the 
uppermost selected control.

Align Bottoms Aligns the selected controls to the bottom edge of the 
lowest selected control.

Align Lefts Aligns the selected controls to the left edge of the leftmost 
selected control.

Align Rights Aligns the selected controls to the right edge of the 
rightmost selected control.

Align Centers Centers all selected controls on an imaginary vertical line 
that bisects the right edge of the right-most selected 
control and the left edge of the left-most selected control.

Align Same 
Height

Vertically resizes all selected controls to the same height as 
the (first) selected reference control.

Align Same 
Width

Horizontally resizes all selected controls to the same width 
as the (first) selected reference control.

Align Even 
Vertical

Adjusts the spacing among a group of selected controls so 
that there is an identical amount of vertical space between 
each pair of adjacent controls.

Align Even 
Horizontal

Adjusts the spacing among a group of selected controls so 
that there is an identical amount of horizontal space 
between each pair of adjacent controls.

At least three controls must be selected for the Align Even Vertical and Align Even 
Horizontal functions to have any effect.
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— To align controls by their centers, from the Alignment menu, click Align Centers.

To adjust a control's height and width

You can resize the controls for a consistent appearance.

1 Select a control to be used as a reference. (This control’s size will not change. The other 
controls will resize to the same height or width as this reference control.)

2 To select the remaining controls you want to resize, hold down Shift and click each one.

3 From the Alignment menu, click Align Same Height or Align Same Width.

To space controls

You can set the spacing between controls for a consistent appearance.

1 Hold down Shift and click at least three controls.

2 From the Alignment menu, click Align Even Vertical, or Align Even Horizontal.

System Menu

The System menu contains choices for testing the dialog box.

Periodically, during the dialog box creation, and especially after it is finished, it is a good idea 
to test it to ensure that it works as you designed and intended. Doing a test runs the Panel 
Manager program, edmpnlwr.exe, using the current dialog box. This shows how the dialog 
box will look when it is displayed in production.

There are two methods, which are discussed below, for testing a dialog box:

• Common

• REXX Processing

Common

To test a screen using the common method

1 Click the Test tool from the Controls toolbar or Test from the System menu.

2 To end the test, click the displayed dialog box's close icon, or click a push button whose 
action terminates the dialog box.

REXX Programming

To test a screen using the REXX processing

1 Click Use REXX for Test from the System menu.

2 To end the test, click the displayed dialog box's close icon, or click a push button whose 
action terminates the dialog box.

Do Not Resolve Panel

To display variable names without resolving objects

1 Specify the symbolic notation in the Name field of the controls that you want left 
unresolved. Note that HPCA always resolves any data specified in the Object and 
Variable fields in the Properties Box.

Align controls prior to placing a Group Box around them. Any aligning or 
positioning done now can be revised at a later time.
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2 From the System menu, click Do Not Resolve Panel.

Help Menu

About is the only function that currently works. It displays the HPCA version number.

HP Administrator CSDB Editor

This section describes how to use the HPCA Administrator CSDB Editor to manage the 
CSDB.

Getting Started

This section helps you understand the working of HPCA Administrator CSDB Editor better.

To open the HPCA Administrator CSDB Editor

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The logon dialog box opens.

2 Type your User ID and Password.

3 Click OK. The HPCA Admin CSDB Editor window opens.

HPCA Admin CSDB Editor Window

This is the main window of the HPCA Administrator CSDB Editor. This section guides you 
through the methods of customizing the look and feel of the HPCA Administrator CSDB 
Editor and the usage of its menu items.

The default user ID and password are:

User ID: ADMIN

Password: secret
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Customizing the HPCA Admin CSDB Editor Window

You can customize the look of the HPCA Administrator CSDB Editor and how it functions by 
using options from the shortcut menus. The most frequently used functions are available from 
the HPCA Administrator CSDB Editor Toolbar. For additional information about these 
functions, see HPCA Administrator CSDB Editor Toolbar on page 94.

HPCA Admin CSDB Editor Window Menus

This section describes each of the menus in the main HPCA Admin CSDB Editor window.

File Menu

Use these options to open additional HPCA Admin CSDB Editor windows or to close the 
current one. Multiple windows can be open at the same time. You can drag items between 
multiple windows.

Edit Menu

Use these options to edit the CSDB. The first six operations apply to the selected items in the 
active pane or dialog box.

Table 25 Edit Menu options

Operation Description

New Creates a new occurrence of the selected item such as 
domain, class, or instance.

Cut Removes the selected text and places a copy of it on the 
Windows clipboard.

Copy Copies the selected text to the Windows clipboard.

Paste Copies the current content of the Windows clipboard to 
the current cursor location.

Rename Changes the friendly name and/or internal name of the 
selected item.

Delete Removes the selected items from the CSDB.

Select All Selects all of the instances in the list view of an HPCA 
Administrator CSDB Editor window.

Invert Selection Toggles the selection status of the instances in the list 
view. The ones that are selected are cleared and those 
that are cleared are selected.

Find Searches the Name and Instance Name columns in the 
selected class for instances that contain the text you 
specify. The results of the search appear selected and 
sorted at the top of the list in the list view.
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View Menu

Use these options to control the appearance of the HPCA Administrator CSDB Editor. You can 
show or hide the toolbar and status bar, control the size and display of the icons, refresh the 
window, or set the display and operational options with the help of this menu.

Window Menu

Use these options when you have more than one HPCA Administrator CSDB Editor window 
open.

Table 26 View Menu options

Options Description

Toolbar Toggles the toolbar display on and off.

Status Bar Toggles the Status Bar display on and off.

Tree Icons Toggles the display between large and small icons.

List View Select from among four different displays for your list view—
Large Icons, Small Icons, List, and Details.

Line Up 
Icons

Re-arranges the list view, arranging the icons either vertically 
or horizontally.

Refresh Re-arranges the list view of the selected HPCA Admin CSDB 
Editor window, lining up all of the elements for easy reading.

Options Opens the HPCA Administrator CSDB Editor Options dialog 
box. For more information, see Setting Preferences: Options 
Dialog Box on page 95.

Font Opens a dialog box that enables you to change the font used to 
display text in the HPCA Administrator CSDB Editor 
windows.

Table 27 Window Menu options

Option Description

Cascade Organizes and overlaps the windows starting at the top, 
left corner of the HPCA Administrator CSDB Editor 
interface.

Tile Horizontal Automatically sizes open windows to the width of the 
HPCA Administrator CSDB Editor interface. It allocates 
the available height within the HPCA Administrator 
CSDB Editor interface equally, stacking the windows one 
on top of the other.
HP Client Automation Administrator Tools for Windows 93



Help Menu

Get details about the HPCA Administrator CSDB Editor and the link to the HP Software web 
site.

HPCA Administrator CSDB Editor Toolbar

The HPCA Administrator CSDB Editor toolbar provides easy access to frequently used 
functions.

Figure 7 HPCA Administrator CSDB Editor Toolbar

Tile Vertical Automatically sizes open windows to the height of the 
HPCA Administrator CSDB Editor interface. It allocates 
the available width equally, stacking the windows next to 
each other.

Arrange Icons Docks minimized HPCA Administrator CSDB Editor 
windows in the bottom left corner of the interface.

1 1:CSname – 1 CSname stands for the Configuration Server name. 
Multiple View enables the administrator to toggle 
between open HPCA Administrator CSDB Editor 
sessions. A check mark next to a session indicates which 
window is active.

Table 28 Help Menu options

Option Description

Contents Opens a traditional Windows-style help interface. 

Hewlett-Packard 
on the Web

Opens a sub-menu with links to the Hewlett-Packard 
web site pages for Technical Support and Home Page. 
Selecting one of these links opens your default Web 
browser and connects to the selected page over the 
Internet.

About CS 
Database Editor

Displays information about the current HPCA 
Administrator CSDB Editor version number, 
Configuration Server information, and so forth. Click 
System Info to display a standard Microsoft System 
Information window. This application analyzes your 
machine and shows the results in an easy to navigate 
format.

Table 27 Window Menu options

Option Description
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The following table describes the functions of these toolbar buttons.

Setting Preferences: Options Dialog Box

The HPCA Administrator CSDB Editor has an Options dialog box that enables you to control 
some of the features of the HPCA Administrator CSDB Editor.

To open the Options dialog box

1 Click View → Options.

There are three tabs on the Options dialog box:

Table 29 CSDB Editor Toolbar buttons

Button Function

Open a new HPCA Administrator CSDB Editor window.

Not available.

Copy the selected item.

Not available.

Delete the selected item.

Display the database level above.

Display large icons in the tree view.

Display small icons in the tree view. Maximizes the number of 
items that can be seen in the list view of the HPCA Administrator 
CSDB Editor at one time.

Display large icons in the list view.

Display small icons in the list view. Maximizes the number of 
items that can be seen in the list view of the HPCA Administrator 
CSDB Editor window at one time.

Display the list view vertically. Maximizes the number of items 
that can be seen in the list view of the HPCA Administrator 
CSDB Editor window at one time.

Display the list view vertically. Adds a column for TYPE such as 
Class and Instance. Maximizes the number of items and provides 
detailed description of the list view.
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— General

— Instance Options

— Advanced

2 Click a tab to access its configuration options.

General Tab

Figure 8 HPCA Administrator CSDB Editor Options General tab
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The following table describes the General tab options.

Table 30 Functions of General tab options

Option Function and Use

Window & 
Font Settings

Select the Save on Exit checkbox to  tracks certain window 
settings and the font to use for displaying text when you 
exit from the HPCA Administrator CSDB Editor session.
The window settings include the view setting for example, 
large icons, small icons, list, or details, for the tree and list 
views of the HPCA Administrator CSDB Editor window, and 
the relative width of each pane. Window settings are saved 
independently for each level of the HPCA Administrator 
CSDB.
Save Now saves the current window settings and font in use.
To change the font, select a font from the dialog box that 
opens when you click View → Fonts from the menus.

Open Class 
Editor When

A New Class is Added opens the Editing Class dialog box 
when you add a class.
A Class is Copied opens the Editing Class dialog box when 
you copy a class.
Since you will probably want to edit the newly copied or 
newly added class, HP recommends that you have these two 
options selected.

Show Class 
Names Next 
to 
Descriptions

Shows the HPCA internal name for classes next to their 
friendly names in the tree view and in the list view. The 
internal name will appear in parentheses next to the 
friendly name.
This is useful if you usually do not use the Details View for 
the list view. The Details View in the list view window 
always shows the internal name for classes in the Type 
column.

Show n 
Instance 
Prefix(es) in 
the Tree

This option can be set to 0, 1, 2, or 3 to control how many 
levels of instance name prefixes--delimited by the 
underscore character--will be compressible and expandable 
in the tree view. This is described in Navigating the HPCA 
Administrator CSDB EditorNavigating the HPCA 
Administrator CSDB Editor on page 101.
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Instance Options Tab

Figure 9 HPCA Administrator CSDB Editor Options Instance Options tab

Show Grid 
Lines When 
List Is Set To 
Details View

Displays grid lines in the list view when its view option is 
set to Details.

Uppercase 
the User ID 
at CSDB 
Editor Logon

Automatically converts the user ID into all uppercase.

Lock the 
splitter bar 
distance to 
the right side 
of the screen

Locks the width of the right side of the HPCA Administrator 
CSDB Editor window during resizing.
When this check box is not selected and the window is 
resized, the width of the left side of the window remains 
fixed, and the width of the right side of the window varies.

Table 30 Functions of General tab options

Option Function and Use
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The following table describes the Instance Options tab options.

Table 31 Functions of Instance tab Options

Options Functions and Use

Prompt These four check boxes control whether HPCA 
Administrator CSDB Editor prompts you before completing 
the actions indicated by their descriptions.

Warn before 
trying to 
display more 
than n 
instances

In large desired states, certain classes such as FILE or 
USER can contain many instances. If you attempt to view 
the instances of a class that contains more instances than 
this option setting, a warning opens. This gives you the 
opportunity to filter the class instances, before they are 
displayed. This is a performance issue. If you try to display 
too many instances, you will wait while the HPCA 
Administrator CSDB Editor retrieves them from the CSDB, 
and you will have to scroll through a large list to find the 
instances you want to work with.

• Click Yes to open the Filter Class dialog box, and 
enter an appropriate filter.

• Click No to display all of the instances.

• Click Cancel to close the warning without displaying 
any instances.
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When 
Displaying 
Instance 
Attributes, 
Show 
Attribute

This setting determines which columns to display such as 
Name, Description, or both in the Details view on the list 
view of the window, when you open an instance by 
double-clicking its name in the tree view.

Use Edit 
Masks When 
Editing 
Instances

This setting determines whether the Edit Instance dialog 
box will be sensitive to the attribute type in the data entry 
area of the dialog box.
If you select this option, attributes that hold logical data 
such as Yes or No have check boxes in the data entry area. 
Attributes that have multiple choices have drop-down lists in 
the data entry area. A flag set will appear as a series of check 
boxes in the data entry area.
You can set the mask by entering the valid choices for an 
attribute within square brackets at the end of the attribute's 
description in the class definition.
If you do not select this option, all data entry in the Edit 
Instance dialog box will be plain text.
This facility is described in detail in Optional Attribute 
Editing ControlsOptional Attribute Editing Controls on 
page 114.

Highlight 
_BASE_ 
inherited 
variables 
with an 
Underscore 

Use this setting if you want to see which values in an 
instance are inherited from the _BASE_INSTANCE_ of the 
class. The inherited instances will show with a red 
underscore.

Table 31 Functions of Instance tab Options

Options Functions and Use
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Advanced Tab

Figure 10 HPCA Administrator CSDB Editor Options Advanced tab

The following table describes the Advanced tab options.

Navigating the HPCA Administrator CSDB Editor

The CSDB is hierarchically organized and subdivided into files, domains, classes, and 
instances. The tree view enables you to view successively lower levels in the hierarchy, and 
easily locate and work with specific CSDB components.

Table 32 Functions of the Advanced tab Options

Options Functions and Use

Tracing Options Use these settings only for 
troubleshooting the HPCA 
Administrator CSDB Editor.

Show Add, Edit and Replace 
options for File type 
components

• Edit this Component
• Replace Component Data
• Add a Component
For details, see Appendix B, 
Naming Conventions.
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To navigate the tree structure

1 Open the HPCA Administrator CSDB Editor, and double-click PRIMARY in the tree view.

The HPCA Admin CSDB Editor window will be similar to the following:

2 To open a CSDB domain, double-click its icon.

Navigation History

Most navigation features in the HPCA Administrator CSDB Editor are similar to those in 
Windows Explorer. However, to discard the history of which branches were previously opened 
beneath a particular component, use the Prune Below function.

The PRIMARY File domains will vary according to which HPCA products have 
been installed in your environment.
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To use the Prune Below function

1 Right-click the SOFTWARE domain icon in the tree view. A shortcut menu opens.

2 Click Prune Below. The tree view collapses all open nodes below the SOFTWARE domain, 
and discards navigation history.
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Compound Names

Use compound names to make navigation in the tree view more manageable. HPCA provides 
one, two, or three collapsible levels, based upon one, two, or three high-level qualifiers of the 
instance name.

A compound name has one, two, or three prefixes, each separated from the rest of the name by 
an underscore character. For example, you might want to group your users according to the 
building where they are located. Instance names for these users will have a building identifier 
prefix. If you had users in the Empire State Building, you might assign ESB_ as the instance 
name prefix to identify them. Each user in the Empire State Building will be assigned an 
instance name beginning with ESB_. The tree view will automatically add a level.

Figure 11 Compound Names

The number of prefix levels in an instance name (0, 1, 2, 3) that are displayed in the tree view 
is controlled by the Show n Instance Prefixes in the Tree option setting. This is found on 
the General tab of the Options dialog box and can be accessed from the View menu. The 
Options dialog box is described in Setting Preferences: Options Dialog Box on page 95.
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Each underscore in an instance name defines a level for the tree view. Thus, the instance 
name ESB_FLOOR10_USER1 has two levels of prefix, which, if the setting Show n Instance 
Prefixes in the Tree were set to 2 or 3, would be displayed in two collapsible non-elementary 
levels (FLOOR10, within ESB).

Inheritance in the CSDB

Each class in the CSDB has a base instance, named _BASE_INSTANCE_. It provides the 
default values for the other instances of the class. Any attribute in an instance will inherit its 
value from the same attribute in the _BASE_INSTANCE_ unless it has been specifically 
assigned another value.

Figure 12 _BASE_INSTANCE_ of Application (ZSERVICE) Class

Inherited values appear in the instance the same as those values that you enter directly into 
the instance. You can tell if a variable’s value is inherited from the _BASE_INSTANCE_ by 
inspecting the _BASE_INSTANCE_. Also, if you delete a value from a variable (see Working 
with ClassesWorking with Classes on page 106 to learn how), and the value re-appears in the 
instance automatically, the value is being inherited from the _BASE_INSTANCE_.

Managing Domains, Classes, and Instances

In the HPCA Administrator CSDB Editor you can add, copy, edit, rename, and delete CSDB 
components such as domains, classes, and instances. You can also connect different instances.

You can access these functions from shortcut menus that open when you right-click targets in 
the HPCA Administrator CSDB Editor window. The menu that opens contains choices 
depending upon which target you right-click.

Working with Domains

This section describes how to add a domain to a file. Domain names can be a maximum of 
eight characters, and can include letters and numbers.

To add a domain to a file

1 Right-click the PRIMARY file or any domain, and select New Domain from the shortcut 
menu that opens. The Create Domain dialog box opens.
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2 Enter a name for the new domain and click OK.

Working with Classes

This section describes how to add, edit, and delete a class.

Adding a Class

New classes can be added by

• copying an existing class,

or

• creating a new class.

The method you select depends upon whether a class already exists whose attributes are 
substantially similar to the class that you want to add. If so, copy the existing class; 
otherwise, create a new one.

Copying a class creates a new class with the same attributes as the copied class, and a 
_BASE_INSTANCE_ for the new class with its attribute values set as in the 
_BASE_INSTANCE_ of the copied class.

To copy an existing class

1 Select the class to be copied and right-click it.

2 Select Copy Class from the shortcut menu. The Copy class dialog box opens.

3 Enter a name for the new class, and click OK.

— When you set preferences in the Options dialog box, Setting Preferences: Options 
Dialog Box on page 95, you did not select to open the Class Editor when a class is 
copied, the original class is copied with the new name, the Class Editor is not opened, 
and no warning is issued. You will have to manually open the Class Editor to edit the 
new class.
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— Conversely, if you did select to open the Class Editor, the Editing Class dialog box 
opens. For more information, see Editing a ClassEditing a Class on page 108.

4 To complete the addition of the copied class, change the Description field to identify the 
copied class, edit the class to reflect the new class’ requirements, and click OK.

The Class Edit Confirmation warning message warns you to back up your database 
before proceeding.

5 Click Yes. The new class addition is complete.

After you create a class, check the MASTER_CONNECTION_RULES variable to determine if 
you need to establish a drag-and-drop rule for the new class. For additional information 
regarding connection rules and drag-and-drop connections, see Maintaining Connection Rules 
in the CSDB on page 147.

To create a new class

1 Select the domain in which you want to create the new class.

2 Right-click the domain name.

3 Select New Class from the shortcut menu. The Create Class dialog box opens.

If you click No or Cancel in the Class Edit Confirmation warning message, the 
Class Editing dialog box closes, but the copying of the class does not terminate.

If you have created a class and want to delete it, see Deleting a ClassDeleting a 
Class on page 116.
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4 Enter a name for the new class, for example, BIZUNITS and Click OK. The Editing Class 
dialog box opens. For more information, see Editing a Class on page 108.

5 To complete the addition of the new class, change the Description field to identify the 
new class, edit the class to reflect the new class’ requirements, and click OK.

6 Click Yes. The new class is added.

After you create a class, check the MASTER_CONNECTION_RULES variable to determine if 
you need to establish a drag-and-drop rule for the new class. For additional information 
regarding connection rules and drag-and-drop connections, see Maintaining Connection Rules 
in the CSDB on page 147.

Editing a Class

When you click Edit Class from a shortcut menu, or during the addition of a new class as 
described in Adding a Class on page 106, the Editing Class dialog box opens.

If you click No or Cancel in the Class Edit Confirmation warning message, the 
Class Editing dialog box closes, but the copying of the class does not terminate.

If you created a class and want to delete it, see Deleting a Class on page 116.
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To edit a class

1 Right-click the Departments Class in the tree view of the CSDB, and select Edit Class from 
the shortcut menu. The Editing Class dialog box opens.

2 Set the Class Information properties at the top of the dialog box.

Description

The friendly name that describes the class and its purpose. This name appears next to the 
class icon in the tree view.

Persistent

This property should be used only by administrators who have a thorough understanding 
of the HPCA resolution process.

A persistent class is one whose attributes and objects remain in global memory for the 
duration of the resolution process. The instances created from persistent classes are 
available to the HPCA agent for storage on its desktop. 

If a class is not persistent, it is transient. A transient object exists only while it is being 
processed during resolution. Instances created from transient classes are not available to 
the HPCA agent for storage on the desktop.

For more information about persistent and transient objects and how they are handled in 
the resolution process, see Appendix F, Resolution Process.

Automatic Sequencing

Normally, resolution proceeds from attribute to attribute in the order that appears in the 
Attribute List. See Appendix F, Resolution Process for a discussion of resolution.

Select this option to impose a grouping on the order in which attributes of the class are 
processed during resolution:

— Expressions

— Variables

— Classes (connections)
HP Client Automation Administrator Tools for Windows 109



— Methods

Within Connections, the resolution is done in the order CAIRO:

Priority

This field is two characters long and has a value between 00 and 99. During object 
resolution, the Configuration Server puts this value in the ZOPJPRI variable. If there is a 
blank or zero value in this field, the Configuration Server supplies the default value 
specified for that particular class. The default values for the classes are:

Type

This field classifies classes according to their purpose and use. HPCA uses this 
classification to affect the resolution process. For example, resolution to populate the 
Service List on an agent computer does not process classes classified as Component 
classes.

Select one of the following values from the drop-down list:

— <none> – This class is not classified.

— Configuration – This class identifies content to be managed by HPCA on agent 
computers on an aggregate level. Typically, instances of this class do not have data 
that can be distributed. They are connected to instances of one or more Component 
classes. Examples: ZSERVICE, PACKAGE, VGROUP, VERSION, and so forth.

— Component – This class identifies items such as files, registry entries, links, icons. that 
comprise the content identified by a Configuration class instance. Typically, instances 
of this class have data that can be distributed. Examples: FILE, REGISTRY, and 
DESKTOP.

— Policy – This class identifies one, or a group of agent computers. Typically, instances of 
Policy classes are connected either to an instance of another Policy class, or instances 
of Configuration classes.

3 To modify the definition of an attribute, click its name in the Attribute List to select it. 
The name, length, and description of the selected attribute appear in the Attribute 
Information text boxes. The Type field indicates the type of the selected attribute.

C Specific connect messages

A Always generic

I Include generic

R Required connection for packages

O Object (deprecated)

PATH 5

REGISTRY 60

DESKTOP 70

FILE 50

METACLAS 10

ZSERVICE 50

MACALIAS 70

All others 50
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4 Type your changes into the Attribute Information fields, and click the Type option to set 
the attribute's type. Class attributes can be one of four types as described in the following 
table.

As you make changes, they are immediately reflected in the Attribute List.

Table 33 Class Attribute types and their functions

Attribute 
Type Usage

Expression Contains a single line REXX command that is executed 
during resolution. If the expression evaluates to true, in an 
attribute named ZSTOP, resolution of the current instance 
terminates.

Variable A piece of named storage containing a variable value. The 
variable’s value forms a part of the agent’s resolved desired 
state, and can influence the resolution process through 
messaging or symbolic substitution.

Connection 
(available) 

Connection 
(set)

Note: The 
letter in the 
icon denotes 
the connection 
type:
• A – Always
• C – Class
• I – 

Includes
• R – 

Requires

Class connections determine the path of resolution of an 
agent’s desired state during the agent connect process.
Available connections are attributes into which a 
connection to another class can be set.
Set connections are attributes containing a specification for 
a connection to another class.
A class connection is, in effect, a branch in the resolution 
process. For more information, see Appendix F, Resolution 
Process.
• An Always connection is always resolved, no matter 

what the name of its attribute.
• A Class connection is resolved if its attribute’s name is 

_ALWAYS_, or if the name of its attribute matches the 
current value of the system message.

• An Includes connection is always resolved, no matter 
what the name of its attribute.

• A Requires connection blocks resolution of instances in 
the required instance and its children whose instance 
names are identical to instance names in the requiring 
instance and its children.

Requires and Includes connection types are useful, among 
other things, for expressing inter-package relationships, 
connecting instances of the PACKAGE Class.
When one package Requires another, components of the 
required package are superseded by the same component 
in the requiring package.
When one package Includes another, both are deployed as a 
single entity.

Method Methods are programs executed as part of the resolution 
process. The method attribute identifies the program to be 
executed.
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5 The Properties options are either enabled or disabled depending upon the attribute type.

Agent Properties

• Select the Agent Protect property to indicate that the value of an attribute stored in an 
object on the agent computer will be encrypted.

• Select the Agent Execute property, which applies only to method attributes, to indicate that 
the method to be executed will be executed on the agent computer.

Configuration Server Properties

The following section summarizes the significance of the Configuration Server properties.

• Global
When selected for a variable in a transient class, this indicates that during resolution the 
variable can migrate--flow--from the child object to a parent object, before the transient 
object being resolved.

• Default
Used internally by HPCA and is not available to Administrators. It prevents default 
values in transient-class objects from being incorporated into parent, persistent-class 
objects.

• Substitute
Indicates that symbolic substitution will occur for symbols--references to other variables 
identified by an initial ampersand--in the value of the variable. Clearing this option treats 
the value of the variable as literal text, preventing symbolic substitution.

The Substitute property determines whether symbolic substitution occurs when a 
variable is created as a result of a Configuration Server GET operation, such as occurs 
when a REXX program calls the EDMGET function. If a variable in the object retrieved by 
EDMGET contains a symbol, and the Substitute check box was selected for that variable 
when the object was created, substitution occurs as the variable is created in storage.

For example, the expression &(ZMASTER.ZUSERID) will evaluate to WILLIAM after 
symbolic substitution, if the value of the ZUSERID attribute of the ZMASTER object is 
WILLIAM at the time symbolic substitution occurs.

• Protect
Indicates that the value of the attribute is to be encrypted during resolution. The 
attribute value exists in encrypted form in memory during resolution, but remains as 
plain text in the CSDB.

• Absolute
When selected for a variable in a persistent class, prevents identically named variables in 
child objects (instantiated from a transient class) from overlaying the values for those 
variables in the parent object.

• Execute
Indicates that the value of the attribute identifies a method to be executed by the 
Configuration Server.

• Resolve
Indicates that symbolic substitution will occur for symbols--references to other variables 
identified by an initial ampersand--in the value of the variable. Clearing this property’s 
check box causes the value of the variable to be treated as literal text, preventing symbolic 
substitution.

All HPCA agent properties, except for Protect and Execute, are reserved for future 
enhancements, and you should leave them set to their default values.
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The Resolve property determines whether symbolic substitution occurs when a variable is 
PUT into an object, such as occurs when a class instance is retrieved from the CSDB and 
instantiated as an object in storage.

• Counter
Indicates that the variable contains an integer that the Configuration Server will 
accumulate. The accumulated total will be stored in a variable with the same name in all 
parent persistent objects.

For example, this property can be used for calculating the total uncompressed size of all 
resources distributed for a service, and storing the result in the ZSERVICE object. Select 
this check box for the ZRSCSIZE variable in the FILE Class, and a ZRSCSIZE variable 
will be added to the ZSERVICE object, containing the sum of the ZRSCSIZE values of all 
FILE instances in the service. The total size of all services’ resources for the user will 
automatically be stored in a ZRSCSIZE variable in the user’s ZMASTER object. The 
ZRSCSIZE variables in the ZSERVICE and ZMASTER objects are created and 
maintained automatically by the Configuration Server when the Counter check box is 
selected for the ZRSCSIZE variable in the FILE Class template.

Any variable containing an integer can be accumulated and stored in parent persistent 
objects by selecting the Counter check box in the variable's definition in the class 
template. For example, select this check box on the ZCMPSIZE variable of the FILE Class 
to calculate the total compressed size of resources distributed for a service.

You can reset the property settings for the selected--selected--attribute to their default values 
by clicking the default buttons at the bottom of the Properties group box.

To add an attribute to a class

1 To add a new attribute, first determine where in the Attribute List the attribute should be 
inserted. Unless the Automatic Sequencing option is selected, as described above, 
attributes are processed during resolution in the order in which they appear in the 
Attribute List.

2 Click an attribute next to the insertion location, to select it. Then click Insert Before or Add 
After. A blank attribute--a variable attribute by default--is inserted at the indicated 
location.

3 Enter a name, length, and description in the Attribute Information data entry fields, and 
then select the Type option from the drop-down list.

Attribute names can be up to eight characters long. Attribute names can have significance 
in the resolution process. Values of variables in child objects instantiated from within 
transient classes can replace the values of identically named variables in parent objects 
represented within persistent classes. Methods can be conditionally executed or skipped, 
and class connections can be conditionally followed or ignored based upon the name of the 
method or class connection attribute. If the attribute's name is _ALWAYS_, the method 
will be executed or the class connection will be followed unconditionally. Otherwise, the 
method will be executed, or a class connection will be followed only if the name of the 
attribute is identical to the current value of the system message. For more information, 
see the Appendix F, Resolution Process.

Specify the length of the attribute, in characters. Enter a number greater than or equal to 
the maximum number of characters for a value of the attribute. For connection and 
method attributes, a length of 50 is normally adequate. The length needed for a variable 
attribute depends on the data it is intended to hold.

The description you enter appears in the Attribute Description column of the Editing 
Instance dialog box. The clearer the description you enter now, the easier it will be for 
those who edit instances of this class later. For variable attributes, enter a description 
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that clearly identifies the data to be held in the variable attribute. For class connections, 
you can enter Connect to, or a description that is more meaningful for your purposes. For 
methods and expressions, try to indicate the purpose of the method or expression in the 
description.

4 To set the value of an attribute as the display name in the HPCA Administrator CSDB 
Editor, select the attribute, and then select Attribute Contains the Instance Alias Name. This 
is usually set on the Name--friendly name--attribute. Only one attribute should have this 
turned on per instance.

Optional Attribute Editing Controls

The Attribute Description for variable attributes can be used to determine the control that the 
HPCA Administrator CSDB Editor displays for entering or editing that attribute in the 
Editing Instance dialog box. Normally, variable attributes are entered or edited as free text 
in a text box. You can change this to a check box, a set of check boxes, or a drop-down list.

To enable this feature, select the Use Edit Masks When Editing Instances option on the Instance 
Options tab of the Options dialog box. For details, see Table 31 on page 99.

• Flag Attribute
A Flag Attribute is a one-character field whose value can be Y or N. To display a check 
box for entering or editing flag attributes in instances, the Attribute Description for the 
attribute in the class template must terminate with [Y/N], as shown in the following 
figure.

Figure 13 ZSVCCAT variable contains [Y/N] for flag attribute

The ZSVCCAT attribute is one character in length, and its Attribute Description, 
Service Visible in Catalog? [Y/N], ends with [Y/N]. Thus, to enter or edit this variable, 
the HPCA Administrator CSDB Editor interface contains a check box.

• Flag Set Attribute
A Flag Set Attribute is a two- or more character field that holds a value composed of 
zero or more single-character flags. If a flag is on, the character value that is associated 
with the flag appears in the flag set string. If a flag is off, the character value that is 
associated with the flag does not appear in the flag set string. An empty flag set string 
indicates that no flags are on.

For example, the DOS File Attribute flag set for a particular file is contained in the 
ZRSCRASH attribute of the FILE Class. You use this four-character attribute to indicate 
which of the DOS File Attributes such as, R=Read-only, A=Archive, S=System, H=Hidden 
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should be turned on for the file associated with the FILE instance when that file is 
deployed to a user desktop. When editing this attribute in an instance, as shown in the 
following figure.

Figure 14 An attribute ending with a set of one-character choices

If the Attribute Description ends with one-character choices separated by slashes, and the 
number of choices equals the length of the attribute, for example, the ZRSCRASH 
attribute above, the HPCA Administrator CSDB Editor treats the attribute as a flag set. 
It displays a check box for each potential value in the flag set in the Editing Instance 
dialog box. If a check box is selected, its associated value is inserted in the attribute.

• Drop-Down List
The HPCA Administrator CSDB Editor displays a drop-down list for entering or editing 
attributes whose Attribute Description in the class template terminates with a series of 
choices separated by slashes and enclosed in square brackets.

For example, the following figure shows that the ZRSCSTYP attribute of the FILE Class 
has two choices in the Attribute Description. An attribute description that terminates 
with a series of choices separated by slashes and enclosed in brackets will have a 
drop-down list for editing attributes.

Figure 15 ZRSCSTYP attribute

1 As you make changes to a class, you might change your mind and wish to start over. After 
a change has been made during class editing, the Restore button is enabled. Click Restore 
to discard changes you have made to the class since the Editing Class dialog box opened.
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The Confirm Restore message appears.

— Click Yes to discard changes and restart editing the class.

— Click No to dismiss the confirmation without discarding your changes.

2 When you are finished editing the class, click OK to save your changes and exit the 
Editing Class dialog box.

— If there are blank attribute names or descriptions in the class, or if an attribute's 
length is zero, an alert message pops-up.

— If there are no blank attribute names or descriptions in the class, and no attribute’s 
length is zero, the Class Edit Confirmation message opens. It warns you to back up 
your database before proceeding.

3 Click Yes to update all existing instances of the class.

Click No to discard your changes to the class, and avoid updating the instances.

Click Cancel to return to the Editing Class dialog box.

Deleting a Class

To delete a class and all of its instances

1 Right-click on the class in the HPCA Administrator CSDB Editor tree view.

2 Select Delete Class from the shortcut menu that opens. A Confirm Delete dialog box 
opens.

3 Click Yes to delete the class and all of its instances or Click No to close the message 
without deleting anything.

Working with Instances

Much of the work of administrators consists of adding, editing, and deleting instances of 
various classes, and setting or removing connections between them.

Naming Instances

Use these guidelines when naming instances in the CSDB:

• Use characters that can be displayed and printed.

• Do not include a period ( . ). Periods are reserved characters used to delimit the File, 
Domain, Class, and Instance names (F.D.C.I) of a fully-qualified instance in the CSDB.

• Do not include special characters that have a specific meaning to the file system or 
command shell of any operating system, such as these:
 \ | / : ; < > * ? ` " ' , ( ) &

• Do not include sequential underscores. This reserved sequence indicates a Group 
Resource in the CSDB.

• Do not include embedded spaces or control characters, such as blanks, CR (Carriage 
Return), LR (Line Return), or tabs.

Friendly Instance Names

Friendly instance names do not have the same restrictions as instance names. Use characters 
that can be displayed and printed. Spaces and other special characters are allowed. To avoid 
confusion, it is recommended that you do not use periods in friendly names.
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Adding an Instance

You can add a new instance from scratch or copy an existing instance. The method you select 
depends upon whether an instance exists whose attribute values are substantially similar to 
the instance you want to add. If so, copy the exiting instance; otherwise, add a new instance 
from scratch.

Copying an Instance

Copying an instance creates a new instance with the same attribute values as the copied 
instance. 

To copy an existing instance

1 Select Copy Instance from a shortcut menu. A Copy Instance dialog box opens.

2 Enter a display name--a friendly name--and an instance name for the new instance, and 
click OK.

The instance will be created and will appear in both the tree view and in the list view of 
the HPCA Administrator CSDB Editor window.

The friendly name appears in the tree view, and the instance--internal--name appears in 
the title bar of the list view of the HPCA Administrator CSDB Editor window.

Adding an Instance

Creating a new instance results in an instance with attribute values set as in the 
_BASE_INSTANCE_ of the class.

To add a new instance

1 Select New Instance from a shortcut menu. A Create Instance dialog box opens.

2 Type a display name--a friendly name--and an instance name, and click OK.

The instance will be created and will appear in both the tree view and in the list view of 
the HPCA Administrator CSDB Editor window.

The friendly name appears in the tree view, and the instance--internal--name appears in 
the title bar of the list view of the HPCA Administrator CSDB Editor window.

You can now edit the attribute value of the new instance.

Editing an Instance

This section describes how to edit a single instance.
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To edit an instance

1 Select Edit Instance from a shortcut menu, or double-click an attribute’s name in the list 
view of the HPCA Administrator CSDB Editor window. The Editing Instance dialog box 
opens.

The dialog box lists the attributes in the instance, and their current values. The selected 
attribute is open for editing in the data entry field at the top of the dialog box.

2 Type the value into the text box at the top of the dialog box.

For information about how the HPCA Administrator CSDB Editor determines which edit 
control to use for a particular attribute, see Optional Attribute Editing Controls on 
page 114.

3 To select a different attribute, click its name.

4 Continue to edit each attribute you want to change.

5 Click OK to close the dialog box and save your changes.

6 If the Instance Edit Confirmation message box opens:

— Click Yes to complete the update of the instance.

— Click No to discard your changes to the instance, and return to the HPCA 
Administrator CSDB Editor main window.

— Click Cancel to return to the Editing Instance dialog box.

When you edit connection attributes, notice the warning about editing class connections 
manually at the bottom of the dialog box. Connection values can be complicated to type, and a 
single typographical error can produce unexpected and undesirable results during resolution. 
It is recommended that you use the drag-and-drop method.

Editing Multiple Instances

The HPCA Administrator CSDB Editor enables you to edit multiple instances in a single 
operation.

If you selected the Prompt: Before Instance Updates option on the Instance 
Options tab of the Options dialog box, see Figure 9 on page 98, an Instance 
Edit Confirmation message box opens.
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One of the selected instances serves as a template. The template instance’s values appear in 
the Editing Instance dialog box. When you change a value in the template instance, the 
change is applied to all the instances in the selected set. No changes are stored in the CSDB 
until you exit the dialog box and confirm the change operation.

To edit multiple instances at the same time

1 Select the instances in the list view of the HPCA Administrator CSDB Editor window.

Click on an instance to select it.

— Ctrl-click to add an instance to the selected set

or

— Shift-click and/or Ctrl-Shift-click to add a range of instances to the selected set.

Selected instances are highlighted:

2 Right-click on the instance that you want to use as the template for the multiple 
instance-edit operation. A shortcut menu opens.

3 Select Edit Multiple Instances. The Editing Instance dialog box appears.

The title bar displays how many instances are in the set of selected instances, the selected 
instances' class friendly name, and the friendly name of the instance serving as the 
template.
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4 Scroll to and select a variable whose value you want to copy to all instances in the selected 
set.

— If the selected variable in the template instance already has the desired value, click 
Change All to copy that value to the other instances in the selected set.

— If the selected variable does not have the desired value, edit the value.

In either case, the caption of the Change All button changes to Reset.

To restore the value of a currently selected variable to its original contents:

— Click Reset.
As you scroll through the instance variables, you can determine if you made a change 
to the selected variable by referring to the caption on this button.

– If the caption is Change All, you have made no change to the variable during the 
current editing session.

– If the caption is Reset, you have made a change to the selected variable.

After making a change to at least one variable, and selecting a different variable, the 
Restore button becomes enabled.

To undo all changes made in the current editing session

1 Click Restore. The Confirm Restore message opens.

2 Click Yes to discard all changes made in the current editing session.

Click No to resume the editing session without restoring original values.

Changes made during the editing session are not saved in the CSDB until you click OK 
and confirm your changes.

3 Click OK to save the changes made in the template instance to all of the selected 
instances.

Click Cancel to resume the Editing Instance dialog box session.

You can click Cancel in the Editing Instance dialog box to exit the dialog box without 
saving any changes.
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Renaming an Instance

Be careful when renaming instances. Instances are connected using the connection attributes 
they contain. When you rename an instance, any other instance connected to the renamed 
instance will have a broken connection. This can produce unexpected and undesirable effects 
during resolution. Before renaming an instance, make sure you know which other instances 
are connected to the renamed instance, and edit them appropriately.

To rename an instance

1 In the tree view right-click the instance. A shortcut menu opens.

2 Select Rename Instance. A Rename Instance dialog box opens.

3 Enter a new display name--friendly name--and/or a new instance name for the instance, 
and click OK.

Deleting an Instance

Be careful when deleting instances. Instances are connected using the connection attributes 
they contain. When you delete an instance, any other instance connected to the deleted 
instance will have a broken connection. This can produce unexpected and undesirable effects 
during resolution. Before deleting an instance, make sure you know which other instances are 
connected to the instance to be deleted, and edit them appropriately.

To delete an instance

1 Right-click on the instance. A shortcut menu opens.

2 Select Delete Instance. The Confirm Delete message opens.

3 Click Yes to delete the instance

or

Click No to close the dialog box without deleting the instance.
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Access Rules and Administrators

An Administrator's database access can be defined as any of three levels of access, as detailed 
in the following table. HPCA Administrator CSDB Editor administrator access rules are 
stored in the ZACCESS Domain.

All Configuration Servers have an edmprof file. This file is divided into multiple sections, and 
it defines the operational parameters for the Configuration Server, including its behavior 
regarding administrator access to the CSDB as described in Table 34 on page 122. The 
administrator access parameters are located in the MGR_ACCESS section.

To set the administrator access value

1 Shut down the Configuration Server.

2 Open the edmprof file.

3 Specify the ADMIN setting with one of the values in Table 34 on page 122.

4 Save and close the edmprof file.

5 Restart the Configuration Server.

Creating Services with the New Application Wizard

After you create a package with the HPCA Administrator Packager or HPCA Administrator 
Publisher, use the New Application Wizard in the HPCA Administrator CSDB Editor to 
create a service. A service is the fundamental unit of content managed by HPCA. Use the 
HPCA Administrator CSDB Editor to see services listed in the Application (ZSERVICE) class.

Table 34 Administrator Access-Level Values

Access Value Definition

ALLOW Configuration Server does not check the administrator 
access rules before granting access to an administrator.
This value disables all administrator access-rule checks, 
even if they are defined in the database.

DENY Configuration Server checks administrator access rules 
before granting access to an administrator.
An administrator will be unable to perform an action 
unless there is an access rule defined in the database for 
that administrator specifically allowing it. This is the 
recommended setting when configuring administrator 
security.
Notes: If this option is specified, undefined administrators 
will not have access to any CSDB administrator functions, 
unless the ADMINID._NULL_INSTANCE_ is modified to 
enable access to those functions.

IGNORE Configuration Server checks administrator access rules 
before granting access to an administrator. An 
administrator will be able to perform an action unless 
there is an access rule defined in the database for that 
administrator specifically prohibiting it.
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Task 1: Access the HPCA Administrator CSDB Editor

For instructions on how to Access the HPCA Administrator CSDB Editor, see Getting Started 
on page 91.

Task 2: Navigate to the Package Class

To navigate to the PACKAGE Class of the SOFTWARE Domain

1 Double-click PRIMARY. The domains of the PRIMARY File appear beneath its icon in the 
tree view and in the list view.

2 Double-click SOFTWARE. The classes of the SOFTWARE Domain appear beneath its icon 
in the tree view and in the list view.

3 Double-click Application Packages (PACKAGE) to open the PACKAGE Class. The instances 
of the PACKAGE Class appear beneath its icon in the tree view and in the list view as 
shown in the next image.

Task 3: Create a Service

To create a service using the New Application Wizard

1 In the PACKAGE Class of the SOFTWARE Domain, right-click the PACKAGE Class 
instance for which you want to create a service. A shortcut menu opens.
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2 Click New Application Wizard. The New Application Wizard opens.

3 In the Service Name (32) text box, type a name, such as WINZIP0009, for the 
Application (ZSERVICE) instance. Follow the instance naming guidelines in Working 
with Instances on page 116.

4 Select the Target Operating System if you want to specify which operating systems are 
eligible for this service. Then, select the appropriate operating systems.

If you do not select the Target Operating System option, the service is available on all 
platforms.

5 If you are creating a service for a Windows Installer-enabled application, you must select 
Populate Windows Installer Methods.

6 Click Next to select the application target type.
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7 Select Application Manager. This designates the service as a mandatory application for your 
subscribers.

or

Select Self-Service Manager to designate this as an optional application that users may 
select to install.

8 Click Next to enter the application properties.

9 Type the appropriate information in the text boxes as shown in the Application 
Properties dialog box.

10 Click Next to select the events that the Application Manager will report on.

11 Select the option for each application event that you want to report on. Then, select the 
appropriate option button to indicate whether to report on the event's success, failure, or 
both.

or

Click Use Base if you want to inherit the values for the ERTYPE and EVENTS attributes 
from the base instance of the Application (ZSERVICE) instance. These attributes control 
event reporting.

12 If you want to save the current settings as the default settings for the Application Event 
Panel, click Save as Default.

When using the Application Manager, applications must be mandatory in order to 
deploy them to your users.
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13 Click Next to see a summary of your selections.

14 Click Finish to create the application instance.

15 Click OK to the message that the application has been added. The instance appears in the 
ZSERVICE Class.

Defining MSI Basic Behaviors in the New Application Wizard

In contrast to Advanced Package Management, where HPCA provides on-going management 
of the components of an MSI package, Basic Package Management is used for packages that:

• Do not support administrative installation.

• Are to be installed and uninstalled by HPCA, but whose components are not to be 
managed by HPCA. That is, the HPCA agent is not to be instrumental in any component 
verification or repair capability.

The New Application Wizard permits you to define MSI Basic Behavior methods for packages 
created with the HPCA Administrator Packager for Windows Installer. These packages have a 
connection to the MSIBASIC Class in the CSDB.

Use the HPCA Administrator CSDB Editor to modify any of the information that 
you entered in the New Application Wizard. Locate the corresponding attribute in 
the ZSERVICE instance and change its value.
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Figure 16 MSI Basic Behaviors in New Application Wizard

Packages that cannot be administratively installed will default to Basic Package Management 
with the HPCA manageability features disabled. Use the MSI Basic Behaviors section of the 
New Installation Wizard dialog box to specify the install type and MSI native mode 
methods to be used for package management.

To define the MSI Basic Behaviors section of the New Application Wizard

1 Select the install type that reflects how the package is installed:

Setup-based install
The package installs with a SETUP.EXE file that calls MSIEXEC to install the package. 
This will run the native setup.exe for the MSI application. If setup.exe supports any 
command line switches, such as /s for silent or ADDLOCAL=ALL for complete 
installation, you can add them to the Create Method. Not all MSI applications support the 
same command-line switches. For setup.exe, see the application’s documentation for 
details.

MSI-based install
The package installs with MSIEXEC.

Custom
The package uses a custom installation method.

2 If necessary review and modify the native MSI commands and switches that are to be 
used for the Create, Verify, Update, and Delete Methods for basic package management.

Version Group Editor

The Version Group Editor is a feature of HPCA Administrator CSDB Editor when the 
HPCA Application Manager is installed. Use it to create and edit instances of the Version 
Group Class. Features of the Version Group Editor enable you to create, edit, and delete 
Version instances of the Version Group and control the Version Group’s deployment. For more 
information, see Appendix D, Creating Services Using Advanced Capabilities.
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Service Optimization

Service Optimization uses patches to maximize the efficiency of distributing periodic updates 
to the packages in a service. Later the packages contain revisions and additions to files 
published in earlier packages.

A patch is a published package of data--bytes--that is needed to upgrade or fix an application 
that is already published and installed on an agent computer. Since a patch contains only the 
differences between the packages, deployment of a patch takes less time and requires less 
network bandwidth. Patches should be built only for file changes that can be distributed more 
efficiently as patches than as replacement files.

Here is how Service Optimization works:

1 The HPCA Administrator Packager or the HPCA Administrator Publisher calculates the 
message-digest algorithm (MD5) signature of the file as it is being published. The MD5 
algorithm can take input and create a 128-bit fingerprint--message digest--of the input. 
This information is then stored in compressed form in the Configuration Server. For more 
information about MD5 signature, visit:

www.faqs.org/rfcs/rfc1321.html

2 The PATCH Domain in the CSDB contains the list of available patches in the PATCH 
Class. The file signatures of a patch are used to identify the associated instance that 
contains the data for the patch. For more information about the PATCH Domain, see HP 
Client Automation Configuration Server Database Reference Guide.

3 In the HPCA Administrator CSDB Editor, Optimize Service is an option on the 
Application (ZSERVICE) instance shortcut menu. It enables the administrator to create, 
display, and delete patches for selected application components.

Using the Optimize Service Option

In order to create a patch using the Optimize Service option, you first need to publish your 
packages using the HPCA Administrator Packager or the HPCA Administrator Publisher. For 
instructions on how to do this, see HPCA Administrator Packager on page 26 and HPCA 
Administrator Publisher on page 45.

This section provides you with detailed instructions for:

• Creating an Application (ZSERVICE) in the SOFTWARE Domain for packages for which 
you will create a patch.

• Creating the patches using the Optimize Service wizard.

In this example, you will optimize a series of text files called BLD. These files were packaged 
and promoted to the CSDB. Each text file is its own package in the SOFTWARE Domain.

Prior to deploying patches to users, change the ZOBJPTCH variable from N to Y in 
the USER Class of the POLICY Domain.

Patches can be created for packages that contain a signature only. Initially, only 
MD5 is supported. Packages being used for patching must be published from the 
same location, or computer, to qualify for byte-level differencing patching. This 
will populate the eight-byte CRC found in the suffix of the instance names.

As the HPCA Administrator Packager and the HPCA Administrator Publisher 
calculate and use the MD5 signature, and this signature is vital to the patching 
functionality, there is no backward compatibility to previously published packages.
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After you publish your packages to the CSDB, you need to create a ZSERVICE instance.

To configure the Optimize Service feature

1 Expand the tree view to the PRIMARY.SOFTWARE.PACKAGE Class and locate the 
BLDTEST packages.

2 Right-click on the Application (ZSERVICE) Class. A shortcut menu opens.

3 From the shortcut menu, select New Instance.

4 Create a new instance named BLD_CREATE, and click OK. The BLD_CREATE service is 
added to the CSDB.

In some cases, the difference in size between two packages is so minimal that 
creating a patch will actually increase the size of the file. In this case, the creation 
of the patch will not be allowed.

When publishing the files needed for this example, the following naming 
conventions were used:

• The file bld1.txt was originally published as bld.txt.

• When the second file was about to be published, it was renamed to bld.txt; 
the original bld.txt file was renamed bld1.txt.

• When the third file was about to be published, it was renamed bld.txt; the 
second file was renamed bld2.txt.

By using the same file name and the same machine during publishing, you are 
assuring the same CRC needed to correctly create patches.
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5 Drag-and-drop the BLDTEST1, BLDTEST2, and BLDTEST3 packages to the 
BLD_CREATE instance in the Application (ZSERVICE) Class.

After you create the Application in the ZSERVICE Class that contains the Application 
Packages from the PACKAGE Class, you can create your patches.

Just as you create a plan or policy for users, you might want to develop a plan for creating, 
editing, and deleting patches. Some important things to remember when creating patches:

— It is important to devise a means by which to document the packages that will create 
your patches. When building different patches in a small database, it is relatively easy 
to follow the schema of connected paths that create a patch. As your database grows, 
it is possible for the patch class, and the packages that they represent, to grow 
unwieldy.

— Only those packages that contain an MD5 signature are eligible for patching.

— Patching is different from versioning. If a patch fails to deploy properly, there is no 
previous version option.

6 Right-click the Application (ZSERVICE) Class BLD_CREATE. A shortcut menu opens.
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7 Select Optimize Service. The Service Optimization dialog box.

8 Click Available Packages From drop-down arrow. This lists the available packages for the 
service you are trying to optimize. When you click the From drop-down arrow, all of the 
packages for the Application (ZSERVICE) are displayed. In this example, click the From 
list to show all of the packages in the BLD_CREATE Application (ZSERVICE).

The packages that are available for the service you selected in step 6 BLD_CREATE, are 
listed.

9 From the drop-down list select BLDTEST Software 1 (BLDTEST1). The Available Packages To 
list is populated with the packages that are available for patching in the BLD_CREATE 
service.

10 Click Available Packages To drop-down arrow. This lists those packages available for 
patching in the service you are optimizing.

11 From the drop-down list, select BLDTEST Software 2 (BLDTEST2).

12 From Classes Eligible for Patching in the SOFTWARE Domain select the appropriate 
class for patching in the SOFTWARE Domain. Select the class in which the file resources 
for the package are located.

Currently, File Resources (FILE), MAC File Resources (MACFILE), MSI 
Resources (MSI), MSI Basic Resources (MSIBASIC), Mobile File Resources 
(RMMFILE), and Unix File Resources (UNIXFILE) qualify for patch building.
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In this example, the only class that is available to be patched is File Resource (FILE).

13 Select File Resource (FILE) and click Next to continue.

The Files and Progress dialog box opens.

This dialog box displays files and progress information. The Service Optimization wizard 
gathers the instance information based on the selections made in the Available 
Packages dialog box.

The following table shows the options in the Files and Progress section of this dialog box. 
Table 36 on page 133 shows the options in the Patch Criteria area.

To determine which classes are available for patching within your package, 
expand your Application (ZSERVICE) instance to the attribute level. Examine 
your instances to determine which resources are available for patching.

Table 35 Files and Progress information

Column Description

Component File 
Name

The name of the patch that is being created.

From Size The original resource-package size.

To Size The original target-resource size.

Status The status of the package. The valid values are none, 
queued, rejected, active, and built.
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It is possible to set patch-building restrictions, such as percent size, bytes, and time 
elements by configuring the Patch Criteria options. You can control the creation of patches 
by setting criteria that will apply to all files whose check boxes are currently marked in 
the file list.

Suppose that the number of files in the list is large and you do not want to evaluate each 
file manually to determine if you want to build a patch for it. Click Check All to select all 
the files in the list. Then, use the Patch Criteria options to limit the building of patches to 
those files likely to produce a benefit.

The following table details the options of the Patch Criteria area. The default for these 
three options is an empty (unselected) check box.

After a component file has been selected, the buttons used for patch building are enabled.

Patch Size The size difference between the original package data 
(BLD1) and the changed package data (BLD2).

Compressed 
Size

The compressed size of the package listed in the From 
Size.

Data The date on which the package was published.

SizeLimit This information is pulled from the Patch Criteria, Min 
Percent Saved field. This field is populated after the 
Patch has been built or when the patch building process 
has ended.

% Limit This information is pulled from the Patch Criteria, Min 
Bytes Saved field. It is populated after the Patch has 
been built or when the patch building process is ended.

Time Limit This information is pulled from the Patch Criteria, Max 
Time Per File field. This field is populated after the Patch 
has been built or when the patch building process is 
ended.

Table 36 Patch Criteria information

File Option Description

Min Percent Saved Specify the minimum percent of the To component to 
save. Otherwise, the patch will not be built.

Min Bytes Saved Specify the minimum number of bytes that the patch 
must save. Otherwise, the patch will not be built.

Max Time per File Specify the maximum processing time for the patch. 
Use the drop-down list to indicate the maximum time 
allowable for patch building. The time can be set in 
minutes, or hours and minutes.

Table 35 Files and Progress information

Column Description
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To apply a criterion, select the options provided. The adjacent data entry fields are 
enabled. Enter the criteria into the associated data fields. The criteria for the patch are 
applied in combination. In order for a patch to be built for a selected file, it must meet all 
the criteria you apply.

The following table explains the functions of the Patch Criteria buttons.

14 Select the check box next to the files to be patched.

15 Click Build. The HPCA Administrator CSDB Editor will prompt you to confirm the new 
patch build.

Table 37 Patch Criteria button functions

Button Action

Check All Selects all the files that are listed in the Component File 
Name column.

Build Begins the patch build process.

Auto Refresh Select Auto refresh to open the Auto Refresh Timer dialog 
box. When you use Auto Refresh, type a refresh interval 
between 1 and 99 minutes. You can cancel the auto refresh 
by typing 0.

Uncheck All De-selects all files that are selected in the Component File 
Name column.

Delete Deletes a selected component file.

Refresh Refreshes build status.

Previous Returns to the previous screen.

Next Proceeds to the next screen.

Exit Exits the Optimization Wizard.
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16 Click Yes to continue

or

Click No to exit.

When you click Yes, any current patches of the pair will be deleted. A patch-creation 
request for each selected file pair is then be sent to the Configuration Server.

17 To update the Status, click Refresh.

18 Click Exit to exit the Service Optimization wizard

or

Click Previous to return to the Available Packages dialog box to build more patches.

The patch is located in the PATCH Domain, under the PATCH Class.

Examine PATCH.PATCH and verify that the patch instances are built. Examine rejected 
patches to determine why they were rejected. To determine the current status of 
requested patches, see the MESSAGE variable.
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Service Groups

HPCA manages products that require more than one service package to establish full product 
installation or operation. You can use Service Groups when a product requires other service 
packages or has dependencies on other services. This includes MSI-packaged products where:

• A product can use more than one MSI service package, for example where Microsoft Office 
requires other language pack services.

• A large product, for example, Microsoft Office might need to be split into smaller 
sub-services to install only specific parts of the product suite.

Service grouping enables multiple services to be grouped by a higher, or master service. This 
action enables administrators to logically group together similar or related components into 
one easy to understand collection.

Use the HPCA Administrator CSDB Editor to define and then group services and packages to 
form the master service.

Component Enhancements

• HPCA Application Manager
The RADSKMAN command contains the logic to process multiple service requests. It 
performs the request on each of the individual sub-services and reports the final results 
back to the master service.

• HPCA Application Self-service Manager
Each service in the Service List displays only the master service.

Prerequisites

Before you configure a master service for a service group, change or confirm the following 
settings:

• Configuration Server (versions 4.5 and above): in the edmprof file, verify that 
ALLOW_DUPLICATE_INSTANCES in the MGR_OBJECT_RESOLUTION section is set 
to No.

• Configuration Server (versions prior to 4.5): in the edmprof file, verify that in the 
MGR_OBJECT_RESOLUTION section:

— ALLOW_CIRCULAR_REFERENCE is set to Yes

and

— ALLOW_DUPLICATE_INSTANCES is set to No.

• CSDB
To configure a set of services (a grouping in which services depend on one another for 
installation), add a variable to the _BASE_INSTANCE_ of the Application (ZSERVICE) 
Class. This is a variable called ZSVCGRP. If you would like to add this variable to the 
ZSERVICE Class, use the following table to help you set the variable.

Make sure to target actions, such as notifies or timer updates, to the master 
service. Any action applied to the master service is applied to all sub-services.
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For information on editing a class, see Editing a Class on page 108.

Creating a Master Service for a Service Group

After you make the changes to the edmprof file, you can create a master service instance for 
a service group.

Use the HPCA Administrator CSDB Editor to create a new Application (ZSERVICE) instance 
for the master service. Next, for each service that is to be a member of the group, make a 
connection between the member service and the master service. You can add service members 
to the master service at any time.

For example, we will create a master service instance called Sales Services. This master 
service will contain the Amortize and GS-Calc services.

Figure 17 Sample services in the ZSERVICE Class

To create a Master Service for a Service Group

1 Open the HPCA Administrator CSDB Editor and navigate to the 
PRIMARY.SOFTWARE.ZSERVICE Class.

2 Expand the class to display the Application (ZSERVICE) instances.

3 Right-click Application (ZSERVICE). A shortcut menu opens.

4 Select New Instance from the shortcut menu. The Create Instance dialog box opens.

Table 38 ZSVCGRP variable

Value Behavior

Y Specify Y (Yes) for the Configuration Server to process the service 
groups as if they are unrelated applications or applications that 
are not dependent on one another for installation.
If this variable is not present, this is the default.

D Specify D (Dependent) for the Configuration Server to process the 
services under the service group as though they are dependent on 
one another for installation. If one sub-service fails, the remaining 
services will not be installed.

N Specify N (No) for no service groups.
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5 Enter the name of the new ZSERVICE instance (SALES SERVICES).

6 Click OK to create the instance. The new instance appears in the Application (ZSERVICE) 
Class.

Now you can add services to the master service.

7 Right-click SALES SERVICES, and select Show Connections from the shortcut menu. The 
SOFTWARE.ZSERVICE Connections dialog box opens.
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8 Select the Application (ZSERVICE) Class from the SOFTWARE.ZSERVICE connections 
dialog box, and click OK. The ZSERVICE Class instances are displayed on the list view of 
the screen.

9 Select the services from the right, and drag them to the ZSERVICE.SALES SERVICES 
instance.

10 Drop them onto the service when the cursor changes into a paper clip.

11 Confirm the connection.

12 Follow the steps that are outlined above to add services, if needed. The master service 
instance for this service group is now complete.

The services grouped into a master service will install from top-down according to 
the order in which they are connected to the master service instance in the 
database. Member services in a master service group do not honor the settings in 
ZSVCPRI.
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You can now deploy this master service to the users.

Filtering—Viewing Portions of the CSDB

As your desired state grows, you will find it convenient to restrict the HPCA Administrator 
CSDB Editor to view only a portion of the CSDB. This saves effort in scrolling through the 
window to locate the domain, class, or instance you need to inspect or edit. The HPCA 
Administrator CSDB Editor has the ability to set filters to provide user-defined restricted 
views of the CSDB. This is particularly valuable for classes that can have thousands of 
instances such as the USER Class or the FILE Class.

The filter specification determines which domains, classes, or instances to display in the 
HPCA Administrator CSDB Editor. Filtering is based upon matching the name of the domain, 
class, or instance with the filter specification you provide.

Filter specifications can contain one or more wildcards, represented by an asterisk, and/or one 
or more placeholder characters represented by a question mark. An asterisk matches any 
number of characters in the name of the component being filtered. Each question mark 
represents any one character in the name of the component being filtered.

Here are a few examples of valid filter expressions, and what they select.

You can apply filters that remain in effect for an entire HPCA Administrator CSDB Editor 
session--permanent filters--, or filters that apply only to the current HPCA Administrator 
CSDB Editor window--temporary filters--.

Permanent Filters

Permanent filters are applied every time you open any HPCA Administrator CSDB Editor 
window and remain in effect for that entire HPCA Administrator CSDB Editor session. Each 
class can have its own permanent filter specification.

To set or clear a permanent filter use the Permanent Filter Settings group box at the top of 
the Filter dialog box.

Table 39 Examples of valid filter expressions

Filter Specification Selects

* Wildcard to select all; removes any filter currently 
in effect.

_* Names whose first character is an underscore.

*_A* Names that have a prefix, and any level of the prefix 
is followed by an A.

*.?LL Names ending in a period, followed by any one 
character, followed by LL. 

*-??WORD*.HP Names containing any number of characters 
preceding a dash, followed by any two characters, 
followed by WORD, followed by any number of 
characters up to a period, followed by HP, followed 
by any one character.
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To set a permanent filter to filter instances of the USER Class on the prefix ESB_

1 Expand the POLICY Domain in the tree view.

2 Scroll down the tree view until you reach the USER Class.

3 Right-click the USER Class. A shortcut menu opens.

4 Click Filter Instances to open the Filter Instances dialog box.

5 Type ESB_* in the Customize the filter text box.

6 In the Permanent Filter Settings group box, click Set next to Users class. The filter 
specification is displayed.
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7 To apply the filter, click Save/Apply at the bottom of the dialog box. The dialog box closes, 
and the tree display will be updated with the filter applied.

This filter is applied to the USER Class in any additional HPCA Administrator CSDB 
Editor windows you open during the current HPCA Administrator CSDB Editor session.

To remove a permanent filter

1 Click the appropriate Clear button in the Filter Instances dialog box.

2 Click Save/Apply to remove the filter.

Temporary Filters

The Filter Instances dialog box also enables you to apply temporary filters. Temporary 
filters remain in effect only as long as the current CSDB Editor window is open. To create a 
temporary filter, enter a filter specification in the Customize the filter field, and then click 
Save/Apply.

To set a temporary filter to filter instances of the USER Class on the prefix ESB_

1 Expand the POLICY Domain in the tree view.

2 Scroll down the tree view until you reach the USER Class.

3 Right-click the USER Class. A shortcut menu opens.

4 Select Filter Instances to open the Filter Instances dialog box.

5 Type ESB_* in the Customize the filter text box.

6 Click Save/Apply.

To remove a temporary filter

1 Apply * as a filter specification.

This matches any domain, class, or instance name, effectively removing the filter. The * 
filter specification is frequently found in the express filter list.
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2 Click Save/Apply to remove the filter.

Viewing the Base or Null Instance

The Filter Instances dialog box also enables you to restrict your view to only the Base 
Instance or the Null Instance of the class. 

To view the base or null instance

1 Expand the POLICY Domain in the tree view.

2 Scroll down the tree view until you reach the USER Class.

3 Right-click the USER Class.

4 Select Filter Instances from the shortcut menu. The Filter Instances dialog box opens.

5 Click Get Base to view the _BASE_INSTANCE_ of the USER Class, or click Get Null to 
view the _NULL_INSTANCE_ of the USER Class.

6 Click Save/Apply.

Appending Filter Results

You might want to continue viewing the current filter’s result, and add an additional filter. To 
view both results at the same time, select Append Results when you perform the next filter.

Filtering Component Class Instances

Component class instances such as those of the FILE and DESKTOP Classes can be filtered 
based on the configuration class instance to which they are connected.

When filtering component classes such as the FILE class of the SOFTWARE Domain, the 
Filter Instances dialog box contains a scrolling list labeled Owning Package, as shown in 
the figure below. The package instances are listed in this scrolling list.
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Figure 18 Filtering component classes

To filter FILE instances to select only those connected to a particular PACKAGE instance

• Double-click a package listed in the Owning Package list.

or

• Click the package in the Owning Package list, and click Save/Apply.

For example, select Amortize Windows Platforms in the Owning Package list, and then 
click Save/Apply. The Filter Instances dialog box will close, and the selected instances 
will appear in the list view of the HPCA Administrator CSDB Editor window.

Express Filters

The box beneath the label contains a list of potentially useful filter specifications that an 
administrator with appropriate authority can customize.

These are express filter specifications. As the label indicates, simply double-click the 
specification of your choice to apply it immediately. The filter is temporary, applying only to 
the current HPCA Administrator CSDB Editor window.

Customizing Express Filters

You can specify the lists of express filters that appear in the Filter Instances dialog box by 
storing them in the CSDB, and making any needed connections. The HPCA Administrator 
CSDB Editor retrieves the list of express filters for a particular Filter Instances dialog box 
from the CSDB as the dialog box opens.

The HPCA Administrator CSDB Editor locates the correct list in the CSDB by starting a 
resolution process based on the user ID that was entered when the HPCA Administrator 
CSDB Editor session was started, and the HPCA components, for example, domain, class, or 
instance are filtered. For more information, see Appendix F, Resolution Process.

The list of express filters for a particular domain is taken from an instance of the ZLIST32 
class of the ADMIN Domain in the PRIMARY File. Here’s how:
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Assume you have logged on as user ID ADMIN. The authority and defaults associated with an 
administrator’s user ID are stored in the ADMIN Domain of the PRIMARY File. The 
ADMINID Class contains an instance for each administrator’s user ID in this case, the 
instance name is ADMIN.

The ADMIN instance contains a connection to an instance of the ZADMIN class, in this case 
ZADMIN.MASTER_ADMIN.

Figure 19 The ADMIN instance connections

The connection to ZADMIN.MASTER_ADMIN passes a parameter in the system message 
(&ZADMFUNC) that indicates which of the connections contained in the 
ZADMIN.MASTER_ADMIN instance should be made. Only those connections whose names 
match the value of the system message (or whose name is _ALWAYS_) are actually made 
during a particular resolution. The HPCA Administrator CSDB Editor sets the parameter’s 
value before initiating the resolution. In this case, the HPCA Administrator CSDB Editor sets 
the value of the ZADMFUNC variable (and thus, after symbolic substitution, the value of the 
system message) to MASKINST, because the Filter Instances dialog box needs to retrieve a 
list of instance masks.
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Figure 20 ZADMFUNC variable set to MASKINST

This causes a connection to an instance of the ZLIST32 class, ZLIST32.MASTER_& 
ZADMDOMN_INSTANCES, based upon the domain to be filtered (SYSTEM). The domain is 
dynamically set in the ZADMDOMN variable by the HPCA Administrator CSDB Editor. This 
is determined by the class the administrator right-clicked to access the Filter Instances 
dialog box. In our example, the connection will be made to 
ZLIST32.MASTER_SYSTEM_INSTANCES after the resolution process performs symbolic 
substitution, that contains the desired list of default express filter specifications.

Figure 21 Connection to LIST32.MASTER_SYSTEM_INSTANCES

To change the list of express filters for a domain, edit the appropriate instance of the ZLIST32 
class. The changes will affect all administrators whose user IDs connect to the ZLIST32 
instance you modify.
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To set custom express filters for particular administrators, use the information detailed above 
to connect their user ID instances in the ADMIN.ADMINID Class to the appropriate ZLIST32 
instance containing the desired list of express filters.

For information on how to use the HPCA Administrator CSDB Editor to make these changes, 
see Adding an Instance on page 117 and Editing an Instance on page 117.

Maintaining Connection Rules in the CSDB

The HPCA Administrator CSDB Editor provides drag-and-drop connections between 
instances of classes. These connections, which contain connection rules, are stored in the 
CSDB.

Connection Rules Overview

To enable drag-and-drop capabilities for a new class, you need to establish rules for the new 
class. These connection rules are stored in the PRIMARY File, ADMIN Domain, ZCONNECT 
Class, MASTER_CONNECTION_RULES Instance.

Figure 22 MASTER_CONNECTION_RULES instance

While the ZCONNECT Class contains the connection rules, the Name List (ZLIST) Class 
contains all of the rules for all of the classes. In order to create a connection rule, you need 
to create the rule in the ZLIST Class. Then you add the rule to the ZCONNECT Class.
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Figure 23 Name Lists (ZLIST) Class in ADMIN Domain

The HPCA Administrator CSDB Editor then uses these rules to populate the class list in the 
Show Connections dialog box, and to control drag-and-drop connections.

For example, notice the connection rules that have been established for the USER Class. To do 
this, examine the ZLIST.CONNECT_USER_TO_RULES Instance as shown in the following 
figure.

Figure 24 ZLIST.CONNECT_USER_TO_RULES Instance

An instance of this particular USER Class can contain a connection to any of the following 
classes:

• WORKGRP

• ZSERVICE

• DEPT
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• COUNTRY

• STAGER

• HTTP

• MULTCAST

• MBLCONFG

The ZLIST instance contains a list of up to 20 classes to which the class, represented by the 
ZLIST instance, in this case USER, can connect. You can edit this list to include additional 
classes, or remove classes from a connection rule. If any class in the CSDB needs to be able to 
connect to more than 20 different classes, you can edit the ZLIST Class template and add 
more ZNAMEnn variables.

After you establish the rules for connection in the Name List (ZLIST) Class, the connection 
type can be created. Since we are creating a connection rule for drag-and-drop, the class 
variable is added to the Connection Rules (ZCONNECT) Class. Then edit the Rules variable 
to define the type of connection that can be made to the USER Class.

Now you can make a drag-and-drop connection to the new class. The following figure shows 
the connectable classes for the POLICY Domain where the USER Class is located.

Figure 25 Connectable classes for the POLICY Domain

Enabling Connections in New Classes

If you add a new class to the CSDB that can validly contain connections to other classes, you 
need to:

• Create an instance in the ZLIST Class to represent the new class.

• Set the new ZLIST Class instance to enable the connection rules.

• Add the new class to the ZCONNECT Class template.

• Set the new class’ variable in the MASTER_CONNECTION_RULES.

For example, the steps below show how to add the connections for a new class called TEST.

1 Create an instance of the ZLIST Class named CONNECT_newclass_TO_RULES, where 
newclass is the name of the new class, for example, TEST.
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2 Open the HPCA Administrator CSDB Editor and navigate to the 
PRIMARY.ADMIN.Name Lists (8) (ZLIST) Class.

3 Right-click ZLIST and select New Instance.

4 Name the new instance as suggested above, CONNECT_TEST_TO RULES. This figure 
shows the added CONNECT_TEST_TO_RULES in the ZLIST Class.

5 Edit the CONNECT_TEST_TO_RULES Instance, setting each ZNAMEnn variable to the 
name of a class to which the new class can be connected.
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For example, set values for ZNAME01 and ZNAME02 to enable connections to the 
ZSERVICE and WORKGRP Classes, as shown in the following figure.

Now you need to add the connection rule variable to the Connection Rules 
(ZCONNECT) Class.

6 Navigate to the PRIMARY.ADMIN.ZCONNECT Class.

7 Right-click ZCONNECT Class and select Edit Class from the shortcut menu.

8 Add the new class variable (TEST) to the class template for the ZCONNECT Class. The 
length of the attribute is 50, and the description is Test Connect List.

After you add the new attribute to the class template, you need to set the value of the new 
attribute in the ZCONNECT.MASTER_CONNECTION_RULES Instance.

When adding an attribute to the ZCONNECT Class, be sure to change the 
attribute type to Class Connection. See the figure below.

For information on editing a class, see Editing a Class on page 108.
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9 Locate the new instance in the list view on the right side and set the value of the new 
variable to ZLIST.CONNECT_TEST_TO_RULES.

For example, check the value that has been set for the TEST attribute in the next figure.
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The next figure shows that the new connection rule was added to the 
MASTER_CONNECTION_RULES, thereby allowing drag-and-drop connections for the 
new class.

Managing WI-enabled Applications

This section describes the Feature Set Editor.

Feature Set Editor Overview

The HPCA Administrator CSDB Editor has a Feature Set Editor, with a wizard type interface, 
that guides you through the selection and configuration of the features of a Windows 
Installer-enabled software package managed by HPCA. This enables you to use the features of 
Windows Installer while taking advantage of the packaging and deployment technologies of 
HPCA.

With the release of Microsoft Office 2000, Microsoft introduced new technology, Microsoft 
Windows Installer, for installing and maintaining software products on the Windows 
platform. HPCA products can install and manage Windows Installer-enabled applications as 
follows:

The HPCA Administrator Publisher has basic and advanced methods of publishing and 
configuring Windows Installer-enabled applications.

The CSDB enables HP products to store Windows Installer feature sets.

HPCA provides policy administration and state data gathering.

For information regarding the publishing of Windows Installer-enabled 
applications, see Windows Installer Files on page 61.
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HPCA provides the ability to control the customization of MSI packages without the need to 
create Windows Installer Transform (MST) files.

HPCA provides the ability to discover and manage previously installed Windows 
Installer-enabled applications that were not deployed using HPCA.

Accessing the Feature Set Editor

To access the Feature Set Editor

1 Locate the Application Packages instance that represents the software package whose 
features you want to edit.

2 Double-click this instance to display its MSI and MSIFEATS connections.

3 Right-click the MSIFEATS connection in the tree view, as follows:

4 Select Feature Set Editor from the shortcut menu.

The Feature Set Editor dialog box opens.

About the MSI Feature Set Editor

Figure 26 on page 155 shows that the Feature Set Editor interface is divided into three 
areas, the tree view on the left, buttons on the right, and package size information on 
the bottom.
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Figure 26 Feature Set Editor dialog box

a Buttons
b Tree View
c Package size information

Tree View

Features are grouped into a hierarchy through which you navigate using the tree control. 
Higher-level features consist of two or more lower-level, child features. Navigate through the 
tree as you would through a typical Windows Explorer tree.

Features Menu

When you click on the drop-down button next to a feature, the Features menu opens.

Figure 27 Features menu

Each of the features has an attribute that indicates how that feature is to be installed and 
maintained.
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Names of features whose attributes are changed during the current session of the MSI 
Feature Set Editor appear in boldface in the tree.

Normally, by setting an attribute for a higher-level feature, the setting is automatically 
applied to all of the child features that comprise it. See the attribute descriptions in the 
following table for exceptions to this rule.

Table 40 Features menu options

Feature Icon 
and Name Description of Function

Run from My 
Computer

Features are physically installed on a hard drive on the 
agent computer, and therefore perform best.
This applies to all child features, unless the child feature’s 
attribute is already set to Installed on First Use or Not 
Available.
The children appear on branches of the tree, and are 
beneath and connected to the selected feature.

Run all from 
My Computer

Features are physically installed on a hard drive on the 
agent computer. All features that are children have their 
attributes changed to Run from My Computer, and they, 
too, are physically installed on the agent computer.
Features perform best because they are run from the end 
user’s machine. Mobile computer users should have all of 
the features they need while traveling set to Run from My 
Computer or Run all from My Computer. Otherwise, when 
they use a feature that is not installed on their computer’s 
hard drive, they will be prompted for the original 
installation media, which might not be available.

Run from 
Source

Features are not physically installed on a hard disk on the 
agent computer; rather they are run from the 
Administrative Installation Point (AIP). This is normally a 
network share persistently accessible to the agent 
computer.
When you select this attribute for a feature, the attribute is 
automatically applied to all features that are children, 
unless the child feature’s attribute is already set to Not 
Available.
The Run from Source and Run all from Source attributes 
save local hard drive space at the expense of slower 
performance and the need to have an active connection to 
the AIP.
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Run all from 
Source

Features are not physically installed on a hard disk on the 
agent computer, rather they are run from the AIP. This is 
normally a network share persistently accessible to the 
agent computer.
When you select this attribute, the Run from Source 
attribute is applied automatically to all features that are 
children, regardless of the attribute currently assigned to 
the child feature.
The Run from Source and Run all from Source attributes 
save local hard drive space at the expense of slower 
performance and the need to have an active connection to 
the AIP.

Table 40 Features menu options

Feature Icon 
and Name Description of Function
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Installed on 
First Use

Features are not installed on the agent computer until the 
end user tries to use the feature through a shortcut or 
menu selection. Shortcuts for shortcut-accessible features 
are deployed when the package is initially installed. When 
the end user first invokes the feature, files that are needed 
to support the feature are installed on the end user's hard 
disk, where they remain. Future uses of the feature are run 
from the agent computer.
In order to install such a feature, the agent computer must 
be running the Redirector service, and it must be able to 
connect to the Configuration Server computer.
This minimizes the use of hard disk space on agent 
computers by allocating space only to features that they 
actually use. On the other hand, end users are subject to 
the delay needed to install the feature at the time when 
they first invoke it.
When you select this attribute, the Installed on First Use 
attribute is applied automatically to all features that are 
children, unless the child feature's attribute is already set 
to Not Available.

Not Available

Features are not installed, are unavailable to the end user, 
but could affect other services. The attributes for all child 
features are also set to Not Available.
For example, one service is defined to deploy Microsoft 
Word, and all other features of Office are set to Not 
Available. Another service is defined to deploy Microsoft 
Excel, and all other features of Microsoft Office are set to 
Not Available.
Now, imagine that the end user installs the Microsoft Word 
service. It installs successfully and does not install any of 
the other features of Microsoft Office. A bit later, the end 
user installs the Microsoft Excel service. The Microsoft 
Excel service indicates that all other features of Microsoft 
Office are Not Available. Therefore, Microsoft Excel is 
installed, but Microsoft Word is uninstalled.
If the end user selects an option that requires the feature, 
the software instructs the end user to run the setup again 
and change the installation state of the feature. However, 
end users whose software is managed by HPCA generally 
do not have access to the setup.
Assign the Not Available attribute only to features that 
must be unavailable to end users. Provide information to 
the end user about what to do if they receive a message.

Table 40 Features menu options

Feature Icon 
and Name Description of Function
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Names of features whose attributes have been changed during the current session of the MSI 
Feature Set Editor appear in boldface in the tree.

Hide and Disable Features

When you right-click the name of a feature as in the following example, Microsoft Word for 
Windows, the shortcut menu for Hide and Disable opens:

Figure 28 Shortcut menu for Hide and Disable

When you select Hide, the feature and all of its child features will not appear in the native 
Microsoft Windows Installer Update Features dialog box, which is accessible to the user 
using the Control Panel’s Add/Remove Programs applet.

Ignore

Note: This is available for backward compatibility. You do 
not need to determine which features need to be ignored by 
a service.
Features set to Ignore are not installed, are unavailable to 
the end user, but will not affect other services. HPCA 
management products act as though the feature were not a 
component of the managed software at all. The attributes 
for all child features are also set to Ignore.
For example, one service is defined to deploy only Microsoft 
Word, with all other features of Microsoft Office set to 
Ignore. Another service is defined to deploy Microsoft Excel 
and Microsoft PowerPoint, setting all other features of 
Microsoft Office to Ignore. If an end user installs both 
services, the features installed by the first-installed service 
will not be affected by the installation of the 
second-installed service.
Both services can be created from one package published to 
the CSDB. The package is cloned by copying it with another 
name. You can then use the Feature Set Editor to edit the 
features of each package.

Table 40 Features menu options

Feature Icon 
and Name Description of Function
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All features that are hidden appear in the MSI Feature Set Editor tree with the prefix (H) 
before the name of the feature.

When you select Disable, the feature and all of its child features are ignored by the HPCA 
agent. A disabled feature’s value is determined by Windows Installer, from the combination of 
MSI and MST files, instead of the value in the HPCA instance.

All features that are disabled appear in the MSI Feature Set Editor tree with the prefix [D] 
before the name of the feature

Feature Set Editor Buttons

The Feature Set Editor buttons are located on the right side of the Feature Set Editor window. 
The following table describes these buttons.

Package Information

Use the package information to view the size of the current Windows Installer-enabled 
features that you are configuring.

Maximum Size
This is the total number of bytes that would be needed on the agent computer to install the 
features in the tree, if all features in the tree they were given the Run from My Computer or 
Run All from My Computer attribute.

Total Size
This is the total number of bytes needed on the agent computer to install only those features 
in the tree that have the Run from My Computer or Run All from My Computer attribute.

Table 41 Feature Set Editor Buttons

Button Description of Function

Save & Exit Click Save & Exit to accept the changes that were made to 
the attributes of the file and exit the Feature Set Editor. It 
is also possible to exit the Feature Set Editor by clicking 
the X on the top right corner.

Exit (no Save) Click Exit (no Save) to discard any changes that were made, 
and to then exit the Feature Set Editor. It is also possible 
to exit the Feature Set Editor by clicking on the X on the 
top right corner.

Defaults Click Defaults to reset all features' attributes to the 
settings in the MSI file distributed with the software by 
the software vendor. The default setting will not be applied 
to the feature set until the feature set is saved when you 
click Save & Exit.

Reset Click Reset to discard any changes made to feature 
settings since you opened the current session of the MSI 
Feature Set Editor. Settings for all features are refreshed 
by re-reading them from the CSDB.

Help Click Help to access the HPCA Administrator CSDB Editor 
Help topics.
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Selected Size
This is the total number of bytes needed on the agent computer to install a single feature 
including the child features that you have selected. The size calculation includes only features 
with the Run from My Computer or Run All from My Computer attribute.

Windows Add or Remove Programs Settings

When a Windows Installer-enabled software package, such as Microsoft Office, is installed on 
an agent computer, it is normally added to the list of applications that can be managed by the 
Add or Remove Programs application of Windows Control Panel.

HPCA enables you to not list an application in the Add or Remove Programs application of 
Windows Control Panel. This prevents the end user from interfering with HPCA products’ 
centralized management of the application. Alternatively, HPCA also enables you to 
selectively hide individual features from access by the Add or Remove Programs application.

Preventing an Application’s Listing in Add or Remove Programs

To prevent listing the application in the Add or Remove Programs application, use HPCA 
Administrator CSDB Editor to change the setting of the SHOWINCP variable of the MSI 
class instance for the DATA1.MSI file that is connected to the Application Packages Class 
instance:

Figure 29 DATA1.MSI instance

Change the value of the SHOWINCP variable to N, as follows:
HP Client Automation Administrator Tools for Windows 161



Figure 30 Editing DATA1.MSI instance

Hiding Features displayed by Microsoft Windows Installer Update Features 

When the end user selects the Windows Installer-enabled software package in the Add or 
Remove Programs application and clicks Change, Microsoft Windows Installer is invoked, and 
opens its native interface for manipulating features of the installation on the agent computer. 
If the end user clicks Add or Remove Features, Microsoft Windows Installer displays its Update 
Features windows.

Use the MSI Feature Set Editor’s Hide function to prevent individual features from appearing 
in the Microsoft Windows Installer Update Features dialog box. This enables you to use HPCA 
to control the end user’s installation of the application software’s features using the HPCA 
management product’s capabilities, and avoids possible end-user interference.

Copying a Windows Installer Enabled Package

One of the key advantages of using HPCA products to manage Windows Installer-enabled 
applications is the ability to specify variants of the software package, and make those variants 
available to targeted users.

When you use the advanced capabilities of HPCA, you to create only one comprehensive AIP, 
and publish it to the CSDB. All variant sets of features are encapsulated in individual 
packages in the CSDB.
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To make a new variant set of features

Copy an existing package, and edit it to meet its unique requirements.

1 Right-click on the Application Packages instance and select Copy Package from the 
shortcut menu.

A message tells you that copying a package instance will result in a duplication of all the 
package's component instances, and that this may take a while.

2 Select Yes to continue the Copy Package function.

Select No to cancel the Copy Package function.

Copying the package copies the package instance and all of the component class instances 
that belong to the package instance. The new package is a complete copy of the original. 
This operation maintains the integrity of the CSDB, because each package retains control 
over its own components.

3 In the Copy Package and Components dialog box, type the name for the newer copied 
package.

4 Click OK to continue. The Configuration Server takes a few moments to copy the package.

5 When the newly copied package appears in the HPCA Administrator CSDB Editor’s tree 
view, right-click on the MSIFEATS instance beneath the package and select Feature Set 
Editor from the shortcut menu.

The MSI Feature Set Editor opens.

6 Set the properties of the applications that should not be deployed to Ignore.

7 Click Save & Exit, and the feature set for the package is updated. You can now connect this 
package to the appropriate policy instances such as USER, DEPT, WORKGRP, to deploy 
and manage a single feature as a stand-alone application.

Managing Feature Sets in Native Mode

In some enterprises, packaging applications and administering HPCA are separate functions. 
You might not want to use the MSI Feature Set Editor to edit the transform (MST) files. Use 
the following procedure to publish the package and MST files and enable you to manage 
feature sets in native MSI mode.

1 Use the HPCA Administrator Publisher in Advanced mode to create the ACP and publish 
the Windows Installer package.
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After you publish the package, use HPCA Administrator CSDB Editor to remove the 
connection to SOFTWARE.MSIFEATS.packageprefix_* from the Application Packages 
(PACKAGE) instance.

2 If you have multiple MST files, use the HPCA Administrator Publisher in Component 
Select Mode to promote each of the MST files into individual packages. This will create a 
new PACKAGE instance for each MST file.

3 Connect the MSI PACKAGE instance to each of the transform file’s PACKAGE instances.

4 Create one Application (ZSERVICE) instance for each of the transform packages.

5 Assign subscribers to the appropriate transform package’s service.

When the service is installed or modified, HPCA will detect the absence of the MSIFEATS 
object, and will use the native MSI mode, MSIEXEC. HPCA will call MSIEXEC natively with 
the proper location of the data source. If HPCA calls MSIEXEC and detects the presence of a 
single MST file, it will add the .MST file to the command line that invokes MSIEXEC. If 
HPCA calls MSIEXEC and detects more than one MST file, it will run MSIEXEC only for the 
MSI file. The MSI native behavior will be used for update and repair.

Registry File Editor

Use the Registry File Editor to edit the properties or values for registry keys associated 
with a Client Automation package.

When you use HPCA Administrator Packager to create a package, all of the registry changes 
for that package are stored in a file with an .EDR extension in the LIB directory. Use the 
Registry File Editor to modify this file. Then, the file is re-published to the CSDB and the 
instance is updated.

Accessing the Registry File Editor

To access the Registry File Editor

1 Locate the Registry Resources instance that represents the software package whose 
registry settings you want to change.

Any changes to or replacement of the *.MST file will cause HPCA to call 
MSIEXEC to uninstall and reinstall the application.

If you are using an MST file to include a new feature that is not already a feature 
available in the Feature Set Editor (MSIFEATS), the new feature from the MST 
file will be included in the MSI service. However, if there is a feature in the MST 
file that already exists in the MSIFEATS object, the feature state indicated in 
MSIFEATS will be used, and the one in the additional MST file will be 
disregarded. If you want to manage the MSI package using only your MST file, use 
the procedure described in this section.
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2 Right-click the instance in the tree view. A shortcut menu opens. For example, locate the 
registry instance for the Drag & View Windows Platforms package and right-click.

3 Select Edit Registry Resource. The Registry File Editor dialog box opens.

— The tree view on the left displays nodes that represent keys in the registry file.

— The list view or value name in the middle displays the contents of a selected registry 
key.

— The buttons on the right enable you to Save & Exit, Exit without saving, or access the 
Help function in the Registry File Editor.

Set Properties Shortcut Menu

To set properties for the Registry File Editor, right-click any node of the tree view in the 
Registry File Editor. A shortcut menu opens.

Each option in this shortcut menu is described in the following sections.
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Active

Select Active to include the registry keys in the package.

Inactive

Select Inactive to prevent the registry keys from being included in the package. Inactive nodes 
appear with a  symbol covering its folder.

Deploy/Verify

Click Deploy/Verify to access the following submenu:

• Unconditional/Enforced
HPCA deploys the registry key every time the subscriber connects to the Configuration 
Server, even if it already exists on his desktop. This setting repairs the registry key if it is 
modified or deleted. Use this setting for registry keys that must remain invariant in order 
for the application software to function properly.

• Unconditional/Exist
HPCA deploys the registry key upon initial deployment or if it has been deleted. However, 
the value of the registry key is not reset if the user modifies it. This is the default setting.

• Exist/Exist
HPCA deploys the registry key only if it does not exist on the subscriber's desktop, during 
both the initial deployment and on each subsequent connection. This gives users full 
control over the registry key value, but reinstalls the key if it is accidentally deleted.

New Key

Click New Key if you would like to add a new value to your registry. This opens a dialog box to 
enter the New Key name. Click OK to accept the new key, or Cancel to return to the Registry 
File Editor.

New Value

Click New Value to add a value to a newly created key or to add a value to an existing registry 
key. This opens a dialog box where you enter the following information:

Value Name
Enter the name of the value you want to add to the registry file. This name will appear in the 
Value Name (center) of the Registry File Editor window.

Data Type
Use the drop-down menu to select from the list of available data types. The type selected is as 
follows:

• REG_SZ
A text sequence most typically used for descriptive information. This is the default 
setting.

• REG_DWORD
Data represented by an integer that is 4 bytes long and is displayed in the binary, 
hexadecimal, or decimal format.

• REG_EXPAND_SZ
An expandable data string. This text contains a variable that is replaced when called by 
an application.

• REG_MULTI_SZ
A string containing multiple text entries of user-readable text.
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Delete Always

Click Delete Always if you want all values under a Registry key to be deleted during a 
Radreg32 Delete operation. When this option is turned on, all values under the key are 
deleted without restoring their original registry values in the backup EDR file.

Delete Never

Click Delete Never if you want to retain all values under a key during a Radreg32 Delete 
operation.

Delete (Default)

Click Delete (Default) if you want the Radreg32 Delete operation to exhibit normal Delete 
behavior with regards to deleting or restoring values.

Editing a Registry Key

To edit a registry key’s value access the key through the Registry File Editor. Follow the 
example in this section to edit the information in a registry key.

To edit the data in a registry key

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security Information 
dialog box appears.

2 If necessary, type a user ID and password, then click OK. The HPCA Administrator CSDB 
Editor splash screen appears briefly.

3 Double-click PRIMARY.

4 Expand the SOFTWARE Domain and then the Application Packages (PACKAGE) Class.

5 Expand the package Drag & View Windows Platforms.

Use extreme caution when you use the Registry File Editor. Editing registry keys 
without thorough understanding of their functions could render a package or 
service useless.

The default user ID and password are:

User ID: ADMIN

Password: secret
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6 Expand the Registry instance.

7 Right-click the registry file and select Edit Registry Resource from the shortcut menu. The 
Registry File Editor dialog box opens.

8 Click the node to expand and display the contents of the registry key in the list view.

9 Double-click the name of the registry key in the list view.

The Override Value dialog box opens.

10 Edit the data in the New Value text box.

11 Click OK to save the changes and close the dialog box

or

Click Cancel to close the dialog box without saving the changes.

To restore the data in a registry key

1 Double-click the name of the registry key in the list view.

2 Click Reset.
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3 Click OK to save the changes and close the dialog box.

or

Click Cancel to close the dialog box without saving the changes.

Closing the Registry File Editor

Close the Registry File Editor dialog box when you are finished making changes to 
instances of the Registry file.

To close the Registry File Editor

1 Click Save & Exit to save the changes and close the dialog box.

or

Click Exit (no Save) to discard the changes and close the dialog box.

2 Click Yes to confirm that you want to save the changes and close the dialog box.

or

Click No to return to the Registry File Editor dialog box.
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4 Installing HP Client Automation Administrator: 
Linux and Macintosh
HPCA Administrator for LINUX contains two tools: HPCA Administrator Publisher and 
HPCA Administrator Agent Explorer.

HPCA Administrator for Macintosh contains one tool: HPCA Administrator Publisher.

System Requirements

TCP/IP connection to a computer running the HPCA Configuration Server.

Platform Support

For detailed information about supported platforms, see the release note document that 
accompanies this release.

Prerequisites

• HP recommends installing the HPCA Administrator as root (or as a Mac OS X 
administrator user ID capable of issuing sudo commands).

• Install the HPCA Administrator on a local file system.

• If you plan to run any of the graphical components of HPCA Administrator, make sure the 
LINUX environment variable DISPLAY is set in your environment. If it is not, the 
installation will default to a non-graphical installation. However, you can set this variable 
to indicate the host name or IP address to which you would like to redirect the graphical 
display.

Table 42 Setting the DISPLAY Variable

In a... Type...

C shell setenv DISPLAY IP address or hostname:0.0

Bourne, Bash, or 
Korn shell

DISPLAY=IP address or hostname:0.0
export DISPLAY

If the DISPLAY environment variable is not set in your environment, the 
installation defaults to a non-graphical installation.
171



Troubleshooting

If you encounter any problems while installing the HPCA Administrator, perform the 
following steps before contacting technical support:

• Enable diagnostic tracing by appending the text -loglevel 9 to the installation 
command line and run the installation again.

• Access tmp/setup/setup.log located in the home directory of the user ID who ran the 
install.

Recommendations

HP recommends that you install and run HPCA Administrator as root.

Installation Methods

To install HPCA Administrator do either of the following:

• Execute the installation procedure directly from the installation media.

• Copy the files from the installation media into a temporary directory and execute the 
installation procedure.

You can use several parameters on the command line when you install HPCA Administrator.

• -mode plain

Example: ./install –mode plain

Installs HPCA Administrator in plain mode. The installation graphics are displayed in 
plain mode (no moving graphics). This is useful for remote installations where network 
bandwidth might be an issue.

• -mode text

Example: ./install –mode text

Installs HPCA Administrator in text mode using the non-graphical installation. The 
installation takes place completely on the command line. The installation will default to 
text mode if the DISPLAY environment variable is not set.

Installing HPCA Administrator for LINUX or Macintosh

Graphical Installation

To install HPCA Administrator for LINUX or Macintosh using a GUI

The install option –loglevel 9 should only be used to diagnose installation 
problems.

Root authority is required to apply owner and group designators to managed 
resources.

If the user ID of the person performing HPCA Administrator installation has 
previously installed an HPCA Agent, the location of HPCA Administrator will 
default to the location of the HPCA Agent.
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1 Depending on your operating system, change your current working directory to the 
correct subdirectory on the installation media.

Examples: 

In Linux:
/Setup-Core/Media/admin/default/linux

In Mac OS:
/Setup-Core/Media/admin/default/macx86

2 Type ./install (for Mac OS X, type sudo ./install) and then press Enter. The 
Welcome window opens.

3 Click Next. The HP Software License terms window opens.

4 Read the software license terms and click Accept.

HPCA Administrator Location window opens.

5 Type the name of the directory where you are installing HPCA Administrator, or click 
Browse to navigate to it.

6 Click Next. If the specified directory already exists you will be prompted to verify this 
location.

— If you would like to update the existing directory, click OK.

— If you would like to change the directory location, click Cancel.

The Lib Directory window opens.

7 Type the name of the directory where you would like to store proprietary information 
created by HPCA (the lib directory), or click Browse to navigate to it.

8 Click Next. The Log Directory window opens.

9 Type the name of the directory where you would like to store the log files generated by 
HPCA, or click Browse to navigate to it.

10 Click Next. The HPCA Configuration Server IP Address window opens

11 Type the IP address (format: xxx.xxx.xxx.xxx) or host name of the Configuration Server 
you will be publishing to.

12 Click Next. The HPCA Configuration Server Port Number window opens.

13 Type the port number of your HPCA Configuration Server (default is 3464).

14 Click Next. The Package Settings window opens.

15 Review the settings displayed in the Package Settings window. If you would like to change 
any of the settings, click Back until you get to the appropriate window.

16 When you are satisfied with the Package Settings, click Install. HPCA Administrator is 
installed.

If you are installing HPCA Administrator to a computer with the same user ID 
that had previously installed an HPCA Agent, the installation program will 
prompt you for the HPCA Configuration Server's IP address. The next three 
windows: Administrator Location, Lib directory, and Log directory, are needed 
only if you are installing HPCA Administrator to a computer that does not have an 
HPCA Agent already installed.
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Command-Line Installation

1 At a command prompt, change your current working directory to the correct operating 
system subdirectory on the installation media.

Example: 

In Linux:
/Setup-Core/Media/admin/default/linux

In Mac OS:
/Setup-Core/Media/admin/default/macx86

2 Type ./install –mode text (for Mac OS X, type sudo ./install –mode text) and 
then press Enter.

HPCA Administrator installation begins.

3 Type C, and then press Enter.

4 Specify the installation location for HPCA Administrator, and then press Enter.

5 Specify the location for the HPCA proprietary objects (IDMLIB), and then press Enter.

6 Specify the location for the log files created by HPCA (IDMLOG), and then press Enter.

7 Specify the IP address of the HPCA Configuration Server, and then press Enter.

8 Specify the port number of the HPCA Configuration Server, and then press Enter.

9 Review the installation settings you have chosen. If you want to install HPCA 
Administrator with these settings, press Enter to accept the default (Y) and begin the 
installation or type N, to re-enter your installation information.

10 To complete the configured installation process, press Enter. HPCA Administrator is 
installed.

If you are installing HPCA Administrator to a computer with the same user ID 
that had previously installed an HPCA Agent, the installation program will 
prompt you for the HPCA Configuration Server's IP address. The next three 
sections: HPCA Administrator Location, Lib directory, and Log directory, are only 
needed if you are installing HPCA Administrator to a computer that does not have 
an HPCA Agent already installed.
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5 HP Client Automation Administrator for Linux 
and Macintosh
HP Client Automation (HPCA) Administrator for LINUX consists of: 

• HPCA Administrator Agent Explorer

• HPCA Administrator Publisher

HPCA Administrator for Macintosh consists of HPCA Administrator Publisher.

HPCA Administrator Agent Explorer

The HPCA Administrator Agent Explorer is available for Linux, but is not available for 
Macintosh.

Accessing the HPCA Administrator Agent Explorer

The following instructions explain how to open and close the HPCA Administrator Agent 
Explorer.

To open the Agent Explorer

From the HP Client Automation Administrator folder, click HP Client Automation Administrator 
Agent Explorer or at the command line type ./radobjed.

The HPCA Administrator Agent Explorer opens with the object list displayed in the right 
pane as shown in Figure 31 on page 176. The object list contains the names of HPCA objects 
that you can view and edit.

Objects that begin with "Z" are used by HPCA. When naming an object that you 
create, HP recommends that you do not click a name beginning with the letter "Z."
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Figure 31 Agent Explorer Window

Menus in the Object List Window

Use the menus in the HPCA Administrator Agent Explorer window to open, copy, delete, 
rename, and create new objects, and to navigate the HPCA Administrator Agent Explorer.

Object Menu

Use the object menu to open, copy, delete, rename, and create new objects.

Figure 32 Object menu in the object list window
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Edit Menu

Select All
Click Select All to select all the objects in the object list. You can then perform actions from the 
Object menu on all objects at the same time.

View Menu

Refresh
Refreshes the screen.

Table Window Menu

Close all
Click Close all to close all open objects.

Menus in the Object View Window

The Object View window displays the contents of an HPCA object for you to view or edit, and 
contains four drop-down menus: Object, Edit, View, and Window.

Object Menu

Use the Object menu to view information about the object, save changes you make, and close 
the object.

Table 43 Object menu options

Menu option Function

New Click New and type a name for the new object in the 
Create New Object dialog box. 

Open Select an object in the object list and click Open. The 
Object View window opens where you can edit and 
manage variables and heaps for that object.

Copy Select an object in the object list. Click Copy, and type a 
name for the new object. A new object is created with the 
same variables and values.

Rename Select an object in the object list. Click Rename. Type a 
new name for the object.

Delete Select an object from the object list. Click Delete to remove 
it from the object list. After it is deleted, an object, its 
heaps, and its variables cannot be recovered.

Change User 
Directory

Select this option to change the default object directory.

Exit Click Exit to close the HPCA Administrator Agent 
Explorer.
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Figure 33 Object menu

Variable Menu

Use the Variable menu to add, delete, and rename variables, and manage and navigate 
through the heaps in an object based on their variable's values.

Figure 34 Variable menu

Table 44 Object menu options

Menu option Function

Information Displays the Object Information screen.

Save Saves the changes you made.

Close Closes the Object View window.
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Heap Menu

Use the Heap menu to add, delete, and copy instances in an object, and to navigate through 
the instances in an object.

An instance is also called a heap. To view each instance in an object, click >> or << at the 
bottom of the Object View window.

Table 45 Variable menu options

Menu option Function

Add Adds a variable with a user-specified name to an 
object.

Delete Deletes a variable from an object.

Edit Changes the value of a variable.

Filter Displays all the variables that contain a user-specified 
character string.

Modify All This feature is yet to be implemented. It changes the 
value of the variable for all heaps in an object.

Rename Renames a variable in an object.

Calculate Row 
Value

For a selected variable, sums all the decimal only 
entries for all heaps in the object.

Find For a user-selected variable, finds the heaps whose 
values contain a user-specified character string. 
Available only for multi-heap objects.

Find Next After you use the Find command to enter a character 
string to find, this command finds the next occurrence 
of this character string.

Find Previous After you use the Find command to enter a character 
string to find, this command finds the previous 
occurrence of this character string.
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Figure 35 Heap menu

HPCA Administrator Packager

The HPCA Administrator Packager is not available for Linux or Macintosh. For both of these 
operating systems, the package feature is part of the HPCA Administrator Publisher.

Table 46 Heap menu options

Menu option Function

Add Adds an instance with blank values. Navigate to Variable 
→ Edit to enter the values.

Delete Deletes the instance you select. Click >> or << to navigate 
to the instance that you want to delete.

Duplicate heap Makes a copy of the instance you select, including its 
values. Click >> or << to navigate to the instance you want 
to duplicate.

Copy heap to Copies the instance that you select to the object that you 
type in the Copy Instance to dialog box.

Go to Jumps to the instance whose number you type in the New 
Instance # dialog box.

Home Jumps to the first instance in an object.

End Jumps to the last instance in an object.
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HPCA Administrator Publisher

The HPCA Administrator Publisher is available for the Linux and Macintosh operating 
systems. This section describes how to use HPCA Administrator Publisher.

The HPCA Administrator Publisher for Linux and Macintosh only has one publishing mode – 
Component Select mode.

In Component Select mode, you select the individual components that make up the 
application, such as files, directories, and links to create a package.

Publishing in Component Select mode involves four phases:

1 Select the individual files to be published.

2 Edit the file properties and methods.

3 Configure the package and service options.

4 Publish the files to the CSDB.

Prerequisites

Before you publish the application in Component Select mode, install the target application 
on your packaging machine. This ensures that the files you need to select reside on the 
computer.

Publishing

This section describes the typical publishing steps of Component Select mode, and by 
referring you to the HPCA Administrator Publisher for Windows, provides detailed 
information about each screen that you encounter. Note that publishing in the HPCA 
Administrator Publisher for Linux and Macintosh are identical to publishing for Windows 
except for the delivery options. For Linux and Macintosh, the User Component and Machine 
Component options are not available, see Task 2 on page 182.

To publish in Component Select Mode

1 Log on as root.

2 To launch the HPCA Administrator Publisher run ./publishr from the location where 
you installed the HPCA Administrator.

3 Type your User ID and Password in the appropriate fields.

4 In the Type of data to publish drop-down box, leave the default choice of Component 
Select. (This is the only publishing mode currently available for UNIX and Macintosh.)

5 Click OK. The Select window opens.

The default user ID and password are:

User ID: ADMIN

Password: secret
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Task 1: Select Files to Publish

Use the Select files to publish window to select all files that you want to include in the 
package. This process is the same as it is for the HPCA Administrator Publisher for Windows. 
For details, see Select Files to Publish on page 49.

Task 2: Edit File Properties and Methods

Use the Edit window to edit file and folder properties and methods. This process is the same 
as it is for the HPCA Administrator Publisher for Windows, except for Delivery Options. For 
the Linux and Macintosh version of the HPCA Administrator Publisher, the User Component 
and Machine Component options are not available.

For similarities, see Edit Properties and Methods on page 50.

Task 3: Enter Package and Service Information

Use the Configure window to name the package and include additional descriptive 
information as well as set package deployment limitations based on hardware and operating 
system settings. Use the Service Information window to enter descriptive information about 
the service, and information about how it will be managed after it is deployed. These 
processes are the same as they are for the HPCA Administrator Publisher for Windows, 
except for the options in the Class drop-down list. For Linux the only class available is 
UNIXFILE, and for Macintosh, the only class available is MACFILE.

For similarities, see Enter Package and Service Information on page 56.

Task 4: Publish the Package

Use the Publish window to view the package and service information and then to publish it. 
This process is the same as it is for the HPCA Administrator Publisher for Windows. For more 
information, see Publish the Package on page 59.
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UNIX File Resources (UNIXFILE)

During the publication process, the UNIXFILE attributes are defined. These attributes define 
the owner and group associations and permissions of each published resource. Each package 
published has a corresponding UNIXFILE instance in the PRIMARY File.

Use HPCA Administrator CSDB Editor to view and modify the attributes in UNIXFILE and 
MACFILE class.

To view UNIXFILE Class instances using HPCA Administrator CSDB Editor

You can also use the following steps to view MACFILE class instances.

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor.

The CSDB Editor Security Information dialog box opens.

2 If necessary, type a User ID and Password, and then click OK.

3 Double-click PRIMARY.

4 Double-click SOFTWARE.

5 Double-click Unix File Resources (UNIXFILE).

6 Double-click the appropriate application. The attributes for the UNIXFILE instances for 
that application appear in the list view.

To change any instance attribute, double-click the attribute name in the list view. Make 
changes in the box that opens, and click OK.

Published Owner, Group, and Permission Considerations

The UNIXFILE Class contains the attributes ZPERUID and ZPERGID. They define the user 
ID and group association of the promoted resource. These attributes are populated during the 
publishing session and reflect the user ID and group association of the resources being 

If publishing is performed from Macintosh operating system, the package is published to Mac 
File Resources (MACFILE) class in HPCA Administrator CSDB Editor.

The following instructions use the HPCA Administrator CSDB Editor. The HPCA 
Administrator CSDB Editor is currently available for 32-bit Windows platforms. 
For more information, see HPCA Administrator CSDB Editor on page 131

The default user ID and password are:

User ID: ADMIN

Password: secret

To view MACFILE class, Double-click Mac File Resources (MACFILE).
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promoted. In addition, permission characteristics are captured during publishing and stored 
in the UNIXFILE.ZRSCRASH attribute. These attributes can be changed using the HPCA 
Administrator CSDB Editor.

If the HPCA Agent is run as a non-root user ID:

• All deployed resources will be associated with the user ID and group of the user ID who is 
running the HPCA Application Manager.

• During publishing, the owner and group of the resource is stored in the UNIXFILE 
instance data. The owner and group attributes within the instance are only applied if the 
HPCA agent is run as root for only root has the ability to perform changes in owner and 
group characteristics.

• HPCA agent capabilities are limited to the permission constraints of the current user ID 
and group membership for the user ID running the connect.

• HPCA will be unable to deploy to directories where the directory permissions prohibit the 
non-root user and or group membership to write.

• HPCA may be unable to set permissions on resources placed under HPCA Management 
that are already on the agent workstation though owned by a different UID and/or GID.

• HPCA will be unable to launch agent methods requiring root authority.

If the HPCA Application Manager is run as root and:

• If the owner name of the resource, as defined in ZPERUID, and the user ID exist on the 
agent workstation, the resource will be owned by the user ID specified.

Table 47 Attributes exclusive to the UNIXFILE Class

Attribute Description

ZPERUID User ID associated with the promoted resource. The resource 
will be owned by this user ID when deployed, providing the 
HPCA Application Manager is run by root and the user ID 
exists on the agent workstation.

ZPERGID Group ID associated with the promoted resource. The 
resource will be associated with this group when deployed, 
providing the HPCA Application Manager is run by root and 
the group exists on the agent workstation.

ZRSCRASH This should be a four-digit octal notation of the managed 
resources permissions (example: 7555). This is populated 
during the publishing session based on the characteristics of 
the published resources.

DIRPERMS Permissions assigned to unmanaged folders that are created 
when the directory structure does not exist. HPCA assigns 
permissions based on umask settings if this attribute is not 
defined.
For example, if the managed file file.txt is placed in /
opt/newlocation, and the directory /newlocation does 
not exist, it will be created. This is an unmanaged directory.
If more than one file is installed to a new location, the first 
one installed determines the assigned permissions.
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• If the group name of the resource, as defined in ZPERGID, and the group exist on the 
agent workstation, the resource will be associated with the group specified.

Native Packaging

Native Packaging is a feature of the HPCA Batch Publisher specifically designed for Linux 
environments. Native Packaging is installed during the regular installation of the HPCA 
Batch Publisher on a Linux system.

Native Packaging explores Linux native software depots, searches for available native 
packages, and publishes wrapped native packages to the Configuration Server. Native 
Packaging publishes all the information that you need for immediate installation of native 
software to end agents. When the HPCA Application Manager agent is installed, a Tcl script 
is included in the IDMSYS directory that is required when packages that are published using 
Native Packaging are deployed. For more information, see the HP Client Automation Batch 
Publisher Installation and Configuration Guide.

To prevent security breaches please note the following:

If the owner of a resource, as defined in ZPERUID, does not exist on the agent 
workstation, the owner designation of the managed resource will be set to 
"nobody" (uid 60001).

If the group of a resource, as defined in ZPERGID, does not exist on the agent 
workstation, the group designation of the managed resource will be set to "nobody" 
(gid 60001).

The HPCA Batch Publisher is an optional feature available from HP. Contact your 
sales representative for more details.
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6 Troubleshooting
This chapter describes common problems in the HPCA Administrator and the possible 
resolution to these problems.

Packages can have connection to FILE and PATH instances that do no exist

Issue

Published packages that only contain registry keys can have connection to the FILE and 
PATH instances that do not exist.

Cause

The HPCA Administrator Publisher populates the FILE and PATH instances even though 
there are no connections specified for the FILE and PATH instances.

Possible Resolution

This issue does not affect the deployment of the packages. You can safely ignore this issue.

Publishing Windows Installer file using HPCA Administrator Publisher takes long time to respond.

Cause

A large number of files are present in the same directory location as the Windows Installer 
file that you want to publish.

Possible Resolution

Place the Windows Installer file in a separate location along with the additional files that you 
want to package.
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A Modifying Component Instances
(Non-Production only)
This appendix explains how to dynamically edit the distributed contents of a file from within 
HPCA Administrator CSDB Editor.

The following figure shows the shortcut menu commands for component modifications.

Figure 36 Instance shortcut menu

HP does not support this feature in production environments, and assumes no 
responsibility if a customer uses this feature where packages are actively being 
deployed to agents in a production environment. Using this feature in such an 
environment would likely result in massive distributions of unnecessary package 
updates, since HPCA would detect a package change and automatically distribute 
the change to all authorized agents.
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When to Use these Commands

Examples of when you might want to use this option to modify component instances are listed 
in the following table.

Accessing the Add, Edit, and Replace Component Commands

The following setting is available on the Advanced tab of the Options dialog box: Show Add 
Edit and Replace Options for File type components.

Figure 37 Advanced tab of the Options window

Table 48 When to use the Advanced Edit Component commands

Command Typical use

Edit this 
Component

Change a serial number deployed with a file.
Edit the contents of a readme file, document, spread 
sheet, logo image, or PDF.

Replace 
Component 
Data

Replace the entire contents of an existing file in a 
package with contents of another file outside of CSDB.

Add a 
Component

Add a new file instance to a package, using another 
packaged file as a template.
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For non-production environments only, select Show Add Edit and Replace options for File type 
components to enable these commands on the shortcut menu for applicable instances.

When you select this option the Instance shortcut menu opens, see Figure 36 on page 189.

Editing a Component

The Edit this Component option permits you to select an editor of your choice with which to 
dynamically modify the distributed contents of a file instance. After you save the changes to 
the file, the modified file is sent (re-promoted) to the Configuration Server and the instance in 
the CSDB is updated.

For example, you can edit the distributable contents of any component instance that has been 
packaged and is represented in the HPCA Administrator CSDB Editor. You must save the 
edited file with the same name as the original file. The modified file immediately replaces the 
existing file in the package. The HPCA Administrator CSDB Editor takes care of the 
publishing for you, saving you from having to republish the package.

The original component’s contents are not retained in the HPCA Administrator CSDB Editor.

For information on creating and promoting packages to the CSDB, see HPCA Administrator 
Publisher on page 45.

HP does not support this feature in production environments, and assumes no 
responsibility if a customer uses this feature where packages are actively being 
deployed to agents in a production environment. Using this feature in such an 
environment would likely result in massive distributions of unnecessary package 
updates, since HPCA would detect a package change and automatically distribute 
the change to all authorized agents.

HP does not support this feature in production environments, and assumes no 
responsibility if a customer uses this feature where packages are actively being 
deployed to agents in a production environment. Using this feature in such an 
environment would likely result in massive distributions of unnecessary package 
updates, since HPCA would detect a package change and automatically distribute 
the change to all authorized agents.
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To edit a component

1 In the HPCA Administrator CSDB Editor, go to Options → Advanced tab, and select Show 
Edit Replace and Add Component options for File type components.

2 Locate the file instance that belongs to the software package whose contents you want to 
change in the CSDB.

3 Right-click the instance in the tree view. A shortcut menu opens.

The following figure shows an example of the shortcut menu for the Amortize.TXT 
readme file instance within the Amortize Platforms package. It includes the commands: 
Edit this Component, Replace Component Data, and Add a Component.

4 Select Edit this Component from the shortcut menu. The Editor Selector for 
AMORTIZE.TXT dialog box opens.

Use this dialog box to select the resident editor you want to use to make the changes to 
this file. For example, double-click Notepad to open the AMORTIZE.TXT file with 
Notepad.exe. The Editor Selector dialog box opens.

For details on using this dialog box, see Using the Editor Selector Dialog Box on page 193.

The component editor does not know a component's target operating system. 
Before you edit an instance, HP recommends that you note or export the values of 
the following attributes, as well as any other attributes, whose values should not 
change due to your edits:

ZRSCMMEM (PDS Member Name)

ZRSCCRC (Resource CRC)

ZRSCPADM (PDS AdminID)

ZPUBVER (Packager/Publisher Version)

If the values of these attributes change as a result of the editing process, HP 
recommends that you restore the original values.

For example, if a component is targeted for a Windows operating system, the 
ZRSCMEMM, ZRSCCRC, and ZRSCPADM attributes do not apply and should be 
null. After editing a component, if these attributes show values other than null, 
you should clear the inserted values. Likewise, the values for other attributes, 
such as ZPUBVER, should remain unchanged due to an edit. If changed, restore 
ZPUBVER to its original value.
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5 Double-click an editor from the Editors list box. The selected editor is launched and 
opens the previously selected file component instance.

6 Make the required changes to the file’s contents and save it with the same name.

7 Close the editor.

8 If necessary, click OK to close the Editor Selector dialog box and save the changes to the 
instance.

9 The File Re-Promote dialog box opens, and requests a confirmation that you want to 
commit the changes to the selected instance in the database.

— Click Yes to save the changes, perform a mini-publish and re-promote the changed file 
to the database.

— Click No to cancel the edits and the edit session. No changes are made to the database 
instance.

After you commit the changes, the instance attributes for ZRSCDATE ZRSCTIME, and 
ZRSCSIZE reflect the edited file size and date.

Using the Editor Selector Dialog Box

Use the Editor Selector dialog box to select a resident editor with which to edit the named 
file.

If you save the file with a different name, the HPCA component editor cannot 
make the changes to the file you selected from the HPCA Administrator CSDB 
Editor.

HP recommends that you compare all attributes' values against their original 
ones, and restore any values that changed unnecessarily. For example, you might 
need to clear values from OS-related attributes whose values were originally null. 
For details, see the cautionary text at the beginning of this procedure on page 268.
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To select an editor, choose an entry from the Editors list, or click Association to use the 
Windows default editor associated with file’s extension.

To add, delete, or rename the editors displayed in the Editors list, use the top three buttons 
on the right.

Figure 38 Editor Selector dialog box to edit a component

The following table summarizes the Editor Selector dialog box button actions.

Table 49 Editor Selector Dialog Box Buttons

Button Action

Browse/Add Opens a File Browse dialog box that you can use to select a 
program to add to the list of editors. Adds an entry from the 
Browse dialog box to the Editors list below the highlighted 
entry.

Delete Deletes a selected (highlighted) program from the Editors 
list.

Info/
Rename

For the selected editor program, opens a dialog box that 
displays the editor’s program name and path, and allows you 
to assign a friendly name to display on the Editors list.

OK Opens the selected file, named in the title bar, with the 
highlighted editor.
Alternatively, you can double-click on the Editors list-box 
entry.

Association Opens the selected file, named in the title bar, with the 
default editor associated with that file type through 
Windows. If no association is available, you will be returned 
to the Editor Selector dialog box where you can specify an 
editor or cancel.

Cancel Cancels the Edit a Component command without making 
any changes to the selected component or package.
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Replacing Component Data

Use the Replace Component Data command to replace the entire contents of a packaged 
file with the contents of a file that exists outside the database. For example, if there is a new 
Readme.TXT, and you want to completely replace its contents, prepare a revised Readme.TXT 
file outside of the HPCA Administrator CSDB Editor. Then, use the Replace Component 
Data command from within the HPCA Administrator CSDB Editor to replace the contents of 
the existing Readme.TXT with the new one. When you use the Replace Component Data 
command, none of the properties of the packaged file changes, just its distributed contents.

To replace [all] component data

1 Prepare a file outside of HPCA Administrator CSDB Editor whose contents represent the 
replacement data for a packaged component file in the CSDB. The prepared file can have 
any name.

2 In the HPCA Administrator CSDB Editor, navigate to Options → Advanced tab, and select 
Show Edit Replace and Add Component options for File type components.

3 Locate the file instance in the software package whose data you want to replace in the 
CSDB.

4 Right-click the instance in the tree view. A shortcut menu opens.

The following figure shows an example of the shortcut menu for the Amortize.TXT 
readme file instance within the Amortize Windows Platforms package. It includes the 
commands: Edit this Component, Replace Component Data, and Add a 
Component.

5 Select Replace Component Data from the shortcut menu.

A standard Windows Open dialog box opens.

HP does not support this feature in production environments, and assumes no 
responsibility if this feature is used where packages are actively being deployed to 
agents in a production environment. Using this feature in such an environment 
would likely result in massive distributions of unnecessary package updates, since 
HPCA would detect a package change and automatically distribute the change to 
all authorized agents.

The entire contents of the prepared file will replace the entire data contents of the 
file selected from the HPCA Administrator CSDB Editor using the Replace 
Component Data command. Verify the contents of the files prior to continuing 
with this procedure.
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6 Navigate to the prepared file whose contents will replace the data for the file you selected 
from the HPCA Administrator CSDB Editor.

7 Click Open to select the file with the replacement data. A confirmation message opens.

8 Click Yes to replace the data; click No to abort the data replacement.

If you click Yes, the HPCA Administrator CSDB Editor substitutes the entire contents of 
the data to be distributed with the selected file’s data, and republishes the package.

The instance attributes for ZRSCDATE, ZRSCTIME, and ZRSCSIZE reflect the new file 
size and date, as previously illustrated.

If you click No, the replacement command is cancelled.

Adding a Component

The Add a Component command is available for file and behavior components only. Files 
always belong to an owning package, so the most likely place to perform an Add is from the 
connection under a package. New files can be added by copying the properties of an existing 
published file; files cannot be created from scratch, that is, from files that have not been 
promoted from the HPCA Administrator Packager.

New files are added by selecting an instance to use as a template. The HPCA Administrator 
CSDB Editor will derive the path for the new instance from the template’s LOCATION 
variable. After a template is selected, right-click it to display the shortcut menu and select 
Add Component. An Open File dialog box opens where you can select the file you want to add 
to your package. A final confirmation box will enable you to stop the process if you need to. 
Click Yes in the box to promote the file that was selected in the Open File dialog box. The 
package now contains the new file.

To add a component to a package

1 In the HPCA Administrator CSDB Editor, navigate to Options → Advanced tab, and select 
Show Edit Replace and Add Component options for File type components.

2 Locate a file instance in the software package whose LOCATION can serve as a template 
for the component to be added.

3 Right-click the template file’s instance in the tree view. A shortcut menu opens.

HP does not support this feature in production environments, and assumes no 
responsibility if this feature is used where packages are actively being deployed to 
agents in a production environment. Using this feature in such an environment 
would likely result in massive distributions of unnecessary package updates, since 
HPCA would detect a package change and automatically distribute the change to 
all authorized agents.
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The following figure shows an example of the shortcut menu for the Amortize.TXT 
readme file instance within the Amortize Windows Platforms package. It includes the 
commands: Edit this Component, Replace Component Data, and Add a 
Component.

4 Select Add a Component from the shortcut menu. A standard Windows Open dialog box 
opens.

5 Navigate to the prepared file you want to add to the package.

The following figure shows an example of navigating to a prepared file named 
AMORTIZE2.TXT. In this case, we want to add this component to the package.

6 Click Open to select the file to be added with the same LOCATION as the template file. A 
confirmation message opens.

7 Click OK or Cancel.
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If you click OK, the CSDB Editor promotes the added file and republishes the package. 
The instance attributes for the added file’s LOCATION reflect the template file’s location.

If you click No, the Add a Component command is cancelled.
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B Naming Conventions
This appendix discusses the use of naming conventions to help you organize the software 
stored in the Configuration Server Database (CSDB).

When publishing applications, subscribers may have different requirements such as:

• Different operating systems.

• Different amounts of free space on their hard drives.

• Different processors, memory, and so on.

• Different data or applications, depending upon their job function or other factors.

Due to these varying requirements, you might need to create several packages for a single 
application. To keep your data organized in the CSDB, HP recommends that you create a 
naming convention to be used within your organization. 

This section provides some recommendations that you can use as a starting point to create 
your own standards.

Categorizing Information

In general, consider using unique high-level identifiers with an underscore (_) to categorize 
information in the CSDB. HPCA Administrator CSDB Editor groups instances based on the 
identifier that precedes the underscore.

For example, if you had a Windows XP version and a Windows Server 2003 version of an 
application to calculate loan amortizations, you might name the packages AMORTIZE_XP 
and AMORTIZE_2003.

If you decide to use a high-level identifier without an underscore (_), you can use 
the HPCA Administrator CSDB Editor's filtering capabilities to display only the 
instances with that identifier.
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Naming Conventions for the POLICY Domain

HP recommends that you use a variation of the following standards. When naming instances 
in a workgroup, use information that groups your subscribers appropriately. For example, if 
your company is organized by division and location, you might use conventions such as the 
following:

Naming Conventions for the SOFTWARE Domain

In a company organized by division and location, you might organize your data using the 
following standards.

Table 50 Naming conventions for the USER Class

Format Description Example

USERID Identifies the subscriber. SJones

DIV_LOC_DES
C

Defines ownership or 
assignment.

CTS_CLE_EVERYONE

DIV Identifies the division. CTS (Corporate 
Technology Services)

LOC Identifies the location. CLE (Cleveland)

DESC Provides additional 
description of the group.

EVERYONE (all users)

Table 51 Naming Conventions for the PACKAGE Class

Format Description Example

DIV_LOC_APPN
AME_VER_OS

Defines the application. CTS_CLE_WINZIP_80_XP

DIV Identifies the division. CTS (Corporate Technology 
Services)

LOC Identifies the location. CLE (Cleveland)

APPNAME Identifies the application. WINZIP

VER Identifies the version of 
the application.

80

OS Identifies the operating 
system that the 
application runs on.

XP
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Determining the conventions that make sense for your organization may take some time. 
However, creating a convention up front and communicating it to all of your Administrators 
will keep you organized in the future.

Table 52 Naming Conventions for Delivery and Auditing Classes

Format Description Example

REG_DIV_LOC_APPNAME_
VER_OS

Defines the application. NAM_CTS_CLE_WINZIP

REG Identifies the region. NAM (North America)

DIV Identifies the division. CTS (Corporate Technology 
Services)

LOC Identifies the location. CLE (Cleveland)

APPNAME Identifies the application. WINZIP
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C Creating Users and Groups in Configuration 
Server Database
Creating Users and Groups

There may be times when you need to create individual users or groups in HPCA. For 
example, you might want to create a lab environment that is used to test the distribution and 
management of your data. To create a simple environment, create several users, assign them 
to groups, and then assign services to the groups.

In this section, you will learn how to create a user in the USER Class of the POLICY Domain. 
You can follow the same steps to create a new WORKGRP or DEPT instance by substituting 
the appropriate Class name.

In the following example, you will use the HPCA Administrator CSBD Editor to create a new 
user (SSampson) in the USER Class.

To create a new user

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. The HPCA Administrator CSDB 
Editor window opens.

3 Double-click PRIMARY.

4 Double-click POLICY.

5 Right-click Users (USER).

6 Select New Instance.

7 In the Create Instance dialog box, type a display name (up to 25 characters) and an 
instance name (up to 25 characters).

8 Click OK.

The user instance, SSampson, is created.

The default user ID and password are:

User ID: ADMIN

Password: secret
203



Assigning Users to Groups

If you created several users, you might want to assign them to one or more groups. In the 
following example, we will use the HPCA Administrator CSDB Editor to assign the user 
SSampson to the Sales department.

To assign a user to a group

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. The HPCA Administrator CSDB 
Editor window opens.

3 Double-click PRIMARY.

4 Double-click POLICY.

5 Double-click Users (USER) to open the list of all user instances.

6 Right-click the user instance (in this example, SSampson) and select Show Connections 
from the shortcut menu.

The Sales instance, shown in the Departments (DEPT) Class, might not appear in 
your Configuration Server Database. To add this instance (or instances that are 
appropriate to your organization), follow the procedure To create a new user on 
page 203. However, instead of right-clicking USER, right-click the appropriate 
Class, such as Departments (DEPT).

The default user ID and password are:

User ID: ADMIN

Password: secret
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The POLICY.USER Connections dialog box opens and displays a list of classes to 
which you can connect the selected instance.

7 Select Departments (DEPT), and then click OK.

The DEPT Class instances appear in the list view. This allows you to easily make a 
connection between an instance in the DEPT Class and an instance in the USER Class.

8 Select the Sales instance from the list view and drag it to the appropriate USER instance 
(in this example, SSampson). When your cursor turns into a paper clip, release the mouse 
button. The Select Connection Attribute dialog box opens.

9 Click Copy to create the connection from Users.SSampson to Department.Sales.

10 Click Yes to confirm the connection.

11 Click OK when you receive the confirmation that “SSampson has been connected to Sales.”

SALES is now listed under the SSAMPSON user instance, indicating that SSampson is 
part of the Sales department.

Connecting Services to Groups

Whether you are using an external policy source or managing policy within HPCA, you will 
need to define the services that your subscribers will receive.

In this section, you will learn how to connect users and groups to the services that HPCA will 
manage. In the following example, we will use the HPCA Administrator CSDB Editor to 
authorize the WinZip application for all users in the Sales department.

If you are using the Policy Server, see the HP Client Automation Enterprise Policy 
Server Reference Guide.
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To connect the WinZip application to the Sales department

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. The HPCA Administrator CSDB 
Editor window opens.

3 Double-click PRIMARY.

4 Double-click POLICY.

5 Double-click Departments (DEPT) to open the Departments Class.

6 Right-click the Sales instance (in the tree view) and select Show Connections.

The POLICY.DEPT Connections dialog box opens. This dialog box displays a list of 
classes to which you can connect the selected instance.

7 From the Show connectable classes for domain drop-down list, select SOFTWARE.

8 Click Application (ZSERVICE), and then click OK. The instances in the ZSERVICE Class 
appear in the list view.

9 Select the WinZip Instance from the list view and drag it to the appropriate Departments 
instance (in this example, Sales). When your cursor turns into a paper clip, release the 
mouse button. The Select Connection Attribute dialog box opens.

10 Click Copy to create the connection from DEPT.SALES to Application.WinZip.

11 Click Yes to confirm the connection.

12 Click OK when you receive the confirmation that “Sales has been connected to WinZip.”

In the image that follows, note the following:

— WinZip is listed under DEPT.SALES, which indicates that the entire Sales 
department is authorized to receive the WinZip application.

— SSampson is listed under the USER Class, as is the SALES Instance, indicating that 
SSampson is part of the Sales department.

The default user ID and password are:

User ID: ADMIN

Password: secret
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Therefore, based on these two conditions, HPCA will manage the WinZip application on 
SSampson’s computer.

Whether you are using an external policy store, or managing policy within HPCA, you can 
quickly modify the services that individuals are authorized for by manipulating the 
connections between services and groups, adding users to groups, or removing users from 
groups.
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D Creating Services Using Advanced Capabilities
Configuring Applications in the Machine/User Context

Your enterprise might require that applications be configured to accommodate multiple users, 
or that one computer always has available the same applications regardless of the user. A 
service might be considered multi-context if it has components to be installed in the machine 
context and in the user context.

In order to complete the installation of a multi-context service, the HPCA agent computer will 
need to connect to the Configuration Server twice: once to install the machine components 
and once to install the user components. The machine components are installed first. If the 
machine portion does not successfully complete, installation of the user component will not 
take place. The machine portion can be invoked through Notify and timers. The user portion 
should be embedded in a logon script, desktop shortcut, or batch file that is local to the user.

Complete the following steps to configure your service for machine or user installations.

• Use either HPCA Administrator Publisher or HPCA Administrator CSDB Editor to 
specify whether a package component is to be installed in the User or Machine context. 
For instructions, see Setting the Context of Components.

• Use HPCA Administrator CSDB Editor to configure your service to deploy under either 
the system or user account. See Setting the Service Mode on page 150.

• Use HPCA Administrator CSDB Editor to set the deployment methods for the service. See 
Deploying a Machine/User Service on page 153.

Setting the Context of Components (ZCONTEXT)

Use HPCA Administrator Publisher to select machine and user components separately. Set 
the context of a component using either HPCA Administrator Publisher during the publishing 
process, or using HPCA Administrator CSDB Editor after the publishing process.

To set the context in HPCA Administrator Publisher

1 Right-click the files or directories and select Set Properties. The Instance Properties 
dialog box opens.

2 In the Agent Management tab select the appropriate context for the component.

If you have already completed the publishing process, use HPCA Administrator CSDB Editor 
to set the ZCONTEXT attribute in the component’s instance.

This is a feature of HPCA Application Manager agent.

To take advantage of the Machine/User context, previously packaged applications 
must be repackaged.
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To set the context in HPCA Administrator CSDB Editor

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. The HPCA Administrator CSDB 
Editor window opens.

3 Double-click PRIMARY.

4 Double-click SOFTWARE.

5 Double-click Application Packages (PACKAGE).

6 Double-click the component’s class.

7 Double-click the component.

8 Double-click ZCONTEXT.

9 Type the appropriate value based on the information in the following table.

10 Click OK to complete the changes.

11 Click Yes to confirm the changes and return to HPCA Administrator CSDB Editor.

Now that you have set the component’s context, specify that the ZSERVICE instance for the 
application has machine and user components.

The default user ID and password are:

User ID: ADMIN

Password: secret

Table 53 Component Context (ZCONTEXT) options

Setting Explanation

blank Leave ZCONTEXT blank if the component is independent of 
context. This component is installed during machine and user 
connects.

U Type U to indicate that this component will be deployed only to 
the user logged on when the application is initially deployed.

M Type M to indicate that the file should be deployed to all users of 
the computer.

User 
Specified

This option is for future use.

As a rule, the component will be processed if its ZCONTEXT attribute matches the 
value of the context parameter in the RADSKMAN command line or if the 
component’s ZCONTEXT attribute is blank.
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Setting the Service Mode (ZSVCMODE)

The ZSVCMODE attribute in the ZSERVICE class is used to determine if the machine/user 
context is relevant to the package’s deployment. If you need to create the ZSVCMODE 
attribute, add it to the class template for the ZSERVICE class. Create it as a variable of 
length 3. Accept the other default properties. The possible values are M, U, MU, blank, and 
EMU.

HP recommends you back up the CSDB prior to making class template changes.

Table 54 Values for ZSVCMODE in the ZSERVICE Class

Value Explanation

Blank Use this when you want the components to install whether the 
client is logged on in the machine or user context. The 
application will only be installed using the available context.

EMU Enhanced Machine/User service:
If the HPCA agent connect is being made in the user context, but 
the machine side of the application has not yet been installed, 
this will force the machine connect. After the machine connect 
completes successfully, the user connect is initiated to install the 
user components.
Use this for optional applications that the user controls through 
HPCA Application Self-service Manager.
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To set ZSVCMODE in ZSERVICE

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. The HPCA Administrator CSDB 
Editor window opens.

3 Double-click PRIMARY.

4 Double-click SOFTWARE.

5 Double-click Application (ZSERVICE).

EMU:AD=N Enhanced Machine/User service:
If the HPCA agent connect is run in the user context, but the 
machine side of the application are not yet installed, this will 
force the machine connect. After the machine connect completes, 
the user connect is initiated to install the user components.
Use this for optional applications on a shared computer that the 
user controls through the Application Self-service Manager. The 
addition of AD=N prevents a user from being able to remove the 
machine components of the application. Other users of the agent 
computer may still need the machine components of the 
application. The valid application events are:
AI  = application install
AD = application delete
AU = application update
AR = application repair
VA = version activation
VD = version deactivation
The default for each event is Y. Separate multiple events with a 
comma.

M Machine service only
Set ZSVCMODE to M if the service has only machine 
components. This service will be ignored if context is set to u on 
the RADSKMAN command line.

MU Machine/User service
Set ZSVCMODE to MU if the service has both machine and user 
components. The user connect will verify that the machine 
components have been installed before installing the user 
components. The user components will not be installed if the 
machine components are not present.

Table 54 Values for ZSVCMODE in the ZSERVICE Class

Value Explanation

The default user ID and password are:

User ID: ADMIN

Password: secret
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6 Double-click the appropriate service.

7 Double-click ZSVCMODE in the list view.

8 Type the appropriate values based on the values discussed in Table 54 on page 211.

9 Click OK to complete the changes.

10 Click Yes to confirm the changes and return to HPCA Administrator CSDB Editor.

Enhanced Machine and User Services for HPCA Application Self-service Manager

When an application has machine and user components, HPCA Application Self-service 
Manager agent needs elevated privileges on the HPCA agent in order to properly install 
machine components, and the user components need a user logged on to access the user’s 
settings. A machine component might be a file or registry key while a user component might 
be a desktop shortcut. If context is set to U, the user will not be able to install the machine side 
of the application, and the user connect will fail. By setting ZSVCMODE to EMU, when the 
user selects the application to install, HPCA Application Self-service Manager agent will 
check to see if the machine components are already installed. If they are not, HPCA 
Application Self-service Manager agent will install the machine components for that service 
only, and then, install the user components. In other words, two separate HPCA agent 
connects will run, one in machine context and one in user context. Set the CONTEXT tag to U 
in the args.xml file to enforce EMU behaviors.

If ZSERVICE.ZSVCMODE is set to EMU, and HPCA Application Self-service Manager agent 
encounters a service that is marked as EMU, it first checks to see if the machine catalog 
exists, and if the requested service exists in the machine catalog:

• If the service exists, and is marked installed in the machine catalog, the service is 
installed for the user.

• If the service is not installed on the machine side, but the catalogs are synchronized, then 
the client will first install the machine side of the service and then install the user piece of 
the service.

• If the machine catalog is missing (because a machine connect never ran), then the client 
gets the machine catalog, and installs the service on the machine side. Then, if the service 
was successfully installed on the machine side, the user side of the service will be 
installed.

Deploying a Machine or User Service

The HPCA agent will need to connect to the Configuration Server twice to complete the 
installation of services that are marked with ZSVCMODE set to MU. The first connect will be 
in the machine context. In the RADSKMAN command line, add a parameter context=M. This 
will set the startdir=SYSTEM by default. Do this by using either a Timer or a Notify 
command.

The second connection will install the user components. Do this in a logon script, batch file, or 
desktop icon since the user needs to be logged on. Use the RADSKMAN command line with 
context=U parameter. If ZSVCMODE is MU, the user components will only be installed if the 
machine connect has finished successfully.

ZSVCMODE must be changed to 3 bytes and EMU must be one of the choices.
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Service Groups

HPCA manages products that require more than one service-package to establish full product 
installation or operation. You can use Service Groups when a product requires other 
service-packages or has dependencies on other services.

This includes MSI-packaged products where:

• A product can use more than one MSI service-package. For example, if MS Office requires 
other language-pack services.

• A large product, such as MS Office, needs to be split into smaller sub-services in order to 
install only specific parts of the product suite.

HPCA Application Self-service Manager interface will display only the master service.

For detailed information on creating Service Groups, see Service Groups on page 136.

Restarting the HPCA Agent Computer

You might need to restart an HPCA agent computer based on an application event. To do this, 
specify a reboot type and reboot modifiers in the ZSERVICE.REBOOT attribute. The 
modifiers allow you to:

• Set the type of warning message.

• Handle a reboot with either a machine or user connect.

• Cause an immediate restart after the application event.

First, specify the application event that needs the reboot. Table 55 on page 215 lists the codes 
for all possible application events. Set the application event code to a reboot type and any 
reboot modifier that you need to use. The sections below describe each type of reboot and all 
reboot modifiers.

If you need an application to immediately perform a hard reboot with no warning messages on 
application installation and repair, set ZSERVICE.REBOOT to AI=HQI, AR=HQI.

If the hreboot parameter is missing from the RADKSMAN command line, the 
parameter defaults to Y to handle service reboot requests. If hreboot = p, the 
HPCA agent computer will power down, regardless of whether there is a service 
requiring a reboot.

The parameters for the reboot attribute are not case-sensitive.
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Reboot Types

After deciding which application events need a reboot, choose the type of reboot. HPCA sends 
a message to the operating system that the computer needs to reboot. There are three types of 
reboot.

• Hard Reboot (H)
All applications are shut down regardless of whether there are open, unsaved files or not. 
The subscriber will not be prompted to save open, modified files.

• Soft Reboot (S)
Users are prompted to save their data if applications have open, unsaved files. If 
applications have unsaved data, the reboot will wait for the user to respond to the 
application’s request for the user to save his data.

• No Reboot (N) (default reboot type)
The computer will not restart after completing the specified application event. This is the 
default reboot type for all application events except a Locked File Event (AL). If you 
specify AL=N, the agent computer will not perform a hard reboot with an OK and Cancel 
button when a locked file is encountered. If no restart type is specified for an application 
event, no restart will occur.

Reboot Modifier: Type of Warning Message

You can specify the type of warning message you want to send to the subscriber before the 
restart occurs. If you specify a type of reboot, but do not specify a type of warning message, the 
default warning message for that type will be displayed. There are three types of warning 
messages. Warning messages are displayed automatically for HPCA Application Self-service 
Manager and HPCA Application Manager used with the HPCA System Tray. If you do not 
want to show a warning message, specify ask=N in a RADSKMAN command line.

Table 55 Reboot Events and Codes

Application Events Code Description

Install AI Specifies a reboot behavior for application 
installations. The default is no reboot.

Deinstall AD Specifies a reboot behavior for application 
removals. The default is no reboot.

Locked File AL Specifies a reboot behavior when a locked 
file is encountered. The default behavior 
when a locked file is encountered is to 
perform a Hard reboot with just an OK 
button (HY).

Update AU Specifies a reboot behavior for application 
updates. The default is no reboot.

Repair AR Specifies a reboot behavior for application 
repairs. The default is no reboot.

Version Activation VA Specifies a reboot behavior for application 
version activations. The default is no 
reboot.
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• Quiet (Q)
No reboot panel will be displayed.

• OK Button (A)
A warning message will display with an OK button only. Clicking the OK button will 
initiate the reboot. The user will not be able to cancel the restart.

• OK and Cancel Button (Y)
Clicking the OK button will initiate reboot. If the user clicks Cancel, the reboot will be 
aborted.

Reboot Modifier: Machine and User Options

The HPCA agent can connect as a machine or as a user by specifying the context parameter 
on the RADSKMAN command line. Use the machine/user reboot modifier to specify if the 
reboot should complete based on the type of connect.

• Reboot on Machine connect (blank)
When a machine/user reboot modifier is not supplied, the default behavior will be to 
reboot on a machine connect only. This default behavior should satisfy the majority of 
reboot requirements.

• Reboot on User connect only (U)
The reboot will be honored on a user connect only where context=u in RADSKMAN or if 
the context parameter is not specified. The reboot will not occur where context=m in 
RADSKMAN.

• Reboot on both Machine and User connect (MU)
Reboot will only occur when both the machine and user components of the application are 
installed.

Reboot Modifier: Immediate Restart

You can modify each type of reboot by adding I (for Immediate). Use this when you want the 
computer to restart immediately after resolving the current service. HPCA will resolve the 
rest of the user’s services after the computer restarts. If you specify I but not H (hard) or S 
(soft) as the type of reboot, a hard reboot will be performed.

Specifying Multiple Reboot Events

If you have two services that require a reboot event on the same HPCA agent connect, the 
most restrictive reboot type and reboot panel will be used. The least restrictive reboot type is 
No Reboot (N), followed by Soft Reboot (S), and the most restrictive is Hard Reboot (H). The 
least restrictive reboot warning message supplies both an OK and Cancel button (Y), followed 
by an OK button only (A), and the most restrictive is completely quiet (Q).

You can specify a timeout value for the Warning message box by adding the 
RTIMEOUT value to the RADSKMAN command line. Set RTIMEOUT to the 
number of seconds you want the HPCA agent to wait before continuing with the 
reboot process.
216 Appendix D



Suppose a user is assigned to an application that needs a soft reboot with just an OK button 
on installation, AI=SA. The user is also assigned a second application that needs a hard 
reboot that displays both an OK and Cancel button, AI=HY. After all of the subscriber’s 
application events are completed, a Hard Reboot (H) with only an OK button displayed (A) 
will be performed.

Preparing Versioned Applications

Typically, when you deploy an application to an HPCA agent computer, using either HPCA 
Scheduler or HPCA Notify, it is activated immediately. There is another option, Version 
Groups, which enables you to roll out a new version of an application to users; it gives you 
the options of having it activate upon delivery or at a pre-determined time. If the installation 
of the new version fails, HPCA will automatically roll back to the previous version. If 
problems occur in the new version after installation, you can deactivate the new version and 
roll back to the previous version for some, or all, users.

After versioning is configured, the compressed files are stored on the HPCA agent computer, 
and the versioning takes place. The roll forward/roll back can be entirely local, not requiring 
any data to be transferred at the version change time. It can also be configured to be partially 
local, with a minimum of data being transmitted.

Versioned vs. Non-versioned Applications

Versioned and non-versioned applications adhere to different connection models within the 
CSDB. For non-versioned applications, one Application instance (ZSERVICE) connects to one 
or more package instances.

Figure 39 CSDB path for non-versioned application deployments
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Versioned applications adhere to a different connection model than non-versioned 
applications. For versioned applications, an Application instance (ZSERVICE) connects to a 
single Version Group (VGROUP) instance.

The Version Group instance connects to one or more Version instances that connect to one or 
more Package instances. A Version instance (which represents one version of a software 
application) contains one HPCA package. Each HPCA package is represented in the CSDB by 
an instance of the PACKAGE Class.

Figure 40 CSDB path for deployments of versioned application

To prepare versioned applications

1 Use HPCA Administrator Publisher to package the application.

2 Right-click ZSERVICE class and select New Instance.

3 In the Create Instance dialog box, type a display name and an instance name, and click 
OK.

To finish creating the Version Group, see the following section, Version Group Editor.

Version Group Editor

Use Version Group Editor, in HPCA Administrator CSDB Editor, to create, edit, and delete 
instances for each version of an application, as well as manage the deployment of a version 
group. A version group contains all versions of an application.

If you want to use multiple Version Groups, you must create one service for each 
Version Group.
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To manage a versioned application, in the Version Group class create an instance that 
represents the set of versions for the application. Then, use the Version Group Editor to 
create instances for each version of the application.

Creating a Version Group

In the following example, we will use HPCA Administrator CSDB Editor to create a new 
instance in the Version Group (VGROUP) class.

To create a Version Group

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. The HPCA Administrator CSDB 
Editor window opens.

3 Navigate to PRIMARY.SOFTWARE, right-click Version Group (VGROUP).

4 Select New Instance. The Create Instance dialog box opens.

5 In the text field of the Create Instance dialog box, type a name (such as Amortize) for 
the Version Group, and click OK. The Editing Version Group dialog box opens.

Creating a Version Instance

Now that you have created a Version Group (VGROUP) instance, it is necessary to learn how 
to create an instance for each version of your application.

To create a version instance

1 In the Version Group Editor, click Add. The Create Version dialog box opens.

2 Type a suffix that identifies the version. For example, Version 1.

3 Click OK. The Version Editor dialog box opens.

The Version Editor dialog box contains a list of Application Package (PACKAGE) 
instances that are stored in the Configuration Server Database. Use this dialog box to 
connect the new Version (VERSION) instance to an Application Package (PACKAGE) 
instance. There is a one-to-one correspondence between these two instances.

4 Click the appropriate Application Package (PACKAGE) instance.

5 Click OK. The Version instance appears in the Unassigned Version list.

Add a Version instance for each version of the application that will be available to 
subscribers through this Version Group.

To delete a version instance

1 In the Version Group Layout list, select the version that you want to delete.

2 Click Delete.

The default user ID and password are:

User ID: ADMIN

Password: secret
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The instance for the version appears in the Unassigned Versions list. The icon is in a 
dimmed state, ready for deletion.

To restore the instance, click the instance in the Unassigned Versions list and then 
click Un-delete.

The version instance will not be deleted until you close the Version Group Editor.

3 Click OK to close the Version Group Editor.

Assigning Version Instances to the Version Group

After creating your Version instances, you must assign them to the Version Group.

To assign Version instances to the Version Group

In the Unassigned Versions list, click a Version instance and drag it over a connection 
labeled <no assigned version> in the Version Group Layout list.

Assign each of the Version instances that you created to the Version Group.

To remove a Version instance assignment

In the Version Group Layout, click a Version instance and drag it to the Unassigned Versions 
area. Then, release the mouse button.

Preparing a Version Group for Deployment

Now that you have created the Version instances and assigned them to your Version Group, 
you are ready to specify how you would like to deploy the versions. Use the Version Group 
Information area in the Version Group Editor to define the deployment of the versions.

To prepare a Version Group for deployment

1 In the Versioning Controlled By drop-down list, select:

— Manager if you want to control the version to be deployed.

— Client if you want the user to control the version to be deployed.

This is used with HPCA Application Self-service Manager only.

2 In the Initially Active drop-down list, select the version that you want to activate on the 
HPCA agent computer the next time the user connects to the Configuration Server.

You can also select from the versions that appear in the Version Group Layout list. The 
selected version appears in bold text in the Version Group Layout list, as shown in the 
next figure.

3 Select the Activate on or After check box to access additional controls that can be used to 
delay activation of a version until a specific date and time.

If you want the ability to schedule the version deployments with the Configuration 
Server you must select MANAGER from the Versioning Controlled By 
drop-down list.

If you select MANAGER in the Versioning Controlled By drop-down list, you 
must select the Activate On or After check box so that the Configuration Server 
knows when to activate the next version.
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4 In the Next Version to Activate drop-down list, select the version of the application 
that you want to activate after the initial version.

5 In the Time (hh/mm) drop-down list, select when you want the version to be activated.

6 Use the Calendar controls to set the date of deployment for the next version.

7 Click OK to save the information in the Version Group Editor.

8 Click Yes to confirm your changes.

The Version Group instance appears in the Version Groups (VGROUP) Class. If you 
scheduled the next version to activate, HPCA creates an instance in the Scheduling (TIMER) 
Class and automatically connects the timer to the Version Group.

To connect the Version Group to the Service

1 In HPCA Administrator CSDB Editor, navigate to PRIMARY.SOFTWARE.ZSERVICE.

2 Right-click the appropriate service (such as Amortize) and select Show Connections. The 
SOFTWARE.ZSERVICE Connections dialog box opens.

If you use the Time and Calendar controls to schedule the deployment of a version, 
consider the following:

• You can schedule deployments of versions only if the Configuration Server 
controls the versions

• If you selected MANAGER in the Versioning Controlled By drop-down list, 
you must select the Activate On or After check box to let the Configuration 
Server know when to activate the next version.

• If you delete a VGROUP instance, the associated TIMER instance will be 
deleted.
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3 Click Version Groups (VGROUP) and click OK.

The Version Group instances appear in the list view of HPCA Administrator CSDB 
Editor.

4 Click Amortize in the list view and drag it to the appropriate Application (ZSERVICE) 
instance (in this example, Amortize). When your cursor changes to a paper clip, release 
the mouse button. The Select Connection Attribute dialog box opens.

5 Click Copy.

6 Click Yes to confirm that you want to connect the Amortize Version Group to the Amortize 
service.

7 Click OK when you receive a confirmation message.

The next time the HPCA agent connects to the Configuration Server, the initial version of the 
application is activated and the compressed files for the next version will be stored on the 
HPCA agent computer.

Editing a Version Group

After you create a version group and its instances, you might want to return to the Version 
Group Editor to make changes.

To edit a Version Group

1 In HPCA Administrator CSDB Editor, navigate to the Version Group instance located in 
PRIMARY.SOFTWARE.VGROUP.

2 Right-click the appropriate Version Group instance and select Version Group Editor. The 
Version Group Editor opens.

3 Edit the Version Group as necessary.

4 Click OK to save your changes.

or

Click Cancel to close the Version Group Editor without saving your changes.

Be sure to connect the ZSERVICE instance to the POLICY instance for the 
subscribers to whom you want to deploy this.
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Version Group (VGROUP) Class

Each instance of the Version Group (VGROUP) Class defines a set of versions for an 
application, and contains connections to the Versions (VERSION) Class. The following table 
describes the VGROUP Class attributes.

Table 56 Version Group (VGROUP) Class Attributes

Attribute Description

ZSTOP00n In ZSTOP attributes, expressions that evaluate to true 
cause resolution of the instance to be skipped. If left blank, 
the instance is not skipped and resolution continues. This is 
useful for assigning a version to a set of users. Use HPCA 
Administrator CSDB Editor to set this attribute.

CONTROL Indicates whether the HPCA administrator (MANAGER) or 
the user (CLIENT) controls which version to activate on the 
HPCA agent computer. Use the Versioning Controlled By 
drop-down list in the Version Group Editor to set this 
option.
Note: HPCA agents support HPCA 
administrator-controlled version activation, but do not 
support subscriber-controlled activation.

INITIAL Indicates which version to activate on the HPCA agent 
computer. Use the Initially Active drop-down list in the 
Version Group Editor to set this option.

ROLLBACK Indicates whether to automatically roll back to the 
previously activated version when deployment of a new 
version fails. The default is Y.

REQACTDT The earliest date on which a version in this Version Group 
will be activated on any HPCA agent computer. If this 
attribute is blank, the version identified by the INITIAL 
attribute will be activated at the end of the HPCA agent 
connect that causes the version to be transferred to the 
HPCA agent computer. Use the calendar controls in the 
Version Group Editor to set REQACTDT.

REQACTTM The earliest time, on the date specified by the REQACTDT 
attribute, after which a version in the Version Group will be 
activated on any HPCA agent computer. The version 
identified by the INITIAL attribute will be activated during 
the next HPCA agent connect. Use the Time (hh/mm) 
drop-down lists in the Version Group Editor to set 
REQACTTM.

NAME The friendly name for the VGROUP instance. This is set 
when you create the instance using HPCA Administrator 
CSDB Editor.

ACTDATE This data is set and maintained, by the HPCA agent, in the 
VGROUP object on the HPCA agent computer. Do not alter 
its value.
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Versions (VERSION) Class

Each instance of the VERSION Class defines one version of an application to be deployed and 
managed by HPCA. Use the Version Group Editor to create VERSION Class instances and 
assign them to a Version Group. The following table describes the VERSION Class attributes.

STATUS This data is set and maintained, by the HPCA agent, in the 
VGROUP object on the HPCA agent computer. Do not alter 
its value.

CURVERS This data is set and maintained, by the HPCA agent, in the 
VGROUP object on the HPCA agent computer. Do not alter 
its value.

NEXTVERS This data is set and maintained, by the HPCA agent, in the 
VGROUP object on the HPCA agent computer. Do not alter 
its value.

SOURCE This data is set and maintained, by the HPCA agent, in the 
VGROUP object on the HPCA agent computer. Do not alter 
its value.

TIMERCON If you specify a “next version to activate,” HPCA 
Administrator CSDB Editor automatically creates a timer 
and stores the connection to that timer in this attribute.

VERCON0n Connects to each version in the Version Group. Each 
VERCON0n attribute contains a connection to one instance 
of the VERSION Class. This is set when you assign a 
version to the Version Group in the Version Group Editor.

Table 56 Version Group (VGROUP) Class Attributes

Attribute Description

Table 57 Versions (VERSION) Class Attributes

Attribute Description

ZSTOP00n In ZSTOP attributes, expressions that evaluate to true cause 
resolution of the instance to be skipped. If left blank, the 
instance is not skipped and resolution continues. This is 
useful for assigning a version to a set of users. Use HPCA 
Administrator CSDB Editor to set this attribute.

NAME The friendly name for the VERSION instance. This is set 
when you create the instance using HPCA Administrator 
CSDB Editor.

PACKAGE Connects to a PACKAGE Class instance, which represents 
the packaged software for this version.
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Application (ZSERVICE) Attributes

This section describes the attributes of the Application (ZSERVICE) instance in HPCA 
Administrator CSDB Editor. Many of the values for these attributes are set when using the 
HPCA Administrator tools, such as HPCA Administrator Packager and the New Application 
Wizard in HPCA Administrator CSDB Editor. You can also use HPCA Administrator CSDB 
Editor to modify the values of these attributes in the SOFTWARE.ZSERVICE class.

You might notice that some attributes do not have values, or their values are not displayed in 
HPCA Administrator CSDB Editor. The HPCA agent uses these attributes.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description

ZSTOPnnn Stops resolution if the expression evaluates to TRUE.
Example: 
WORDPOS(EDMGETV(ZMASTER,ZOSTYPE),’WIN32_NT 
WIN64_NT’)=0

This example expression will stop resolution (the 
application will not be installed) on the instance if the 
HPCA agent’s operating system is neither Windows 32-bit 
nor Windows 64-bit.

ZSVCNAME Use this attribute to set the name of the service that will 
display in HPCA Application Self-service Manager 
interface. This value is initially set in the Short 
Description field in the New Application Wizard.

ZSVCTTYP This indicates for which HPCA agent this application was 
packaged.
• Specify A for HPCA Application Manager.
• Specify S for HPCA Application Self-service Manager.
This value is initially set in the New Application Wizard.
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ZSVCMO Use this attribute to designate a service as mandatory or 
optional.
• When using HPCA Application Manager, services are 

typically designated as mandatory (M);
• When using HPCA Application Self-service Manager, 

services are typically designated as optional (O).
If both HPCA agents are being used you could also specify 
mandatory then optional (ZSVCMO=MO), or optional then 
mandatory (ZSVCMO=OM).
• The first character indicates how the application should 

be handled before installation.
• The second character indicates how the application 

should be handled after installation.
Note: You might need to edit the ZSERVICE class template 
to allow the ZSVCMO=OM setting. For information on editing 
a class, see Editing a Class on page 108.
To process mandatory applications using HPCA 
Application Self-service Manager, add 
enterprisemanagement=auto to the args.xml file.
This value is initially set based on the setting for the 
application target type (ZSVCTTYP) in the New 
Application Wizard.

ZSVCPRI Use this attribute to set the priority level for the service. 
Services are created based their priority. The lower the 
number, the higher the service’s priority.
• A service with ZSVCPRI=01 would have the highest 

priority.
• A service with ZSVCPRI=99 would have the lowest 

priority.

_ALWAYS_ Any method that you specify for this attribute is 
unconditionally executed when this instance is resolved.

ZCREATE A method that runs when the service is installed.

ZINIT A method that runs when the service is initialized.

ZDELETE A method that runs when the service is deleted.

ZUPDATE A method that runs when the service is updated.

ZVERIFY A method that runs when the service is verified.

ZREPAIR A method that runs when the service is repaired.

PUBDATE Reserved for future use.

UPDDDATE Reserved for future use.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description
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AUTHOR The name of the author of the service. This appears in the 
extended information area in HPCA Application 
Self-service Manager interface. This value is initially set in 
the Author field in the New Application Wizard.

DESCRIPT A description of the service. This appears in the properties 
for the service in the Service List. This value is initially set 
in the Long Description field in the New Application 
Wizard.

VENDOR The name of the vendor of the service. This appears in 
HPCA Application Self-service Manager interface. This 
value is initially set in the Vendor field in the New 
Application Wizard.

URL The web address where the subscriber can find additional 
information about the service. This appears in the 
properties for the service in HPCA Application Self-service 
Manager interface. This value is initially set in the Web 
URL field in the New Application Wizard.

CATGROUP Use this attribute to group a set of applications. You can 
display applications based on their group in HPCA 
Application Self-service Manager interface.

PRICE Specify the price of an application. This will be displayed to 
subscribers in the extended information area in HPCA 
Application Self-service Manager interface.

SCHEDOK For HPCA Application Self-service Manager only.
• Specify Y to allow the user to locally change the update 

schedule.
• Specify N to retain control on the Configuration Server.

VERSION The version of the software. This appears in the properties 
for the service in HPCA Application Self-service Manager 
interface. The value is initially set in the Version field in 
the New Application Wizard.

NAME This name appears in the properties for the service in 
HPCA Application Self-service Manager interface. The 
value is initially set in the Short Description field in the 
New Application Wizard.

OWNER Reserved for future use.

RUNDLG Specify Y to enable the processing of DIALOG Class 
instances during the installation of the service; specify N 
(the default) to disable this processing.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description
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REBOOT This attribute is used to restart the HPCA agent computer 
based on an application event. Specify the action by 
equating an application event to a reboot type, panel, or 
connect.
Event on which to Restart:
AI = Install; AD = Deinstall; AU = Update; AR = Repair; AV = 
Verify
Type of Panel:
Q = No panel; A = OK button only; Y = OK and Cancel 
buttons.
Type of Reboot:
S = Soft reboot (default of type Y panel); H = Hard reboot 
(default of type A panel); N = No reboot
Type of Connect:
None specified = Reboot on machine connect (context=m); 
U = reboot on user connect (context=u); MU = reboot when 
machine and user parts of the service have been installed.

EVENTS Set this attribute to indicate on which events to report. 
Specify your event by equating an application event to an 
event type.
AI=Application Install; AD=Application Deinstall; 
AU=Application Update; AR=Application Repair; 
AV=Application Verify; VA=Version Activation; VD=Version 
Deactivation
What to Report on:
S=Success; F=Failure; B=Both (success and failure); 
N=None
The default is AI=B,AD=B,AU=F,AR=N,VA=F,VD=F

ERTYPE Set this attribute to send an APPEVENT object. Currently, 
this supports the Object format only, so the default is 
ERTYPE=O.

ADAPTIVE Set this attribute to indicate whether the installed package 
is dependent on HPCA agent settings that must be 
monitored periodically.
• Specify Y for Yes.
• Specify N for No.
If the settings change, the HPCA agent must reconnect to 
the Configuration Server to get new or different 
components.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description
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LREPAIR Set this attribute to enable local repair of broken 
applications. If an application is broken due to missing 
files, the files (locally stored) can be used to repair the 
application.
• Specify Y for Yes.
• Specify N (the default) for No.

REMOVAL This attribute controls how the application is managed 
when a service is removed.
• REMOVAL=A (Abandon) will delete the service’s objects 

on the HPCA agent, but leave its components. The 
service will no longer be managed by HPCA.

• REMOVAL=D (Delete) will delete the service’s objects and 
components. The service will still be managed by 
HPCA.
— This is the default.

• REMOVAL=U (Unmanage) will stop management of the 
service by HPCA. Neither the objects nor the 
components will be deleted. This applies only to 
optional applications (ZVSCMO=O) that are removed 
based on entitlement policy.

Note: If a user removes an optional application, the 
service’s objects are also removed, regardless of the 
REMOVAL setting.

RECONFIG Set this attribute to indicate whether an application can be 
relocated after it has been installed. For example, you can 
move an application from the C drive (on which it was 
installed) to the D drive without having to remove and 
re-install the application.
• Specify Y for Yes.
• Specify N for No.

ZSVCCAT Set this attribute to indicate whether the service is visible 
in HPCA Application Self-service Manager catalog. For 
optional applications, the default is Y; for mandatory 
applications, the default is N. These defaults can be 
overridden.

UIOPTION Set this attribute to indicate whether the Service Status 
window will be displayed. Possible values are:
• UIOPTION=NONE: No interface displayed.
• UIOPTION=FULL: Interface displayed; Cancel button is 

available.
• UIOPTION=INFO: Interface displayed; no Cancel option.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description
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UIOPTMSI This attribute provides control over the MSI status 
window, to the user. The possible values are:
UIOPTMSI=NONE: No interface displayed.
UIOPTMSI=FULL: Displays what is happening on the 
agent computer and provides the subscriber with controls 
to make changes..
UIOPTMSI=INFO: Displays what is happening on the 
agent computer, but disables all the controls so that the 
subscriber cannot make any changes. See the Setup log 
files and Event Viewer for warnings, errors, successes, 
failures, and other details.

CACHE This attribute enables element caching.
• Specify Y for Yes.
• Specify N (the default) for No.

CACHELOC For Windows Installer applications only.
Specify the location of the folder, on the HPCA agent 
computer, that is used to cache the compressed application 
files that are needed for the product. The default is 
_UNDEF_.
HPCA support for Windows Installer tags the PRODGUID 
value to this value in order to create the folder. For 
example, if
CACHELOC=C:\progra~1\Hewlett-Packard\HPCA\Age
nt and PRODGUID=12345_XXXX
the cache folder would be
C:\progra~1\Hewlett-Packard\HPCA\Agent\12345_
XXXX\cache.
Note: The folder \cache is automatically appended to 
PRODGUID. If you are not deploying a Windows 
Installer-enabled application, the files will be cached in 
IDMDATA.

CACHELIM For Windows Installer applications only.
Specify a number between 000 and 100 to indicate the 
cache limit—defined as “the percentage of used drive 
space.”
If the percent of used space is greater than the cache limit, 
all of the product’s cached files are removed and the cache 
folder is deleted. This is checked after every file is cached 
on the disk.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description
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ZDISCONN Set this attribute to indicate whether the HPCA agent is 
allowed to disconnect from the Configuration Server if 
there is an open session with the Configuration Server.
• Specify Y to disconnect the HPCA agent from the 

Configuration Server.
• Specify N (the default) to keep the HPCA agent 

connected to the Configuration Server.

ZSYSACCT Set this attribute to indicate whether to install the service 
under the system account or the user’s account.
• Specify Y to install the application using the system 

rights.
• Specify N (the default) to install the application using 

the rights of the user that is logged on.

MCELIGBL Indicates whether the application is eligible for 
multicasting.
• Specify Y (the default) for Yes.
• Specify N for No.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description
Creating Services Using Advanced Capabilities 231



Reporting Attributes in ZSERVICE

Some of the attributes in the ZSERVICE Class are calculated. They are updated when the 
service is installed, verified, updated, repaired, or deleted and reported in the HPCA agent 
computer’s service objects.

RSTRSIZE Use this attribute in the appropriate ZSERVICE Class 
instance to control which files are enabled for check-point 
restart based on the amount of data (in bytes) that are 
being downloaded.

ZSVCMODE Set ZSVCMODE to:
• M if the service has machine components only. This 

service will be ignored if context=u on the 
RADSKMAN command line.

• U if the service has user components only. This service 
will be installed if context=u or is left blank on the 
RADSKMAN command line. You might want to use this 
setting if the application consists only of user registry 
changes or user desktop shortcuts.

• MU if the service has machine and user components. The 
user connect will verify that the machine components 
have been installed before installing the user 
components. You will need to run two RADSKMAN 
connects—one with context=m and one with 
context=u.

• EMU if the HPCA agent connect is being made in the 
user context but the machine side of the application has 
not yet been installed, because this will force the 
machine connect. After the machine connect completes, 
the user connect is initiated to install the user 
components. Use this for optional applications that the 
user controls through HPCA Application Self-service 
Manager.

Leave ZSVCMODE blank to treat the service as single 
mode that can be installed independently by the machine 
or the user. In other words, install the entire service 
ignoring the component’s ZCONTEXT.

ZBITARCH Use this attribute to specify the bit size-based architecture 
to which the service can be deployed.
• Set to 32 to deploy to 32-bit architectures.
• Set to 64 to deploy to 64-bit architectures.
• Leave blank to deploy to all architectures.

Table 58 Modifiable SOFTWARE.ZSERVICE Attributes

Attribute Description

These attributes should not be modified using HPCA Administrator CSDB Editor.
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Table 59 Calculated ZSERVICE Attributes – DO NOT MODIFY

Attribute Description

ZSVCCSTA This status code for the service is used to determine why 
files for a service might not be correctly deployed. Values 
range from 000–999.

SIZE The uncompressed size of the application that is displayed to 
the users in the extended information area in HPCA 
Application Self-service Manager interface.
This “calculated” field is the cumulative value of the SIZE 
that is defined in the PACKAGE class; do not modify it.

COMPSIZE The compressed size of the application that is displayed to 
the users in the extended information area in HPCA 
Application Self-service Manager interface.
This “calculated” field is the cumulative value of the 
COMPSIZE that is defined in the PACKAGE class; do not 
modify it.

ZAVIS The HPCA agent manages this attribute to show, in the 
catalog, the different states of the application. The four 
states are:
• Available indicates whether a service is available from 

the Configuration Server.
• Verified indicates whether a service has been verified.
• Installed indicates whether the service has been 

installed.
• Synchronized indicates whether the installed service 

has all of the latest changes from the Configuration 
Server.

The valid values for each state are: Y (Yes), N (No), and X 
(unknown).

VERDATE This attribute indicates (in local time, in the format of MMM 
DD,YYYY HH:MM:SS) when the application was last 
verified on the HPCA agent computer. This is displayed to 
the users in the extended information area in HPCA 
Application Self-service Manager interface. The HPCA 
agent manages this attribute.
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Local Catalog Processing

Local catalog processing reduces the network bandwidth and the number of connects required 
to the Configuration Server to manage applications. Use a Timer or a Notify command to 
make the machine connect with context = m on the RADSKMAN command line.

If you have only one user for a computer or multiple users on one computer with the same 
entitlements, local catalog processing allows you to make one connection to the Configuration 
Server for the machine and user components of a service. During the machine connect, the 
required configuration information will be downloaded to the agent computer, machine and 
user components of the services will be downloaded in a compressed format, and the machine 
components will be installed. For the user connect, set cat = m, local = y, and context = 
u on the RADSKMAN command line. When the user connect is made, the user’s services will 
be resolved based on the machine’s service list, and the already downloaded resources will be 
added, modified, or deleted as needed.

If an HPCA agent computer has two or more users with distinct entitlements, you will need to 
create policies for each machine so that all components for all of the services for all users of 
that HPCA agent computer will be downloaded. Contact Professional Services for 
implementation.

UPGDATE This attribute indicates (in local time, in the format of MMM 
DD,YYYY HH:MM:SS) when the application was last 
updated on the HPCA agent computer. This is displayed to 
the users in the extended information area in HPCA 
Application Self-service Manager interface. The HPCA 
agent manages this attribute.

INSTDATE This attribute indicates (in local time, in the format of MMM 
DD,YYYY HH:MM:SS) when the application was installed 
on the HPCA agent computer. This is displayed to the users 
in the extended information area in HPCA Application 
Self-service Manager interface. The HPCA agent manages 
this attribute.

DELDATE This attribute indicates (in local time, in the format of MMM 
DD,YYYY HH:MM:SS) when the application was removed 
on the HPCA agent computer. The HPCA agent manages 
this attribute.

Table 59 Calculated ZSERVICE Attributes – DO NOT MODIFY

Attribute Description

The ZSVCMODE attribute of the application must be M or MU to use this feature.
234 Appendix D



E Creating Timers in Configuration Server 
Database
To schedule the deployment of a service, configure a timer in the Configuration Server 
Database. When the HPCA agent computer connects to the Configuration Server, the timer 
information is transferred to the HPCA agent computer in the ZTIMEQ object.

Creating a Timer

Use HPCA Administrator CSDB Editor to create a Scheduling (TIMER) instance in the 
SOFTWARE Domain.

To create a TIMER instance in the SOFTWARE Domain

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator CSDB Editor. The HPCA Administrator CSDB Editor Security 
Information dialog box opens.

2 If necessary, type a user ID and password, and click OK. HPCA Administrator CSDB 
Editor window opens.

3 Navigate to PRIMARY.SOFTWARE.Scheduling (TIMER), and right-click TIMER Instance.

4 Select New Instance. The Create Instance dialog box opens.

5 Type a name, for example, Mandatory Apps Timer, and click OK.

Scheduling (TIMER) Class Attributes

The TIMER Class attributes are described in the following table. They contain information 
that is needed to execute the timer on the HPCA agent computer.

The default user ID and password are:

User ID: ADMIN

Password: secret

Table 60 Scheduling (TIMER) Class Attributes

Attribute Usage

_ALWAYS_ Stores connections to other instances.

NAME The friendly name for this instance.

PINGDLAY If ZNOPING=N, PINGDLAY specifies the time (in 
milliseconds) between pings. The default is 2000.
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PINGCNT If ZNOPING=N, PINGCNT specifies number of ping 
attempts. The default is 3.

RETRYINT Specify the number of minutes to wait between command 
executions.
Note: This is ignored if RETRYFLG=N.

RETRYLMT Specify the number of times to retry the command.
• Specify 0 to retry until the command succeeds.
Note: This will be ignored if RETRYFLG=N.

NETAVAIL Use to check the availability of the network.
• Specify Y to check for network availability before 

executing the TIMER instance. If the network is not 
available, network availability will be checked every 
time the timer wakes up until the network is available.

• Specify N (the default) and the TIMER instance will be 
executed without checking for network availability.

• Specify W to check for network availability before 
executing the TIMER instance. If the network is not 
available and the time window’s end limit has been 
reached, the timer will wait until the next time window 
before checking for network availability again.

RETRYFLG Use to specify the retry activity.
• Specify Y to retry the command up to <RETRYLMT>, 

ignoring the end time for the timer.
• Specify W to retry the command up to up to <RETRYLMT>, 

but stop retrying after the specified limit time has 
passed.

• Specify N to not retry.
Note: A return code other than 200 will indicate success, 
and stop the retries.

RETRYRC Specify return codes that qualify for the retry logic.
If this variable does not exist or is blank, RETRYRC will 
default to 200 which means there was a fatal error due to a 
network connection failure with the Configuration Server. 
If you populate this attribute and a return code of 200 
qualifies for a retry, be sure to specify 200 in the list.
Example: RETRY=200, 202, 209

Table 60 Scheduling (TIMER) Class Attributes

Attribute Usage
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ZNOPING Use this attribute to control automatic sensing of a network 
connection between the HPCA agent computer and the 
Configuration Server. The default is Y.
• Specify Y to prevent the Scheduler service from pinging 

the Configuration Server. This is especially useful for 
mobile users.

• Specify N to have the Scheduler service to ping the 
Configuration Server.

• Specify W if you are specifying an end limit in the 
ZCHDEF attribute. The Scheduler will ping the 
Configuration Server before executing the command. If 
the Configuration Server is unavailable, the 
ZPENDING flag will be set to W. If the ZSCHEDEF has 
a limit time, then, when that time passes, the 
ZPENDING flag will be set to N and the Scheduler will 
not attempt to execute the command until its next 
scheduled time.

An expired timer continually evaluates whether 
communications with the Configuration Server can be 
established. When communications are established, the 
command line that is associated with the timer is executed. 
After executing the command line, the Scheduler service 
resumes normal evaluation of whether the timer has 
expired again.
If this attribute is not present in the ZTIMEQ object, the 
Scheduler service will not ping the Configuration Server.
If the Configuration Server is successfully pinged, the 
command in ZRSCCMDL executes and the ZPENDING 
attribute—in the HPCA agent’s ZTIMEQ object—is set to 
N, to indicate that the Scheduler service does not need to 
ping the Configuration Server again.
If the Configuration Server is not successfully pinged, the 
timer is not processed any further, and the ZPENDING 
attribute value remains Y, to indicate that the next time 
the Scheduler service “pops,” it should ping the 
Configuration Server again.

ZRSCCMDL Use this attribute to specify the command line that is 
executed on the HPCA agent computer when the timer 
expires.
Use RADSKMAN to verify and update HPCA-managed 
mandatory applications. For a list of the parameters and 
examples, see Connection Parameters (RADSKMAN) on 
page 183.

Table 60 Scheduling (TIMER) Class Attributes

Attribute Usage
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ZSCHDEF Use this attribute to specify when the timer expires. The 
syntax for this attribute varies depending on the frequency, 
which can be DAILY, HOURLY, WEEKLY, MONTHLY, 
INTERVAL, MONTHDAY, NUMDAY, WEEKDAY, or 
STARTUP.
For instructions on how to set ZSCHDEF, see Specifying 
the Timer Expiration (ZSCHDEF) on page 241.

ZSCHFREQ Use this attribute to specify how often the timer should 
expire.
• Specify ONCE to have the timer to expire one time.
• Specify PERIODIC to have the timer to expire 

repeatedly.
• Specify RANDOM to have the timer to expire in random 

intervals.
For more information, see Deploying Applications over a 
Period of Time on page 247.

Table 60 Scheduling (TIMER) Class Attributes

Attribute Usage
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ZSCHTYPE This attribute is valid only when ZSCHFREQ=PERIODIC. 
Valid values are IMMEDIATE and DEFERRED.
Specify DEFERRED to indicate that the first time an event is 
attempted to be launched, it will be deferred until the next 
scheduled time, regardless of when the timer instance is 
evaluated. This was designed so that events that are 
scheduled for off-peak hours will not launch while a user is 
working.
Example 1
Assume a timer with 
ZSCHDEF=DAILY(&ZSYSDATE,04:00:00).
• If ZSCHTYPE=IMMEDIATE and it is:

— Earlier than 4:00 a.m., the command in the instance 
will be executed the same day at 4:00 a.m.

— Later than 4:00 a.m., the command in the instance 
will be executed immediately.

• If ZSCHTYPE=DEFERRED and it is:
— Earlier than 4:00 a.m., the command in the instance 

will be executed the same day at 4:00 a.m.
— Later than 4:00 a.m., the command in the instance 

will be executed the next day at 4:00 a.m.
Example 2
Assume a timer with 
ZSCHDEF=WEEKDAY(FRIDAY,04:00:00).
• If ZSCHTYPE=IMMEDIATE and it is:

— Either not Friday, or earlier than 4:00 a.m. on 
Friday, the command in the instance will be executed 
on Friday at 4:00 a.m.

— Later than 4:00 a.m. on Friday, the command in the 
instance will be executed immediately.

• If ZSCHTYPE=DEFERRED and it is:
— Not Friday, the command in the instance will be 

executed on the next occurring Friday, at 4:00 a.m.
— Earlier than 4:00 a.m. on Friday, the command in the 

instance will be deferred one week and executed a 
week later on the following Friday, at 4:00 a.m.

— Later than 4:00 a.m. on Friday, the command in the 
instance will be executed a week later on Friday at 
4:00 a.m.

ZSTOP Expressions evaluating to “true” in ZSTOP attributes cause 
resolution of the instance to be skipped. If left blank, the 
instance is accepted and resolution continues. This is useful 
if you want to set conditions on which of your subscribers 
receive the timer.

Table 60 Scheduling (TIMER) Class Attributes

Attribute Usage
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The values for the following attributes are inherited from the 
_BASE_INSTANCE_ of the TIMER Class; they should not be edited.

RUNSYNC Specifies whether synchronous timer execution will take 
place. The default value is Y.

ZOBJPRI The deployment priority level (relative to the other 
elements being deployed during the HPCA agent connect) 
of the ZTIMEQ object. A value of 90 is inherited from the 
_BASE_INSTANCE_.
Note: Elements with priority levels that are lower than this 
value will be deployed before this ZTIMEQ object.

ZSCHMODE This attribute is specific to HPCA Application Self-service 
Manager and is used when a ZTIMEQ Instance is run. Its 
value, Default, should not be changed.

ZSVCOID The object ID of the Application instance to which this 
Scheduling instance is connected.

ZCHNNAME The Configuration Server Database domain that contains 
the Application instance to which this Scheduling instance 
is connected.

ZPRVNAME The name of the Configuration Server to which the 
subscriber that is receiving this timer instance is 
connected.
The value is inherited from the _BASE_INSTANCE_.

ZCREATE The Scheduler “create” method that runs on the HPCA 
agent computer.
The value is inherited from the _BASE_INSTANCE_.

ZVERIFY The Scheduler “verify” method that runs on the HPCA 
agent computer.
The value is inherited from the _BASE_INSTANCE_.

ZUPDATE The Scheduler “update” method that runs on the HPCA 
agent computer.
The value is inherited from the _BASE_INSTANCE_.

ZDELETE The Scheduler “delete” method that runs on the HPCA 
agent computer.
The value is inherited from the _BASE_INSTANCE_.

Table 60 Scheduling (TIMER) Class Attributes

Attribute Usage
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Configuring the Timer

This section offers a review of the syntax that is used to configure the attributes of the TIMER 
instance. Following that, in the section, Deploying Applications over a Period of Time on 
page 247, is a sample exercise on how to configure a TIMER instance to deploy mandatory 
applications during off-peak hours.

Specifying the Timer Expiration (ZSCHDEF)

Use ZSCHDEF and ZSCHFREQ attributes to specify when and how often a timer will expire.

• ZSCHDEF indicates when the timer will expire;

• ZSCHFREQ indicates how often the timer will expire.

The syntax of the ZSCHFREQ attribute will influence the settings of the ZSCHDEF attribute. 
Use Table 61 on page 243 to determine the appropriate syntax for the value of ZSCHDEF. 
Before configuring the ZSCHDEF attribute, review the following syntax-formatting 
considerations.

• The value of WEEKDAY must be UPPERCASED and will accept only the days of the 
week: MONDAY, TUESDAY, WEDNESDAY, THURSDAY, FRIDAY, SATURDAY, and 
SUNDAY.

• In all ZSCHDEF attribute syntax, the time value must be expressed in base-24 time, in 
the format HH:MM:SS. Valid values are 00:00:00–23:59:59.

• In all ZSCHDEF attribute syntax, the date value must be expressed in the format 
YYYYMMDD.

Start Time and End Time Parameters:

When ZSCHFREQ=RANDOM is specified the time parameter is automatically replaced with two 
parameters, start time and end time. The start time and end time parameters are used to 
specify the time limit between which the command can be chosen to be executed. For example, 
the command

DAILY(20070707,10:00:00,12:00:00[,20:00:00])

will choose to execute in between the start time parameter (10 a.m.) and the end time 
parameter (12 p.m.) on July 7, 2007. However, it will not execute after the limit time 
parameter (8 p.m.). So, if the target machine is not powered on (or the Scheduler is not 
running) during this time, the command will not execute. It will be rescheduled for the next 
occurrence to start in between 10 a.m. and 12 p.m.” and end before 8 p.m, in this case. As it is 
a “daily” command, it will execute on the next day, July 8, 2007.

Limit Time Parameter

The limit time parameter is used to specify a time after which the command will not be 
executed. For example, the command

DAILY(20070707,18:00:00[,20:00:00])
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will execute any time between 6 p.m. and 8 p.m. on July 7, 2007, but it will not execute after 8 
p.m. So, if the target machine is not powered on (or the Scheduler is not running) during this 
time, the command will not execute. It will be rescheduled for the next occurrence of “between 
6 p.m. and 8 p.m.” which, in this case, because it is a “daily” command, will execute on the 
next day, July 8, 2007.

ZSCHFREQ=RANDOM

When ZSCHFREQ=RANDOM is specified the time parameter is automatically replaced with two 
parameters, start time and end time.

Be sure to not use the limit time parameter as an end time indicator; their functionalities are 
different and doing so will result in a malformed ZSCHDEF command.

• If ZSCHFREQ=RANDOM and the limit time parameter is NOT specified:

The end time parameter can span midnight (it can be the next day). For example, the 
commands

DAILY(20070707,20:00:00,06:00:00) and

NUMDAYS(20070707,20:00:00,06:00:00,,14)

will execute at random times between 8 p.m. on July 7, 2007 and 6 a.m. on July 8, 2007. 
Note that even though the limit time parameter is not specified in either command, 
NUMDAYS still requires the third comma in order to be considered a valid argument; 
DAILY does not.
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• If ZSCHFREQ=RANDOM and the limit time parameter IS specified:
The end time parameter cannot span midnight. If it does, the RADTIMEQ create method 
will log a warning and set the start time to midnight (00:00:00).

Table 61 ZSCHDEF Attribute Syntax

Attribute Description

HOURLY The timer will expire and run hourly, starting any time 
after the specified time but not later that the specified limit 
time, based on the system’s date.
Syntax: &SYSDATE,time[,limit time]
Example: ZSCHDEF=HOURLY(&ZSYSDATE,04:30:00)
Note: If ZSCHFREQ=RANDOM, the start time and end time 
parameters are activated.
Syntax: &SYSDATE,start time,end time[,limit 
time]

Example: 
ZSCHDEF=HOURLY(&ZSYSDATE,04:30:00,09:00:00)

For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.

DAILY The timer will expire and run daily at the specified time (but 
not later that the specified limit time), based on the system’s 
date.
Syntax: &SYSDATE,time[,limit time]
Example: ZSCHDEF=DAILY(&ZSYSDATE,12:00:00)
Note: If ZSCHFREQ=RANDOM, the start time and end time 
parameters are activated.
Syntax: &SYSDATE,start time,end time[,limit 
time]

Example: 
ZSCHDEF=DAILY(&ZSYSDATE,12:00:00,14:00:00,

18:00:00)

For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.

WEEKLY The timer will expire and run at the specified time (but not 
later that the specified limit time) on every seventh day, 
based on the system’s date.
Syntax: &SYSDATE,time[,limit time]
Example: ZSCHDEF=WEEKLY(&ZSYSDATE,08:00:00)
Note: If ZSCHFREQ=RANDOM, the start time and end time 
parameters are activated.
Syntax: &SYSDATE,start time,end time[,limit 
time]

Example: 
ZSCHDEF=WEEKLY(&ZSYSDATE,08:00:00,12:00:00,

14:00:00)

For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.
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INTERVAL The timer will expire and run every n minutes starting at 
the specified time (but not later that the specified limit 
time), based on the system’s date. Once the limit time has 
been reached, the command will stop executing. The same 
command will execute the next day, again, within the same 
time limits.
Syntax: &SYSDATE,time,[limit time],interval
Example: 
ZSCHDEF=INTERVAL(&ZSYSDATE,04:00:00,06:00:00,3
0)

Notes: INTERVAL must be specified in minutes.
The third comma is required regardless of whether a third 
argument is specified.
If ZSCHFREQ=RANDOM, the time parameter is automatically 
replaced with two parameters, start time and end time.
Syntax: &SYSDATE,start time,end time,[limit 
time],interval

Example: 
ZSCHDEF=INTERVAL(&ZSYSDATE,04:00:00,23:00:00,

06:00:00,30)

For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.

WEEKDAY The timer will expire and run at the specified time (but not 
later that the specified limit time) on the specified weekday, 
every week.
Syntax: WEEKDAY,time[,limit time]
Example: ZSCHDEF=WEEKDAY(TUESDAY,01:00:00)
Note: If ZSCHFREQ=RANDOM, the time parameter is 
automatically replaced with two parameters, start time and 
end time.
Syntax: WEEKDAY,start time,end time[,limit time]
Example: 
ZSCHDEF=INTERVAL(TUESDAY,04:00:00,06:00:00,

10:00:00)

For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.

Table 61 ZSCHDEF Attribute Syntax

Attribute Description
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MONTHDAY The timer will expire and run at the specified time (but not 
later that the specified limit time) on the specified weekday 
in the week of the month that is indicated by the 4th 
parameter.
Syntax: WEEKDAY,time,[limit time],week of the 
month

Example: ZSCHDEF=MONTHDAY(TUESDAY,01:00:00,,2)
Notes: The valid values for the 4th parameter are 1–5. If 
this argument is not specified, the timer will expire during 
the first week of the month.
The third comma is required regardless of whether a third 
argument is specified.
If ZSCHFREQ=RANDOM, the time parameter is automatically 
replaced with two parameters, start time and end time.
Syntax: WEEKDAY,start time,end time,[limit 
time],week of the month

Example: 
ZSCHDEF=MONTHDAY(TUESDAY,01:00:00,04:00:00,,2)

Important Note: Consider the consequences of specifying an 
end time that spans midnight (occurs on the following day). 
For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.

Table 61 ZSCHDEF Attribute Syntax

Attribute Description
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MONTHLY The timer will expire and run at the specified time (but not 
later that the specified limit time) on the nth of every 
month, starting in the specified month and year.
Syntax: date,time[,limit time]
Example: 
ZSCHDEF=MONTHLY(20040215,01:00:00,05:30:00)

Note: If ZSCHFREQ=RANDOM, the time parameter is 
automatically replaced with two parameters, start time and 
end time. For more information, see Specifying the Timer 
Expiration (ZSCHDEF) on page 241.
Syntax: date,start time,end time[,limit time]
Example: 
ZSCHDEF=MONTHLY(20040215,01:00:00,05:30:00,

07:00:00)

Important Note: This attribute reschedules differently than 
other ZSCHDEF attributes; it will reschedule by adjusting 
the month (but retaining the date) for which it was 
originally scheduled, rather than adjusting the date based 
on when it eventually ran.
For example, assume 
ZSCHDEF=MONTHLY(20040116,05:30:00) and that the 
HPCA agent device was powered off on January 16th and 
that the timer didn’t execute until January 18th. The new 
schedule would automatically revise to 
MONTHLY(20040216,05:30:00) rather than 
MONTHLY(20040218,05:30:00).

NUMDAYS The timer will expire and run at the specified time (but not 
later that the specified limit time) on the specified date, 
then again on every nth day (as specified by the 4th 
parameter).
Syntax: date,time,[limit time],number of days
Example: 
ZSCHDEF=NUMDAYS(20040803,18:00:00,21:30:00,14)

Notes: The third comma is required regardless of whether a 
third argument is specified.
If ZSCHFREQ=RANDOM, the time parameter is automatically 
replaced with two parameters, start time and end time.
Syntax: date,start time,end time,[limit 
time],number of days

Example: 
ZSCHDEF=NUMDAYS(20040803,18:00:00,21:30:00,

22:00:00,14)

For more information, see Specifying the Timer Expiration 
(ZSCHDEF) on page 241.

Table 61 ZSCHDEF Attribute Syntax

Attribute Description
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Deploying Applications over a Period of Time

Applications can be deployed over a period of time in order to balance the workload on the 
Configuration Server and alleviate network congestion.

To do this, configure the timer for “random” expiration and use ZSCHDEF to specify the 
period of time during which the applications should be deployed. The time-period options are 
detailed in Table 61 on page 243.

In the following example, a timer will be configured to deploy mandatory applications on a 
weekly basis. The deployments will be scheduled to run between 5:00 p.m. and 7:00 p.m. in 
order to alleviate network congestion.

To specify when the timer expires

1 In HPCA Administrator CSDB Editor, navigate to the timer instance and double-click 
ZSCHFREQ. The Editing Instance dialog box opens.

2 In the Frequency drop-down list, select RANDOM.

3 Click ZSCHDEF.

4 In the Timer Parameter text box, type WEEKLY(&ZSYSDATE,17:00:00,19:00:00).

5 Click ZSCHTYPE.

6 In the Type (Immediate/Deferred) drop-down list, select IMMEDIATE.

7 If you are done editing the attributes for the timer instance, click OK and then click Yes 
when prompted to confirm your changes.

or

Select another attribute to edit.

STARTUP When the Scheduler starts on the HPCA agent device, it will 
immediately execute all Timer instances that have 
ZSCHDEF=STARTUP specified.
It will check for special conditions such as NETAVAIL, 
ZNOPING, and RETRYFLG.
After executing all the STARTUP instances, RADSCHED 
will return to its regular timer loop. It will execute 
STARTUP instances in the regular timer loop only if the 
ZPENDING flag on that instance was set (because 
NETAVAIL or ZNOPING could not get through or 
RETRYFLG is on and the return code was 200 during 
startup run).

Table 61 ZSCHDEF Attribute Syntax

Attribute Description
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Specifying the Command Line (ZRSCCMDL)

When the timer expires, it executes on the HPCA agent computer any command line that 
you’ve specified.

To specify a command line

1 In HPCA Administrator CSDB Editor, navigate to the timer instance and double-click 
ZRSCCMDL. The Editing Instance dialog box opens.

2 In the Command line to execute text box, type the appropriate command line to 
execute the program.

3 Click OK, and then click Yes when prompted to confirm your changes.

At the beginning of this section, we indicated that we would be deploying new mandatory 
applications on a weekly basis. The following procedure will demonstrate how to specify a 
command line that will update all mandatory services and perform self-maintenance.

Connecting the Timer to a Service

Once you have created the timer, you must connect it to a service. Each subscriber that 
receives the service with which the timer is associated will receive the timer information in 
the ZTIMEQ object the next time his/her HPCA agent connects to the Configuration Server.

In the example in this section, we created a timer that is intended to deliver mandatory 
applications. Now, we will connect the timer to a service and assume that all subscribers are 
receiving it.

To connect the timer to a service

1 In HPCA Administrator CSDB Editor, navigate to PRIMARY.SOFTWARE.Application 
(ZSERVICE), and right-click ProDraw.

2 In the menu that opens, click Show Connections. The SOFTWARE.ZSERVICE 
Connections dialog box opens.

3 Select Scheduling (TIMER) and click OK. The TIMER Class instances appear in the list 
view.

4 In the list view, click Mandatory Apps Timer and drag it to ProDraw. When the cursor 
changes to a paper clip icon, release the mouse button. The Select Connection 
Attribute dialog box opens.

5 Click Copy.

6 Click Yes to confirm that you want to connect the ProDraw service to the Mandatory Apps 
Timer.

7 Click OK to close the confirmation message.

To see how timers work, create a timer that runs a command line such as 
SystemDrive:\Notepad.exe.

Remember to configure the timer to immediately expire, and attach it to a service. 
Then, deploy the service. When the timer expires on the HPCA agent computer, 
the Notepad application opens.

For the following exercise, assume a service named ProDraw. The steps are 
identical for the services in your database.
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Testing the Timer Deployment

The first time that an HPCA agent computer connects to the Configuration Server after the 
timer has been created, the timer information is transferred to the HPCA agent computer in 
the ZTIMEQ object, ZTIMEQ.EDM.

In the exercise that follows, you will force the HPCA agent computer to connect to the 
Configuration Server so that you can view the ZTIMEQ object.

To connect to the HPCA Configuration Server

1 On the HPCA agent computer, go to a command prompt and change the directory to the 
location of RADSKMAN. The default location is <InstallDir>\Agent.

2 Type radskman ip=manager_ip,port=mgr_port. Be sure to specify a valid IP address 
and port for the Configuration Server.

3 Press Enter.

After the HPCA agent connect completes, you can view the ZTIMEQ object on the HPCA 
agent computer, as described in the next section.

Removing the Timer Object

After the timer expires, the ZTIMEQ object will be removed from the HPCA agent computer 
during its next connect to the Configuration Server. This is dependent on the expiration 
settings in the TIMER.ZSCHFREQ attribute.

• If the timer is configured to expire once, the ZTIMEQ object will be removed immediately 
after the timer expires, during the next HPCA agent connect to the Configuration Server.

• If the timer is configured to expire more than once, the ZTIMEQ object will be removed 
after the timer expires for the last time, during the next HPCA agent connect to the 
Configuration Server.

Viewing the Timer Object

After having forced the HPCA agent to connect to the Configuration Server and retrieve the 
ZTIMEQ object, it can be viewed (and modified) using HPCA Administrator Agent Explorer, 
which was installed as part of the HPCA Administrator.

The ZTIMEQ object contains one instance for each Scheduling (TIMER) instance in the 
Configuration Server Database. Therefore, if two services have associated timer instances 
there will be two instances in the ZTIMEQ object.

To view the ZTIMEQ object on the HPCA agent computer

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Agent Explorer.

For information about RADSKMAN and the above parameters, see Connection 
Parameters (RADSKMAN) on page 183.

If you plan to do additional testing, consider creating a batch file that contains the 
command line. Save the file in IDMSYS (by default, <InstallDir>\Agent) on the 
HPCA agent computer. Then, create a shortcut on the desktop of the HPCA agent 
computer.
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2 Double-click the ZTIMEQ object. The ZTIMEQ object opens.

Figure 41 ZTIMEQ object window

Experimenting with Timers

If you want to experiment with timers, you can modify the ZRSCCMDL, ZSCHDEF, 
ZSCHFREQ, and ZSCHTYPE variables in the ZTIMEQ object on the HPCA agent to see what 
happens in various situations.

To edit a variable in ZTIMEQ

1 Click Start → Programs → HP Client Automation Administrator → HP Client Automation 
Administrator Agent Explorer.

2 Double-click the ZTIMEQ object. The ZTIMEQ object opens.

3 Double-click the variable that you want to edit. The Change Variable dialog box opens.

4 Type the new value.

5 Click Save/Exit.

To quickly determine whether the timer expires, change ZRSCCMDL to run any executable, 
such as Notepad. When the timer expires, Notepad should open, confirming that the timer 
expired.
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Timer Logs

Timer events are tracked in three logs—RADSCHED.LOG, RADSHIST.LOG, and 
RADTIMEQ.LOG—that are stored in the IDMLOG directory (by default, 
<InstallDir>\Agent\Log).

Table 62 Timer Logs

Log File Description

RADSCHED.LOG Lists the results of the most recent Scheduler 
expiration.
The Scheduler, RADSCHED, runs in the background. 
It wakes up once per minute and examines the 
ZTIMEQ object to determine whether a timer has 
expired.
This log contains information from only the most 
recent expiration.

RADSHIST.LOG Lists all of the programs that were dispatched 
because a timer instance expired. It reflects all 
activity that has taken place since RADSCHED was 
last started.

RADTIMEQ.LOG Lists the events that occurred during the last 
execution of the RADTIMEQ method.
RADTIMEQ executes when the application to which 
the timer is attached is created, updated, verified, or 
deleted. Only the last execution’s events appear in the 
log, with an indication of what activity took place 
regarding the application.
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F Resolution Process
The Configuration Server uses the resolution process to accomplish a unit of work in 
response to a service request. The unit of work is defined by the contents of the CSDB and 
parameters included in the request. In other words, what the Client Automation 
infrastructure does depends on what information is stored in its CSDB and what information 
accompanies the request for Client Automation to perform some action. For example, the 
agent connect submits service requests to the Configuration Server, and the Configuration 
Server performs a resolution in response to each request.

Figure 42 Configuration Server performs resolution

The ZMASTER object is sent to the Configuration Server during the agent connect. The 
ZMASTER object contains information about the agent computer that is needed to run Client 
Automation, such as the identity of the subscriber and the IP address of the agent computer.

The Configuration Server stores the ZMASTER object in global memory. Global memory is 
a temporary storage area in the Configuration Server. The Configuration Server maintains 
global memory’s contents for the duration of the resolution process.
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Figure 43 Subscriber's local ZMASTER object

After storing ZMASTER in global memory, the Configuration Server finds the Process 
instance for the ZMASTER. This is the process entry point. Its location is 
SYSTEM.PROCESS.ZMASTER.

The Configuration Server reads each attribute of SYSTEM.PROCESS.ZMASTER. Based on 
an attribute’s value, the Configuration Server may:

• Set variable values.

• Evaluate an expression.

• Execute a method.

• Connect to other instances

If there is a connection to another instance, the Configuration Server processes the connected 
instance. Then the resolution process resumes in the referring instance at the next attribute 
after the connection attribute. For example, in Figure 44 on page 255, the first connection 
instance links to SYSTEM.ZINTENT.&(SESSION.INTENT). After processing this connection 
instance, the resolution process will return to PRIMARY.SYSTEM.PROCESS.ZMASTER.
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Figure 44 PRIMARY.SYSTEM.PROCESS.ZMASTER instance

During resolution the Configuration Server performs symbolic substitution to set values and 
to connect to other instances. For example, in SYSTEM.PROCESS.ZMASTER there is a 
connection to SYSTEM.ZINTENT.&(SESSION.INTENT). The Configuration Server 
substitutes the value of the INTENT from the SESSION object that is in global memory. If 
the INTENT is CATALOG_RESO, the resolution process will connect to 
SYSTEM.ZINTENT.CATALOG_RESO and resolve that instance. In the 
SYSTEM.ZINTENT.CATALOG_RESO instance, there is a connection to 
SYSTEM.ZPRODUCT.&(PREFACE.ZDOMNAME). The Configuration Server substitutes the 
value of the ZDOMNAME from the PREFACE object that is in global memory. If the 
ZDOMNAME is SOFTWARE, the resolution process will connect to 
SYSTEM.ZPRODUCT.SOFTWARE and resolve that instance. In 
SYSTEM.ZPRODUCT.SOFTWARE there is a connection to 
POLICY.USER.&(ZMASTER.ZUSERID). The Configuration Server substitutes the value of 
the ZUSERID from the ZMASTER object that is in global memory.

In Figure 43 on page 254, the value of ZUSERID is alee. Therefore, the resolution process will 
connect to POLICY.USER.ALEE, and resolve that instance.
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Figure 45 POLICY.USER.ALEE instance

In Figure 45 above, after setting a number of variables, the first connection attribute is to 
SOFTWARE.ZSERVICE.AMORTIZE. In your implementation, the POLICY instance may 
connect to a workgroup that connects to a service.

Figure 46 ZSERVICE.AMORTIZE instance
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A Service instance links to packages. Figure 46 above begins with a ZSTOP expression 
variable. An expression variable contains statements that, if evaluated to “true,” stop the 
resolution of the current instance. An expression allows alternative paths to be taken during 
resolution based on variable data. In this case, the expression checks to be sure that the 
operating system of the agent computer is authorized for the Amortize software.

If the agent computer’s operating system is Windows 2003, Windows XP, or Windows Vista, 
the resolution process continues with this instance, connecting the file instances, registry 
entries, path instances, and shortcuts. If the agent has an operating system other than one of 
the four that were previously mentioned, resolution returns to 
SOFTWARE.ZSERVICE.AMORTIZE, and to the next connection instance.

Eventually, the resolution process will return to the User instance, finish resolving it, and 
return to the process entry point, SYSTEM.ZPROCESS.ZMASTER.

After processing all attributes in the SYSTEM.PROCESS.ZMASTER instance, resolution 
terminates.
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We appreciate your feedback!

If an email client is configured on this system, click    

If no email client is available, copy the following information to a new message in a web mail 
client and send the message to docfeedback@hp.com.

Product name and version: HP Client Automation 8.10

Document title:

Feedback:  
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